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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1  Introduction

How to Use This Guide  
Use this guide together with the sales playbooks available on the Sales Playbook page  to learn how to implement Oracle
Sales for Redwood. The chapters in this guide provide you with information on some features, but many key features
are covered in separate playbooks. For features relevant to implementation of the Classic version of Oracle Sales, see
the Implementation Reference guide.

Here's a list of some of the most important playbooks for implementation:

Key Playbooks Descriptions

How do I get started with Oracle Sales in
the Redwood User Experience?

Provides basic setup for new customers.

What's my roadmap for implementing
Oracle Sales in the Redwood User
Experience?

Provides a roadmap for setting up a new implementation. The steps are aimed at customers
implementing Sales for the first time, not for those migrating from classic Sales to Redwood.

How can I speed up my transition from
classic Oracle Sales to the Redwood
platform?

Explains how the Redwood Migration Accelerator tool simplifies and speeds up your transition from
classic Oracle Sales to Oracle Sales for Redwood.

How do I configure Adaptive Search? Explains how to enable and configure search for Sales for Redwood.

How do I configure the Sales Dashboard in
the Redwood User Experience?

Explains how to configure sales dashboards for different roles in the organization. The sales
dashboards provide an overview of key sales information and tasks as well as a good starting point for
your daily sales activities.

• How do I set up Sales Products?

• How do I get started with the Sales
Catalog?

Explain how you build a sales catalog with products and product groups. Assets functionality is
available by default, or you can integrate with Oracle SCM Installed Base Assets for added features.

How do I get started with Orchestration? Explains how to guide salespeople with best practices for different sales situations using Guidance.
It also helps eliminate the need for training on various nonstandard procedures unique to specific
businesses.

How do I integrate Microsoft Teams with
Redwood User Experience?

Explains how to enable web conferencing using Microsoft Teams.

How do I implement Microsoft 365 for
Oracle Sales Redwood UX?

Explains how to implement the Sales for Outlook add-in.

How do I configure CX Sales Mobile? Explains how to set up the Oracle CX Sales Mobile app. The app helps salespeople manage their day
effectively and develop customer relationships using their phone or tablet.

How do I integrate LinkedIn with Oracle
Sales?

Explains how to set up LinkedIn integration to allow salespeople to use the LinkedIn Sales Navigator.

How do I get started with Sales
Forecasting?

Explains how to set up and use forecasting.

How do I get started with Sales
Intelligence?

Explains how to get started with Oracle Sales Intelligence features.

1
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Key Playbooks Descriptions

How do I enable the Generate Account
Description feature in Sales for Redwood?

Describes how to set up and use the Generate Account Description feature. The feature uses
generative AI to help you create account descriptions from PDFs you upload.

How can I quickly import records during
implementation?  
You can use Oracle Sales quick import macro files to speed creation of records in your implementation.

You can import up to 5,000 records at a time using the quick import macro files.

Sales Objects You Can Import with Quick Import Macro Files
The quick import macro files are available for these Sales business objects:

Business Object Where to Find More Information

Accounts and Contacts Overview of Account and Contact Import

Account Hierarchy Import Accounts and Account Hierarchies Using the Account Import Macro File

Leads Import Leads Using the Import Macro

Opportunities Overview of Opportunity and Revenue Lines Import

Products and Product Groups Overview of Importing Products and Product Groups

Users (sales resources) Overview of Importing Sales Resources

For more import options, see What are my data import options?.
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2  Implementation (Setup) Users

Setup Overview  
Using the Setup Assistant, you can create up to 15 users to help you with setup.

Use this chapter to:

• Create additional setup users.

• Enable the initial user created by Oracle to participate in the setup process.

The initial user can perform security tasks, such as creating other users and granting setup permissions, but
needs the additional privileges granted to setup users.

• Enable setup users to monitor all background processes

• Learn how to reset passwords for users

Here's a list of the setup tasks. You can open the tasks from the Sales offering in the Setup and Maintenance work area.
Tasks are organized by functional areas. Remember that you may have to show All Tasks to see the task you want.

Step Description Navigation Where to Get More Details

1
 

Create other setup users.
 

Setup and Maintenance > Sales >
Users and Security > Manage
Users
 

Create Setup Users

2
 

Provision the initial user with the
same permissions as the other
setup users.
 

Setup and Maintenance > Sales >
Users and Security > Manage
Users
 

Provide the Initial User the Same
Permissions as Other Setup Users

3
 

Any setup users you create
receive an email notification with
a link they can use to reset their
passwords. If they don't receive
the email for some reason, you
can reset user passwords and
update email addresses in the
Security Console. (You can open
the Security Console using the
task Manage Applications Security
Preferences)
 

Setup and Maintenance >
Sales > Users and Security >
Manage Applications Security
Preferences
 

See the section: Reset User
Passwords and Update Email
Addresses
 
To understand the notification
process for new accounts and
recommendations on the kinds of
notification changes you may want
to make, see the topic: Automatic
New Account Notifications and
What to Change
 
For setup instructions, see: Set
Up Preferences for User Names,
 Passwords, and Notifications
 

4
 

By default, setup users can only
see the scheduled processes
they themselves submit. Use the
Security Console to provide all
of the setup users the ability to
see what processes are running

Setup and Maintenance >
Sales > Users and Security >
Manage Applications Security
Preferences
 

See the topic: Give Users the
Permission to View All Scheduled
Processes
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Step Description Navigation Where to Get More Details

and their status, no matter who
submitted them.
 

About Setup Users and Security  
Providing users with the security permissions they need to complete the setup tasks in this guide is very simple if you
used Setup Assistant for your initial setup. You just make a couple of entries and click Save. Provisioning rules provided
by Oracle do the rest. This topic provides a brief overview of Oracle's security model, lists the permissions that setup
users need, and explains how the provisioning process works.

How Permissions Are Grouped and Provisioned
Oracle uses the Role-Based Access Control (RBAC) security industry standard. The permissions are grouped in two
types of roles:

• Job roles, which provide users with the permissions to carry out tasks specific to a job, such as a sales manager
or sales administrator

• Abstract roles, which permit users to complete tasks that are common to all employees or resources

You typically provision salespeople with the job roles corresponding to the roles they play in the sales organization (their
resource roles), as well as the employee and resource abstract roles. The employee abstract role provides access to
reports and personal profile information. Without the resource abstract role, users can't participate in the sales process,
create accounts and opportunities, or be assigned to sales teams. You can find the description of each job and abstract
role Oracle provides and all the duties that come with it in security reference guides.

When you create users, the application automatically provisions them with the required job roles and abstract roles
using role-provisioning rules. Each role-provisioning rule is made up of the rule conditions and the names of the job
roles and abstract roles that are assigned to the user if the conditions are met. In the sales application, the job role and
the resource abstract role are assigned to a user based on the resource role. The employee abstract role is provisioned
to all users of type employee.

As long as you used Setup Assistant, the application creates all the role-provisioning rules you need for setup users and
all the standard sales users. If you set up the company information in a different way, then you must create all the role
provisioning rules yourself. That's true if you're setting up the application together with Oracle HCM Cloud or another
cloud service. You must also create role-provisioning rules for any additional resource roles you create. You can learn
more about role-provisioning rules in the Get Ready to Create Sales Users chapter and in the Securing CX Sales and B2B
Service guide.

Security Roles Required by Setup Users
To complete the setup tasks in this guide, you must be provisioned with the security roles listed in the table. The initial
user provided by Oracle comes provisioned with only the first three. While the initial user can create other users and
perform many setup tasks, the initial user can't complete all the tasks without the additional security roles.

4
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Role Type Permissions the Role Provides

Application Implementation Consultant
 

Job Role
 

Access all setup tasks across all products
 

IT Security Manager
 

Job Role
 

Access security tasks, including the ability to
assign other security roles
 

Application Diagnostics Administrator
 

Job Role
 

Access diagnostic tests and data
 

Employee
 

Abstract Role
 

Access BI reports and run and monitor
background processes
 

Sales Analyst
 

Job Role
 

Create sales recommendation rules
 

Sales Administrator
 

Job Role
 

Perform the sales administrator duties
 

Note:  For licensing reasons, use the Application Implementation Consultant role only for the initial setup tasks.

How You Create and Provision Setup Users
To provision the required security roles, just create setup users as users of type employee and assign them the Sales
Setup User resource role. It doesn't matter whether the user you're setting up is an actual employee or not. Provided
you used Setup Assistant for your initial setup, Oracle creates two role-provisioning rules that do the rest:

• The Employee rule automatically assigns the Employee abstract role to all users of type Employee.

• The Sales Setup User rule automatically assigns all users with the Sales Setup User resource role (the
condition), with all of the required job roles.

5
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The setup users you create aren't assigned the Resource abstract role, so they can't participate in the sales process. But
there is nothing stopping you from creating other provisioning rules to provision sales administrators or others with the
same setup permissions.

Create Setup Users  
Follow this procedure to create users who can perform the sales setup discussed in this guide.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Users and Security

6
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◦ Task: Manage Users

Alternatively, click Navigator > My Team > Users and Roles.
2. On the Search Person page, click Create.
3. On the Create User page, in the Personal Details region, enter the user's name and a unique email address.

The application automatically sends user notifications to this email address unless you disable notifications in
the Security Console.

4. In the User Details region, you can enter a user name.

If you leave the User Name field blank, the application automatically creates a user name for you. By default,
the application uses the email unless you made changes in the Security Console.

5. To automatically send an email notification to the user, select the Send user name and password option in
User Notification Preferences. The email includes a link to create a password in the application.

Note:  If this option isn't available, notifications may be disabled. Check the notification settings in the
Security Console.

6. Select these values in the Employment Information region:

Field Value to Select Comments

Person Type
 

Employee
 

For setup only. The user need not be an
employee.
 

Legal Employer
 

Your company name followed by the letters
LE

 

The legal employer name is used for setup
only, so doesn't have to correspond to any
actual entity.
 

Business Unit
 

Your company name followed by the letters
LE BU

 

The business unit name, like the legal
employer name, is used for setup only.
 

7. In the Resource Information section, select Sales Setup User from the Resource Role list.
8. Click Autoprovision Roles.

The Role Requests region displays the following roles:

◦ Application Diagnostics Administrator

◦ Application Implementation Consultant

◦ IT Security Manager

◦ Employee

◦ Sales Analyst

◦ Sales Administrator

The role request process may take a few minutes to complete because it's set to run periodically. You can view
the status of the request anytime you edit the user.

9. Click Save and Close.

7
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If you selected the Send user name and password option and notifications are enabled, the application sends
the new account notification email. If you didn't select this option, then you must reset the password for the
user using the procedure described in the Resetting User Passwords topic. After you create the user, you can
no longer update the email address in this UI. You can instead update the email address on the Users tab in the
Security Console.

Related Topics
• Set Up Preferences for User Names, Passwords, and Notifications

• Automatic New Account Notifications and What to Change

Provide the Initial User the Same Permissions as Other
Setup Users  
Use this procedure to grant the initial user the same permissions as the other setup users.

1. Click Navigator > My Team > Users and Roles.

Alternatively, you can open this task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Users and Security

◦ Task: Manage Users

2. On the Search Person page, enter the first name of the initial user in the Keywords field and click Search (the
right-arrow icon).

3. Select the name link in the Search Results.
4. On the Edit User page, in the Resource Information region, select Sales Setup User from the Resource Role

list.
5. Click Autoprovision Roles.

The Role Requests region displays these roles:

◦ Sales Analyst

◦ Employee

◦ Sales Administrator

Your role request process may take a few minutes to complete because it's set to run periodically. You can view
the status of the request anytime you edit this user.

6. Click Save and Close.

If you're signed in as the initial user, you must sign out and then sign in again for the new permissions to take
effect.

8
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Reset User Passwords and Update Email Addresses  

Reset Passwords for Others  
Use the Security Console to reset passwords for other users. Only setup users, and other users with the IT Security
Manager job role, can access the Security Console.

All users can reset their own passwords by clicking their user name or image, and selecting the Set Preferences link in
the Settings and Actions menu. They can also reset their passwords by using Forgot Password on the sign-in page.

1. Open the Security Console. You have two options:

◦ In Setup and Maintenance, go to the following:

- Offering: Sales
- Functional Area: Company Profile
- Show: All Tasks
- Task: Manage Applications Security Preferences

◦ Click Navigator > Tools > Security Console.

2. You can ignore and close any warnings regarding the scheduling of the Import Users and Roles Application
Security Data job.

3. Click the Users tab.
4. Search for the user using one of the following:

◦ First or last name, but not both

◦ User name

Here's a screenshot of the Users tab highlighting the location of the Action menu.

5. From the Action menu, select Reset Password.
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6. In the Reset Password page, you have two options:

◦ To send an email to users with a link they can use to create their own passwords, select the
Automatically generate password option.

◦ Reset the password yourself:

i. Select the Manually change the password option.
ii. Enter the new password twice.

Note:  The manual option is available only if you selected the Administrator can manually reset
password option while editing the password policy for the DEFAULT user category in the Security
Console.

7. Click Reset Password.

Related Topics
• Set Up Preferences for User Names, Passwords, and Notifications

Change a User's Email Address  
To change sales users' email addresses, use the same import process that you used to create them. You can also use
REST services.

You can also use these steps to change email addresses on the Users tab in the Security Console work area. However,
this method is not always foolproof:

1. Open the Security Console by clicking the Security Console link under the Tools heading in the Navigator.
2. Click the Users tab.
3. Search for the user using one of the following:

◦ First or last name, but not both

◦ User name

4. Click the user name link.
5. On the User Account Details window, click Edit.
6. In the Edit User Account window, edit the email address.

Note:  Don't edit any of the other information available on the Edit User Account page. Use the Manage Users
task instead.

7. Click Save and Close.

Related Topics
• What can I use the Security Console for?
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Change Your Password  
Use the application link your company gave you to open the Sign In page and change your password for better security.
You can use either of these methods to change your password.

• After you sign in, you can change your password using the Set Preferences option.

• On the Sign In page, you can change your password using the Forgot Password link.

Change Your Password Using Set Preferences
1. Click your user image or name in the global header, and on the Settings and Actions menu, select Set

Preferences.
2. In the General Preferences section, click Password, and enter your password details.
3. Click Save and Close.

Change Your Password Using Forgot Password
1. On the Sign In page, click the Forgot Password link.
2. Enter the registered work email, select the Forgot Password option and click Submit.

A notification containing a link to reset your password is sent to your work email.

Note:
• If you don’t have your work email registered, the notification is sent to your line manager.

• If both you and your line manager don’t have work emails registered, you’ll not be able to reset your password.
Contact your security administrator to register your work email.

This table shows which method you can use for resetting passwords based on your Single Sign-On (SSO) configuration.

Password Reset Method to UseSSO Configuration

Set Preferences Option Forgot Password Link

SSO Disabled Yes Yes

SSO Enabled No No

SSO with Chooser Enabled (both SSO sign-in and local
authentication options are available)

No Yes

Give Users the Permission to View All Scheduled
Processes  
Your application setup requires you to run numerous scheduled processes and ensure they complete successfully. By
default, users can only see the scheduled processes they themselves submit. By creating a custom role in the Security
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Console and assigning all of the setup users to it, you ensure that everyone can see what processes are running and
their status, no matter who submitted them.

1. Open the Security Console.
2. Click the Roles tab.
3. On the Roles tab, click Create Role.

The Create Role page displays a series of steps you can click directly or reach using the Next button.

4. In the Create Role: Basic Information step, make the following entries:

Field Suggested Entry

Role Name
 

Monitor ESS Processes
 

Role Code
 

MonitorESSProcesses
 

Role Category
 

Common -Abstract Roles
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5. Click the Role Hierarchy step.

6. Click Add Role.
7. In the Add Role Membership window, search for ESS Monitor Role and click Add Role Membership.

8. Click Cancel to close the Add Role Membership window.
9. Click the Users step.

10. Click Add User and add all of the setup users by searching for each by name and clicking Add User to Role.
11. Click Cancel when you are done.

The Users step should list all of the users you added.
12. Click Next to get to the Summary and Impact Report step.
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13. Click Save and Close.

The users you added to the role can now monitor all of the scheduled processes in the Schedule Processes
work area.
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3  Accounting Calendar

How the Accounting Calendar Impacts Forecasting and
Other Sales Features  
The accounting calendar defines the start and end of your fiscal year and the time periods in that calendar, including
the exact dates for each time period. Your sales application uses these defined periods, often called enterprise periods,
for multiple purposes.

Here are some examples:

• Reports that provide amounts by enterprise period, such as a sales pipeline analysis

• Metrics calculations by period for territory analysis

• The ability to adjust forecast amounts by time period

• Distribution of quota amounts by time period

The period frequency set in your fiscal calendar is the shortest period you can use. Most sales organizations select
monthly (the default setting in Setup Assistant). A monthly period frequency enables you to generate monthly
forecasting windows that permit your organization to update quarterly forecasts. And you can break down activities
and reports by month and summarize by quarter and year. If you set the period frequency to yearly, then you can create
reports and activities for the year, but cannot break them down by month. If you set the period frequency to weekly,
then you can perform activities and generate reports by week, quarter, and year, but not by month because the number
of weeks varies by month.

Accounting Calendar Setup Tasks Setup Assistant
Completes for You  
The entries you make in Setup Assistant completes all of the tasks you need to create the accounting calendar and
enable it for use in your sales application:

• Creates the accounting calendar itself.

• Creates the forecasting periods for five years from the year you entered.

• Enables the calendar for use by setting the profile Accounting Calendar Default.

• Enables the calendar to be used in analytics and report by running the Refresh Denormalized Time Dimension
Table for BI process.

Follow the procedures in this chapter to review the accounting calendar that was created for you and, if required, to
create additional forecast periods in the future.
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Review the Accounting Calendar and Generate
Additional Forecasting Periods  
You can review the accounting calendar Setup Assistant created for you. Optionally, you can generate forecasting
periods for additional years in the future in your review.

If you need to make other changes to the accounting calendar, if you need to start the calendar in an earlier year,
for example, then you must create a new accounting calendar. See the Create the Accounting Calendar topic in the
Implementation Reference guide. You can't create a different accounting calendar after you start using your calendar for
forecasting and reporting.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Company Profile

◦ Task: Manage Accounting Calendars

2. On the Manage Accounting Calendars page, click the name of the calendar created for you by Setup Assistant.
3. The Edit Accounting Calendar page displays the periods created for you by year from the starting date you

entered in Setup Assistant. You can change the year format and generate periods for additional years.
4. Here's how to generate periods for additional years. For each year, do the following:

a. On the Edit Accounting Calendar page, click Add Year.
b. Click Save.

5. When you complete adding all the years, click Save and Close.
6. Click Done.

Related Topics
• Create the Accounting Calendar
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4  Geography Data

Setup Overview  
Import and set up reference geography data for the countries where you do business. Importing the reference
geography data makes it possible for you to set up validation for address elements such as states and cities to prevent
address data entry errors.

For example, if you're setting up sales territories by states in the US, it's a good idea to have salespeople select the
states from a list rather than entering them manually. Preventing address entry errors ensures that the accounts are
assigned to the correct territory and that opportunities are included in forecasts. If you subscribe to the Oracle Address,
Email, and Phone Verification service, you don't really need the validation. Using the service, salespeople can look up
and enter valid addresses for most countries in the world at a fraction of a penny a piece. However, it's a good idea to
import and set up the geography data anyway. An extra bit of validation can't hurt. Besides, the geography data you
import is a shared resource that's used by HCM, supply chain, and financials cloud services, and it's free!

Oracle licenses geography data from Loqate that you can import, at no additional cost. Alternatively, you can license
geography data from another supplier and import it from a file. For more information about importing third-party
geography data, see the guide Understanding Import and Export Management for CX Sales and Fusion Service.

Here's the list of the setup tasks. You can open the tasks from the Sales offering in the Setup and Maintenance work
area. Tasks are organized by functional areas. Remember that you may have to show All Tasks to see the task that you
want.

Step Description Functional Area and Task Name Where to Get More Details

1
 

You can import the geography of
up to 3 countries at a time using
the Setup Assistant.
 
You can also import countries
using the Manage Geographies
task.
 

Setup and Maintenance > Sales >
Sales Foundation > Manage
Geographies
 

Overview of Geographies Import
Geography Reference Data
 

2
 

For the countries you imported,
 you can enable validation and lists
of values for address elements
such as states.
 
When you enable validation on an
address element, the application
suggests alternatives during
address entry. Enabling a list
of values requires the user to
make a selection from a list. Both
validation and lists of values are
enforced in the UIs.
 

Setup and Maintenance > Sales >
Sales Foundation > Manage
Geographies
 

Set Up Geography Validation

3
 

The validation affects entries made
in the application UI only. You must
set the profile option Geography

Setup and Maintenance > Sales >
Sales Foundation > Manage
Administrator Profile Values
 

Set Up Geography Validation
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Step Description Functional Area and Task Name Where to Get More Details

Address Validation Enabled to Yes
to validate addresses you import.
 

4
 

Enable the mapping of account
and contact addresses for each of
the countries that you import. With
mapping enabled, salespeople on
the go can view their contacts on a
map and obtain directions on their
mobile phones with the click of a
button.
 
If you selected the geocoding
option for a country in Setup
Assistant, you can skip this step.
Selecting geocoding for one
country, enables it only for that
country.
 

Setup and Maintenance > Sales >
Sales Foundation > Manage
Geographies
 

Enable Address Mapping
 

Setup Assistant and Geography Data  
Using Setup Assistant, you can import the geography data for up to three countries at a time. Here's an explanation of
what geography setups Setup Assistant completes for you and which you must complete manually as described in this
chapter.

What Setup Assistant Does for You
• Imports the geography data for up to three countries each time you run it.

• Enables the mapping of addresses for a specific country when you select the Geocoding option for that country.

• If you selected the Geocoding option for any country, the application schedules the Populate Location Latitude
and Longitude Information process to automatically generate geographic coordinates from addresses. Oracle
CX Sales Mobile and other applications use this to put addresses on a map.

What You Must Complete Manually
• You must set up validation for address elements that you are using for sales territory assignment.

If you're assigning accounts to salespeople by state, for example, having a list of values for States ensures that
salespeople don't make mistakes during manual address entry.

• Import geographies for additional countries.

• Enable geocoding for additional countries.

• If you didn't turn on geocoding in Setup Assistant, you must run the Populate Location Latitude and Longitude
Process on a regular schedule.
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Import Geography Reference Data  
Here's how to import geography reference data licensed by Oracle.

1. In Setup and Maintenance, go to: Sales offering > Sales Foundation functional area > Manage Geographies
task.

2. In the Manage Geographies page, enter either the country name in the Country Name field or the two-letter
ISO code of the country in the Country Code field.

Examples of ISO country codes include US (United States) and AT (Austria).
3. Click Search.
4. Select the country in the search results. Don't click the link.
5. Select Import Geography Data from the Actions menu.

Note:  The Import Geography Data action is disabled if the country isn't available from Loqate or if the
country data is already imported.

6. Click OK to close the warning message.
7. Click OK to close the confirmation message.

The import of larger countries might require several hours to complete. You can track the progress of the import
process by selecting Scheduled Processes from the Navigator menu.

After the import completes successfully, the Completed icon (check mark) replaces Go to Task icon in the Structure
Defined and Hierarchy Defined  columns on the Manage Geographies page.

Here's a screenshot of the Manage Geographies page with the Completed icons (check marks) highlighted.

The Geocoding Defined and Address Cleansing Defined columns are used for additional features that you set up
separately:

• Geocoding enables mapping features in your application, such as the display of customer locations on a map in
the UI. For details, see the Enable Address Mapping topic.

• Address cleansing makes it possible to validate addresses down to the street level. Address cleansing requires
you to obtain a separate license for the Address Verification Cloud Service.
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Note:  The geography data is provided by Loqate is third-party content. As per Oracle policy, this software and
documentation may provide access to or information on content and services from third parties. Oracle and its
affiliates aren't responsible for and expressly disclaim all warranties of any kind with respect to third-party content
and services. Oracle and its affiliates aren't responsible for any loss, costs, or damages incurred due to your access
to or use of third-party content, products, or services.Report any issues with Loqate data to Oracle Support who will
contact the appropriate team for correction. Alternatively, you can make manual changes to the geography data by
using the Manage Geographies task in the Setup and Maintenance work area.

Related Topics

List of Available Countries with Loqate Geography
Reference Data  
Oracle Applications Cloud provides third-party Loqate geography data for import. Here's the list of countries for which
the Loqate geography data is available for import.

Country Name Country Code

Andorra
 

AD
 

Angola
 

AO
 

Argentina
 

AR
 

Australia
 

AU
 

Austria
 

AT
 

Belgium
 

BE
 

Bolivia
 

BO
 

Bosnia and Herzegovina
 

BA
 

Brazil
 

BR
 

Bulgaria
 

BG
 

Canada
 

CA
 

Cayman Islands KY
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Country Name Country Code

  

Chile
 

CL
 

China
 

CN
 

Croatia
 

HR
 

Cuba
 

CU
 

Cyprus
 

CY
 

Czech Republic
 

CZ
 

Denmark
 

DK
 

Dominican Republic
 

DO
 

Ecuador
 

EC
 

Estonia
 

EE
 

Finland
 

FI
 

France
 

FR
 

Germany
 

DE
 

Great Britain
 

GB
 

Greece
 

GR
 

Guadalupe
 

GP
 

Guam
 

GU
 

Guernsey
 

GG
 

Hungary
 

HU
 

Iceland
 

IS
 

India IN
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Country Name Country Code

  

Indonesia
 

ID
 

Ireland
 

IE
 

Isles of Man
 

IM
 

Israel
 

IL
 

Italy
 

IT
 

Jamaica
 

JM
 

Japan
 

JP
 

Jordan
 

JO
 

Kenya
 

KE
 

Latvia
 

LV
 

Liechtenstein
 

LI
 

Lithuania
 

LT
 

Luxembourg
 

LU
 

Malaysia
 

MY
 

Malta
 

MT
 

Martinique
 

MQ
 

Mexico
 

MX
 

Netherlands
 

NL
 

New Zealand
 

NZ
 

Norway
 

NO
 

Oman OM
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Country Name Country Code

  

Peru
 

PE
 

Poland
 

PL
 

Portugal
 

PT
 

Puerto Rico
 

PR
 

Qatar
 

QA
 

Reunion Island
 

RE
 

Romania
 

RO
 

Russia
 

RU
 

San Marino
 

SM
 

Singapore
 

SG
 

Slovakia
 

SK
 

Slovenia
 

SI
 

South Africa
 

ZA
 

South Korea
 

KR
 

Spain
 

ES
 

Sri Lanka
 

LK
 

Swaziland
 

SZ
 

Sweden
 

SE
 

Switzerland
 

CH
 

Taiwan
 

TW
 

Thailand TH
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Country Name Country Code

  

Tunisia
 

TN
 

Turkey
 

TR
 

United Arab Emirates
 

AE
 

United States
 

US
 

Uruguay
 

UY
 

Vatican City
 

VA
 

Vietnam
 

VN
 

Set Up Geography Validation  
Set up geography validation for those geography elements that you plan to use in your sales territories to prevent data
entry errors. By default, application enforces the validation you specify for creating addresses in the UI only, so you
must turn the validation on for import.

Set Up Validation

1. Open the Manage Geographies task from the Setup and Maintenance work area using the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Geographies

2. On the Manage Geographies page, search for each country you imported using either its name or its two letter
ISO code. For example, you can search by entering either the country name United States or the two letter ISO
code US, and clicking Search.

3. Select the country in the Search Results area.
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4. Click Go to Task in the Validation Defined column.

Here's a screenshot of the Manage Geographies page highlighting the Go to Task icon in the Validation Defined

column. 
5. On the Manage Geography Validation page. Address Style section, ensure that the No Styles Format address

style is selected. Defining validation for the No Styles Format address style ensures that the validations are
performed for all addresses in the country.

6. Select Enable List of Values in the Geography Mapping and Validation section to display a list of values during
address entry in the UI. For example, to have users select states from a list, select Enable List of Values for
State.

Vision Corp. enables the list of values for State. The company uses states for its sales territories and wants to
ensure that state names are always entered correctly.
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7. Select Geography Validation for all the geography types that you plan to use in territories.

In our example, Vision Corp. plans to set up sales territories by state, so it selects Geography Validation for
State.

Here's a screenshot of the Manage Geography Validation page highlighting the location of the Enable List of
Values and Geography Validation options for the US State geography type.

Note:  If you don't select the validation for an address element, the application still suggests values during
address entry. It just doesn't validate the address element.
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8. Specify if you want to allow users to save incomplete or invalid addresses by making a selection from the
Geography Validation Level for Country list.

◦ No validation: permits users to save incomplete or incorrect addresses.

◦ Error: permits only valid addresses to be saved.

Vision Corp. wants to save all addresses, including incomplete and invalid addresses, so it selects No
validation.

9. Click Save and Close.
10. Click Done in the Manage Geographies page.

Turn On Validation for Address Import
You must set a system profile option Geography Address Validation Enabled to Yes for the validation to be enforced
during import.

1. Open the Manage Administrator Profile Values task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option by entering Geography Address
Validation Enabled in the Profile Display Name.

3. Select Yes as the Profile Value.
4. Click Save and Close.

Enable Address Mapping  
You can quite literally put your accounts and contacts on the map by enabling geocoding as described in this topic.
Geocoding turns the addresses you enter or import into longitude and latitude coordinates so that the locations can be
displayed on a map.

Enabling address mapping involves two steps:

1. You enable the generation of geographic coordinates for a country
2. You run a process that converts the addresses into geographic coordinates

Salespeople must enter valid postal addresses for geocoding to work, so it's a good idea for you to validate the
addresses in your application by subscribing to Oracle Address Verification Cloud Service.
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What You're Enabling
Salespeople benefit from geocoding in two ways:

• In the office, salespeople can view the location of an account address on the map while editing the account
record.

• Using Oracle CX Sales Mobile on their smart phones, salespeople can view a map showing the locations of
accounts and contacts within a certain radius of their current location, or any other location they choose.
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They can obtain travel directions to any of the locations with the tap of a finger (CX Sales Mobile passes the
coordinates to the native mapping application on the phone).

Turn on Geocoding on the Manage Geographies Page
To turn on geocoding for a country, all you need to do is select the Geocoding Defined icon for the country where you
want to turn it on. Here are the steps:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Geographies
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2. On the Manage Geographies page, search for a country you imported using either its name or its two letter ISO
code. For example, you can search by entering either the country name United States or the two letter ISO code
US, and clicking Search.

3. Click the Geocoding Defined icon.
4. Click Done

Run the Populate Location Latitude and Longitude Process
Run the process that converts the addresses to the location latitude and longitude regularly and each time you import.
Addresses that salespeople enter or addresses that you import don't show up on the map until the process completes,
so schedule the process to run as frequently as necessary. If you imported geography data using Setup Assistant and
turned on geocoding for any country, the process is already scheduled to run for you. Here's how to run the process:

1. In the Navigator, click Scheduled Processes under the Tools heading.
2. Click Schedule New Process.
3. Click the Name drop-down list icon and the Search link at the bottom of the list.
4. In the Search and Select: Name window, search for "Populate Location Latitude and Longitude Information".
5. Select the process name in the search results and click OK.
6. In the Schedule new Process dialog box, click OK to confirm your selection.
7. In the Process Details window, click Advanced to view the advanced options.
8. You can make the following entries on the Parameters Tab:

Parameter What to Enter

Country Code
 

Leave this field blank if you want to generate the coordinates for all the countries you enabled
for geocoding, or enter a specific country code.
 

Start Date, End Date, and Regenerate
Geocode
 

Leave these fields blank. The geocoding process picks up any addresses that have not been
geocoded previously.
 

Batch Size
 

Leave this field blank unless you're geocoding more than 50,000 addresses at a time. If you're
processing a large number of addresses, then enter 1000. By default, the application launches
a subprocess for each batch of 500 addresses. There's a maximum of 10 subprocesses, so, if
you're processing more than 50,000 addresses, then you must run the process multiple times.
You can increase the batch size up to a maximum of 1,000.
 

9. Schedule the process to run regularly:

a. Click the Schedule tab.
b. Select Using a Schedule and specify the frequency.

10. Click Submit.

The application confirms your process was submitted.
11. You can monitor the process completion on the Overview page.

The process spawns multiple processes, depending on the batch size and the number of addresses you need to
process.

30



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 5
Search

5  Search

Overview of Optional Setup for Adaptive Search  
In this chapter, you learn about optional setups: how to make additional keywords available for search in both classic
and Redwood UIs, for example. This chapter assumes you've completed the steps outlined in the playbook How do
I configure Adaptive Search? first. If you use Setup Assistant for your initial setup, it enables the Adaptive Search
configuration provided by Oracle for the objects that you selected.

For additional advanced configuration and for information on how to configure search in individual work areas, see the
Adaptive Search and Workspace chapter in the Implementation Reference guide.

Here's a list of optional tasks that you can use to configure the way search works in your application:

Step Applies To Description Navigation Where to Get More Details

1
 

Both Redwood and Classic
Sales

By default, Adaptive Search
is configured for keyword
search on all the important
fields. However, you can
make additional fields
searchable both in Sales for
Redwood UIs and in Classic
Sales UIs, including global
search and Workspace.
 

Setup and Maintenance >
Sales > Sales
Foundation > All Tasks >
Configure Adaptive
Search > Setup >
Advanced
 
 

See the topic: Make
Additional Fields
Searchable
 

2 Sales for Redwood Configure the list of values
that use Adaptive Search,
 called Smart Pickers.

Configuration done in VB
Studio.

See the topic Configure the
Picker
 
.
 

3 Sales for Redwood and
Classic Sales
 

Configure what shows up
in list of prioritized recent
items, called Smart Lists.
 
For example, you can
specify how long to keep
the items in smart lists if
they aren't acted on and
how frequently the lists are
refreshed.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Administrator Profile
Values

See the topic: Change the
Behavior of the Show Smart
List Filter
 

4
 

Classic Sales For Global Search, a feature
available only in Classic
Sales, you can restrict the
number of the objects that
can be searched.
 
By default, all of the objects
you enabled in Adaptive
Search are automatically
searchable from the Global
Search box at the top of the

Setup and Maintenance >
Sales > Sales
Foundation > All Tasks >
Configure Adaptive
Search > Configure Global
Search
 

See the topic: Configure
Global Search Scope and
Display of Search Results
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Step Applies To Description Navigation Where to Get More Details

page. If you enabled the
Partner object, for example,
 a salesperson searching
for the name "Pinnacle",
 gets both the accounts and
partners named Pinnacle.
 

5
 

Classic Sales Optionally, you can
configure the way the
global search UI appears
to salespeople by creating
your own configuration for
Classic Sales. For example,
 you can change which
suggestions display when
you click in the search
box and which objects get
displayed in search results
by default.
 

Setup and Maintenance >
Sales > Sales
Foundation > All Tasks >
Manage Global Search
Configurations
 

See the topics:
 

• Global Search UI

• Configure Global
Search UIs

Related Topics

Adaptive Search and Workspace  
Oracle is completing the process of replacing the CRM search technology with Adaptive Search, a high-performance
search engine that provides keyword searching and enhanced filtering capabilities. Sales in Redwood UIs and features
rely exclusively on Adaptive Search. In Classic Sales, some work areas still rely on legacy CRM Search technology.

By default, all customers now have Adaptive Search enabled automatically for Accounts and Contacts. You can enable
other objects using Setup Assistant or manually. Not all the available objects are sales objects. For example, Partner and
Partner Contact are only pertinent for Partner Relationship Management. HR Help Desk Request, Installed Base Asset,
Internal Service Request, and Service Request are specific to Fusion Service. Adaptive Search is also available on custom
objects or child objects you create.

Here's where you can use Adaptive Search:

• All Sales in Redwood UIs

• Workspace in Classic Sales

A work area where salespeople can work on all of the available business objects at the same time.

• Work areas for individual business objects in Classic Sales.

• Global Search in Classic Sales

This is the keyword search available at the top of the page in Classic Sales.

• REST APIs

Note:  Many customers run their applications and Oracle Databases in their own data centers on Oracle
Cloud@Customer. Currently, Cloud@Customer pods or government pods don't support Adaptive search.
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Use Setup Assistant to Enable Search  
Setup Assistant sets up everything your sales organization needs to start using Adaptive Search for standard objects in
Oracle Sales.

What Setup Assistant Does for You
• Enables the objects you selected for Adaptive Search and runs the indexing process at the recommended

intervals. The Setup Assistant enables the search configuration provided by Oracle. Adaptive Search is the
search technology that powers all Oracle Sales in the Redwood User Experience searches, including smart
pickers. It's also the search technology used for most Classic Sales features, including Workspace, individual
work areas, Workspace infolets, Global Search, and REST APIs.

• The Setup Assistant also sets up the search for work areas that still use the legacy CRM-specific search
technology:

◦ Enables the work area searches in the work areas that don't yet use Adaptive Search.

◦ Runs the Synchronize CRM Search Indexes process every 5 minutes. This process sets up the search
index for work area searches.

◦ Runs the Optimize CRM Search Indexes process weekly. This process keeps the work-area search index
from getting fragmented.

Note:   If your implementation requires indexing processes to run at different intervals, you must
schedule the processes separately using individual tasks available from the Scheduled Processes page
(Navigator > Tools > Scheduled Processes). For details, see the topic Schedule Work Area Search
Processes topic in the Implementation Reference guide.

What You Can Set Up Manually
• Modify the way global search works.

• Configure the way keyword searches work.

• Add or remove objects available in Adaptive Search.

• Create saved searches for the sales organization.

Search in Sales in Redwood and Classic Sales UIs  
There are multiple ways to search in Sales in Redwood and Classic Sales.

List Pages in Sales in Redwood
Here's a brief overview of how salespeople search in the list pages in Sales in Redwood work areas.

1. They place the cursor in the search field and select a saved search as the starting point.
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The selected saved search determines the breadth of the search. For example, the My Accounts saved search
restricts the search to accounts where the salesperson is in the team or territory. The filters are displayed right
above the search field.

2. In the search field, they can enter filters and keywords:

◦ Add filters to filter results by a specific field. For example, to filter out all the accounts in Boston:

i. Enter city.
ii. Select Primary Address: City to specify the address type.

iii. Select Equals as the operator.
iv. Enter the city name: Boston.

For more search options see the Using Sales in Redwood guide topics Filter a List and Filter by Numbers
and Dates

◦ Enter one or more keywords to search on and press return. Keywords can be words in the name or in
related fields and objects. See the topic: Search Using Keywords.

3. Further configure the search results:

◦ You can group your results by selecting the attribute you want to group by.

◦ Change the columns displayed in the search results by clicking Actions (the three dots) and selecting
Manage Columns.

◦ Change the order of the columns by selecting and dragging.

◦ Change the default sort order using the controls at the top of each column.

4. Click Save to save your search criteria and search result formats to create a saved search.

Sales in Redwood List Page Features

Callout Number Description

1 Name of the saved search that's generating the list on the list page.

2 List of filters in the search.

3 Search bar where you select saved searches, and enter filters and search terms

4 Group search results

5 Take actions:
• Save to create a new saved search

• Export the list

• Manage columns in list results

• Sort to display most relevant records first
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Search in Workspace and Work Areas in Classic Sales
For searches focused on one sales object and to explore sales data, you can use Workspace and the different work
areas.

Here's an annotated screenshot of Workspace to explain how it works. (The search experience in the work areas
targeted to single objects is exactly the same. You just can't switch objects.) :

1. You select a particular saved search as your staring point (callout 1 in the screenshot).
2. Adding filters (callout 2) lets you explore the list along a particular dimension. When you add industry as a filter

to a list of accounts, for example, you can see which industries have the most accounts and how many there
are.

3. If you are looking for a specific record in the list, you can search by keyword (callout 3).
4. You can save your personalized search as a new search (callout 4).
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Smart Pickers in Sales in Redwood
In Sales in Redwood, a smart picker is a special kind of search on a list of values. Smart pickers leverage your Adaptive
Search setup so that users can quickly and easily find the record they're looking for. Adaptive Search makes it possible
to search using attributes of related objects and you can create saved searches to narrow down the search to the items
you want. For example, a salesperson searching for an account can search on the name of the contact, or the city where
the account is located. Smart pickers also provide "type ahead keyword search", which means that search results appear
as the user starts typing.

Here's an example of a smart picker:
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Global Search in Classic Sales
In Classic Sales, you can use the global search, located at the top of the application pages, to search by keyword across
the different types of sales information. For example, searching using the keyword "Paris," finds all the contacts named
Paris, as well as all the accounts, opportunities, leads, and other records Paris is associated with. You also get all of the
records with Paris addresses. Global search makes it possible to search all records you have permission to view.

Global search uses the same Adaptive Search technology as Sales in Redwood, Workspace and work areas, but it
supports keyword searches only.

Search in Work Areas That Still Use CRM Search
For Products, Business Plans, Service Requests, and Competitors work areas, salespeople can search either by record
name or switch to an advanced search mode to search using multiple search criteria. The saved searches (lists) for the
different work areas use a different technology from those you create for Adaptive Search, so you must set them up
separately.

To highlight the differences in UI features, here's a screenshot of the Advanced Search panel in the Business Plans work
area landing page, a work area with the legacy CRM search.
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Search Type Differences  
Here are the key differences between the two search types.

Search Technology Differences Overview

Search Properties Adaptive Search CRM Search

Where It's Used All Sales for Redwood searches: including list
pages, "smart pickers", and saved searches.
 
In Classic Sales: Workspace, work areas
powered by Adaptive Search, Infolets powered
by Adaptive Search, and saved searches for
these.
 
Adaptive Search is also used in REST APIs.
Global Search uses only Adaptive Search
keyword searches.
 

Legacy work areas including Product, Business
Plans, Service Requests, and Competitors.
Note that you set up Saved Searches for legacy
work areas separately because they use CRM
Search.
 

Search Scope
 

In list pages, you select a saved search to set
the scope of your search
You can search using related information. For
example, you can search for an account by
contact name, address city, and owner.
 

In list pages, you select a saved search to set
the scope of your search and search by name.
You can use advanced search to search using
multiple search criteria.
 

Indexing Frequency
 
Until a new record is indexed, it's not available
for search.
 

Records you create and update in the UI are
automatically indexed and made searchable
within seconds.
 
Imported records or records updated by
background processes aren't available for
search until the process completes.
 

Both records that you create in the UI and those
you import are available almost immediately.
The indexing process usually runs every 5
minutes.
 

List of Recent Items
 
Records you recently created, edited, or
accessed, includes records that haven't been
indexed yet.
 

You get a list of up to 10 most recent items for
each object. In addition, selecting a Smart List,
 displays up to 50 items you recently accessed
ranked by the number of times you accessed
them.
 

Displays recent items when you place your
cursor in the Search field.
 

Wildcards and Operators
 

Use an asterisk (*) at the end or middle of
a word to indicate missing letters and the
question mark (?) to indicate a single missing
letter. You can also use operators OR and NOT,
 and quotation marks (") for exact phrases.
 
Adaptive Search also includes multiple numeric
and text operators that you can use for
advanced search. For example, you can search
on a range of values, on all the words, and
words in a specific order. You can also find
records with no values.
 

Use a percent sign (%) at the beginning, end, or
middle of a word to indicate missing letters.
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Search Properties Adaptive Search CRM Search

Filters Extensive ability to use filters to explore your
data. For example, you see the most frequent
values in a filter and how many records appear
in each.
 
For example, adding the primary industry as a
filter when searching accounts, automatically
displays the most frequent industries and
the number of records for each. A search of
opportunities using win probability as a filter,
 displays different ranges of win probabilities
and the number of records in each range.
 

You can filter your results by adding new search
terms and rerunning yours search.
 

Saved Searches You can create personal saved searches and
sales administrators can also create saved
searches for different roles in the organization.
 
Adaptive Search saved searches can be used in
any feature powered by Adaptive Search.
 
You can reuse Sales for Redwood saved
searches in Workspace, in infolets powered by
Adaptive Search and in Classic Sales Mobile.
 

You can create personal saved searches
and sales administrators can create saved
searches for different roles. Because the saved
searches are built on a different technology
from Adaptive Search, you can't use them in UIs
that use Adaptive Search, including Workspace
and Sales for Redwood list pages.
 

How Salespeople Search and What You Can Configure  
Here's how salespeople search with Adaptive Search and how you can modify the default behavior provided by Oracle.

How Salespeople Search in the UI What Administrators Can Configure

Selecting a saved search displays a list
that matches the saved search criteria and
determines the scope of any search you
perform on the page. For example, if you
select All Accounts, you're searching all
accounts you can view. If you select My
Accounts, then you're searching only the
accounts that you own.
 

You can create your own saved searches targeted to specific roles within the sales organization. And
you can determine which saved search appears by default when salespeople open the UI. Salespeople
can create their own personal saved searches and override the administrator defaults.
 

You can enter one or more search terms in
the Search field.
 
You can use related information for your
searches. For an account, you can search
by company name, the city where the
account is located, or the primary contact
at the company, for example. You can even
search for an account by the name of the
salesperson on the sales team.
 
The search results match whole terms,
 but you can use the (*) wildcard for partial

You can enable or disable the attributes available for search. Oracle enables the most common
attributes for you, but you must enable the search for any child objects and fields you create in
Application Composer.
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How Salespeople Search in the UI What Administrators Can Configure

words and use operators, including NOT,
 OR, and Between for date ranges.
 

You can view the filters used in the saved
search by clicking the Show Filters link.
You can also add filters of your own.
 

You can specify which additional fields users can add as filters and you can set up groupings of values
the filters show. For example, you can break down opportunities by revenue ranges: 0 to 10,000, 10,
000 to 100,000, 100,000 to 500,000, and 500,000 and up.
 

Filters show the most common values
and the number of records in each. For
example, a search of accounts with the
primary industry as a filter, automatically
displays the most frequent industries and
the number of records for each. A search
of opportunities using win probability as
a filter, displays different ranges of win
probabilities and the number of records in
each range.
 
Your filter selections are additive, if
you select Health Care as the primary
industry and then Lisa Jones as the owner,
Workspace displays only those Health Care
accounts Lisa owns.
 

You can configure value ranges for numeric, corporate currency, percent, and date filters. For example,
 you can configure value ranges for the opportunity win probability filter and other similar filters.
 

Salespeople can save any search criteria
they enter as their own personal saved
search.
 

You can create saved searches for use by the whole sales organization and you can tailor them to
different roles.
 
You can expose the saved searches as filters in Workspace infolets to display key sales information
right on the home page.
 

Sales administrators and sales managers
can download search results into an Excel
spreadsheet.
 

You can remove the Export List button from the page using Application Composer. You can also enable
other custom sales roles to use the button, by granting the privilege ZCA_WORKSPACE_EXPORT.
 

Make Additional Fields Searchable  
All of the key fields you need for search of standard objects are searchable (See the topic Adaptive Search Configuration
Provided by Oracle for a list.)

However, you can enable additional fields for search, including custom ones. And you can remove existing fields from
use. This example shows you how to enable the Chief Executive Name field. The field is a standard application text
field, but the same procedure applies to any field, even a custom field on a standard application object. When you're
done with this configuration and publish it, a salesperson can search on the CEO's name to find the account where the
person is the CEO. The search also returns all of the opportunities for that account when you enable opportunities to be
searched by account fields.

Suppose that you added the CEO name field to the Account UI and want to make entries in this field searchable.

Making the field searchable involves these steps:

1. Make the field searchable for its business object.
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2. Optionally, you can enable the field for search of a related object.
3. You publish your configuration.
4. Enable the field for display in UIs as a column and a filter.

Note:  If you want the field to be displayed in the UI, either as a filter or as a column in search results, then you must
enable it for display on the Configure Workspace UI tab of the Configure Adaptive Search page.

Make the Field Searchable in Its Business Object
Here's how you make the field available for searching its business object. For example, making the account searchable
by the CEO name.

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, Setup tab (callout 1 in the screenshot), click Advanced (callout 2).

Note:  If you receive a message that Application Composer changes are being synced, you must wait until
the sync process completes before using the Setup tab. You can use other features of the application in the
meantime.

3. In the left pane, click the name link for the object where the custom field appears (callout 3). The CEO name
field is an account field, so you click Account.

The field is listed in the Configure Fields section.

4. Select the Enable option to index the field for Workspace and Global Search (callout 4).

41



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 5
Search

5. For a text field, including Chief Executive Officer, select the Analyzed Text Search option to index individual
words in the field. Your selection also enables fuzzy search (search that retrieves results with similar spellings).
And you enable other search operators, including All of the words and Any of the words.

6. Select the Include in Keyword Search option to enable the field for searches in the Sales for Redwood list
pages and in Classic Sales Workspace and Global Search.

If you leave this check box deselected, users can't search for accounts using the CEO name. But in Workspace,
they can still add the Chief Executive Name field as a filter for accounts and search the field there. Global Search
doesn't permit you to add filters, only to search by keyword.

7. Select the Include in Object Reference option to enable the field for search in related objects. Make the
selection if you want to use the CEO name when searching for opportunities, for example.

If you didn't select the Include in Keyword Search option, but select Include in Object Reference, then users
searching opportunities can use the field only as a filter.

Make the Field Available for Searching a Related Object
You can only make the field available for search in a related business object if you selected the Include in Object
Reference option for the field.

1. In the left pane of the window, open the object where you want to enable the search. For this example,
Opportunity (callout 1 in the screenshot).

2. Select the field in the left pane, in this example, Account (Callout 2).
3. In the right pane, select Enable (callout 3).
4. If you want to use the field for searches in Global Search and in the Workspace Search box, then you must select

the Include in Keyword Search  option (callout 4).

If you don't select this option, but selected Enable, then the field remains available as a filter in Workspace, but
can't be searched in Global Search.

The Include in Object Reference option isn't relevant here. Here's a summary of the two use cases:

Use Case Enable Include in Keyword Search

Users can search on the field using Global
Search and in the Workspace Search box.

Selected
 

Selected
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Use Case Enable Include in Keyword Search

For example, entering the CEO name,
 they get results containing, not only the
account where the person is a CEO, but the
opportunities for that account as well. In
Workspace, they can also select the fields
as a filter when searching for the object. For
example, when searching for opportunities
in Workspace, they can filter by CEO name.
 

Users can add the field as a filter in
Workspace, but can't search on it using the
Search box or using Global Search.
 

Selected
 

Deselected
 

Change the Behavior of the Show Smart List Filter  

Overview of the Show Smart List Filter  
Salespeople can reduce the amount of navigation and clicking during searches by adding the Show Smart List filter
to the Ask Oracle bar on any list page. The filter displays a list of the most relevant records based on a calculated score.
The records with higher scores appear higher in the list.

For example, adding the filter on the Accounts list page, displays a list of accounts ranked by the number of times a
salesperson has opened each account, its contacts, and its opportunities, and how recently they opened these. So, if
today, a salesperson opens or updates account information on Acme four times, but only opens Pinnacle once, then
Acme appears higher on the list than Pinnacle.

Here are some of the factors that affect the relevancy score:

• Recency: The last time a user interacted with the record.

• Frequency: How often a user interacts with the record.

• Favorites: If the user has marked the record as a favorite.

• Urgency: When an action is expected from a user, such as a task due tomorrow, an upcoming appointment, and
so on.

• Related objects: Relevancy scores are boosted for related accounts, opportunities, or leads associated with
overdue tasks and appointments.

• Event-based updates: For opportunities, updates to win probability, status, and sales stage boost the relevancy
score.

The list of relevant records can display a maximum of 50 items. Items that haven't been touched for 30 days or another
number specified in the Relevancy Aging Maximum Number of Days profile option get automatically taken off the list.
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Supported Business Objects for Lists
Smart lists are derived from users' past and recent application touches and interactions with these business objects:

• Accounts

• Activities

• Contacts

• Leads

• Opportunities

• Partners

• Products and Product Groups

The My List for Accounts and for Other Objects
While salespeople can add the Show Smart List filter to any search on the list page, they can instead select the My List
for <object>  list (the object changes depending on the list page). Selecting the My List for Accounts, for example,
automatically includes the filter and displays a list of the most relevant of all of the accounts the user can access.

Change the Behavior of the Show Smart List Filter  
The Show Smart List filter is available automatically to salespeople as soon as they start working in the application. No
setup is required. However, you can change the filter behavior in a few ways:

• Change how long untouched items are kept in the list, from the default of 30 days.

• Change the refresh rate of the lists from once every 3 hours to near real-time, 10-minute refresh intervals

• Change how often and when the lists are refreshed, to improve the user experience.

Change How Long to Keep Untouched Records in the List
By default, records are kept 30 days after they're accessed last. For example, if your organization has long sales cycles,
then you might want to keep items on the list for a little longer.

You can change the number of days untouched records are kept in the list by setting the profile option, Relevancy
Aging Maximum Number of Days:

1. In Setup and Maintenance, go to: Sales offering >  Sales Foundation Functional area: > Manage
Administrator Profile Values task.

2. In the Manage Administrator Profile Values page, search by the profile option name Relevancy Aging
Maximum Number of Days or code ZCA_UC_AGING_CYCLE.

3. Set the profile option value to the desired number of days.
4. Save your changes.

Change the Refresh Rates of the Lists
You can change the refresh rates from once every 3 hours to near real-time, 10-minute refresh intervals, by setting the
profile option, Enable Near Real Time User Context Relevancy:

1. In Setup and Maintenance, go to: Sales offering >  Sales Foundation Functional area: > Manage
Administrator Profile Values task.
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2. In the Manage Administrator Profile Values page, search by the profile option name Enable Near Real Time
User Context Relevancy or code ORA_ZCA_UC_ENABLE_NRT.

3. Change the profile option value from FALSE to Y to enable near real-time user contextual relevancy.
4. Save your changes.

Run the Processes with Different Frequencies and Schedules
You can change how often or when you run the two scheduled processes that generate the lists and remove untouched
items from the lists:

• Generate Relevancy Feed
Generates the lists by analyzing all records that have been updated in the last 24 hours. By default, this process
runs every three hours.

• Age User Context Relevancy Feed
Removes from the lists all items that haven't been accessed in the past 30 days (the number of days set in the
profile option Relevancy Aging Maximum Number of Days). By default, this process runs once a day.

Classic Sales Search Setups  

Global Search  

Global Search UI  
Global Search is the search box at the top of the page in the Classic Sales UIs. This feature isn't available in Sales for
Redwood. Here's a summary how global search works and how you can configure it.

How It Works What You Can Change

When salespeople click in the global
search box (callout 1), the application
suggests recent search terms, recent
pages you visited, and other recent items.
The items are organized in suggestions
groups (callout 2). For example, under
Recent Items, the application suggests
recent pages you visited.
 

• Change the "Search" prompt in the global search box.

• Specify which suggestion groups get displayed for users by default. For example, you may want
to hide Recent Items and show Recent Searches first.

Salespeople can specify which suggestion
categories they want to see and which
categories of results are available in the
search results, by clicking Personalize
(callout 3), the application suggests recent
items they worked on recently.
 

• Specify which suggestion groups are available for use. For example, instead of hiding Recent
Items by default, you may want to remove it from use entirely so users can no longer display the
category.

Salespeople enter keywords in the search
box (callout 1) and press Return to search
across different objects.
 

• You can specify which objects are available for global search and how the results are displayed.
See the topic Configure Global Search Scope and Display of Search Results
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Here's how the results get displayed after you enter your search term and press Enter.

How It Works What You Can Change

The results of the search show the objects
that are enabled for global search during
setup.
 

• You specify which objects are available for global search and how the results are displayed. See
the topic Configure Global Search Scope and Display of Search Results

Salespeople click Show Filters, and select
those objects they want to see in their
search results (callout 1).
 

• The objects you selected for use in global search, show up as the available filters here.

• You can specify which objects are selected by default.

Clicking on the first line of each search
result opens the record for editing.
 

• By default, users drill down on the record name, but you can specify a different field as the title.

• You can also specify which fields display in the two lines below the title in each search result.
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Salespeople can personalize their global searches by clicking Personalize. See the topic Configure Global Search and
Result UIs to learn how to make changes in the default behavior.

How It Works What You Can Change

Salespeople can specify which objects are
included in search results and in which
order.
 

• You can specify which objects are available for selection and which are enabled by default.

• You can disable personalization of search categories.

Salespeople can specify which
autosuggest groups show up and in which
order when they click in the global search
box.
 

• You can specify which autosuggest groups are available for display and which are enabled by
default.

• You can disable personalization of autosuggest groups.

Here's the Search Categories tab salespeople can use to select which objects (categories) are included in search results.
Changing the order of results isn't supported.
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Salespeople can control which Autosuggest Groups tab makes it possible to control the suggestions you get when you
first click in the global search.
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Related Topics
• Configure Global Search UIs

Configure Global Search Scope and Display of Search Results  
You can specify which of the objects you enabled for Adaptive Search are searchable in Global Search and how the
search results are displayed.

Each search result, includes:

• A title that provides the link that users click to drill down into the record. By default, the name of the record is
the title, but you can choose a different field.

• Two lines displaying fields you specify

Here is a screenshot showing the results of an account search:
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1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search
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2. In the Configure Adaptive Search page, click the Configure Global Search tab in the left-side of the page
(callout 1 in the screenshot).

1. Configure each object you enabled for Adaptive Search:

a. Click the object link in the Objects column on the left (callout 2).
b. You can prevent users from using Global Search to search the object by deselecting the Display in UI

option (callout 3). By default, users can search all objects you enabled for Adaptive Search.
c. By default, users click on the record name link in the search results to drill into a record, but you can

select a different field. To change the drill-down link, click Title (the pencil icon, callout 4) and select the
alternate field.

d. Click the Line 1 edit button and select the fields you want to display in the first line under the title.
e. Click the Line 2 edit button and select the fields you want to display in the second line.
f. Click Save.

2. When you complete configuring all the objects, click Save and Close.

Configure Global Search UIs  
Optionally, you can configure the behavior of global search UIs. For example, you can specify which suggestions display
automatically when users click in the search field and which objects display in search results. You can create different
configurations for different application pages.

Tip:  If you already made a copy of the new OSC Default Global Search Configuration, then you can edit that copy and
make your changes there. You don't need to create a second copy.

Duplicate the Default Configuration Provided by Oracle
You can't make changes to the Global Search configuration provided by Oracle. You must copy the Oracle configuration
and edit that copy instead. If you already created a copy, you can skip this step.

1. Click Navigator  > My Enterprise  >  Setup and Maintenance.
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2. In the Setup and Maintenance work area, open the Manage Global Search Configurations task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Manage Global Search Configurations

3. On the Manage Global Search Configurations page, select the configuration with the OSC short name and
Default Global Search Configuration name.

4. Click Duplicate (the document icon).
5. In the Short Name field, enter an alphanumeric code with uppercase letters and no spaces.
6. Enter a name for your configuration in Display Name.
7. Select CRM as the product family and module.
8. Leave the Default option deselected for now. You select this option as a last step.
9. Click Save and Close.

10. Open the Manage Global Search Configurations page again.
11. Click the name link for the configuration you created.
12. Use the tabs to define your configuration:

◦ Autosuggest: Determine what's available to users in the global search autosuggest, as well as how
autosuggest looks and behaves.

◦ Search Field: Control the Search field in the global header and in the search results dialog box.

◦ Search Results: Specify if salespeople can personalize the filters used in their searches

◦ Pages: Specify where you want your configuration to apply.
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Define Which Groups of Suggestions Users See

1. While editing the global search configuration you created, click the Autosuggest tab.

2. Skip setup of Synonyms as they don't apply to Sales.
3. Keep the Enable personalization of search groups option selected unless you want to prevent users from

personalizing suggestion groups.
4. In the Suggestion Groups section:

◦ Move the Saved Searches group (callout 2), and any other unwanted suggestion groups, to the Available
Groups column. This action removes them from use. Saved searches can't be used with Global Search.

◦ You can remove a suggestion group from being displayed by default by setting Enable to No. Users can
still enable the group when they personalized their global search.

◦ You can change the order the suggestion groups are presented to users.

◦ You can change the suggestion group headings.
i. Click Manage Suggestion Groups.

ii. Duplicate an existing group and edit your copy.
iii. Click Refresh.
iv. Swap your copy for the original.

5. You can turn the suggestion group headings off in the Appearance section (callout 3).
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6. You can change suggestion behavior (callout 4):

◦ Show Top Suggestions: Enable this option to display suggestions in autosuggest as soon as the user
clicks in the search field, even without entering a search term. For example, the last few pages the user
opened would appear as suggestions in the Recent Items group.

◦ Minimum Characters for Autosuggest: Enter the number of characters that users must enter in the
search field before matching suggestions appear in autosuggest.

◦ Maximum Number of Suggestions: Enter the maximum number of suggestions to be displayed across
all suggestion groups. This total is distributed as equally as possible among the groups.

Configure the Global Search Field
Here are the main configurations for the global search box field:

• You can change the minimum and maximum number of characters required for search.

• You can specify a different word to appear in the Global Search box instead of "Search".

Configure How Salespeople Can Use Filters

• In the Saved Search and Recent Search section, you can disable the display of recent searches by deselecting
Enable recent searches. Saved searches aren't available in global search.

• In the Filters section:

◦ Keep Enable personalization of search categories selected unless you want to prevent users from
specifying which objects they see in the search results. You determine the objects that show up as filters
in global search while setting up Adaptive Search (see the topic Configure Global Search Scope and
Display of Search Results).

◦ Enable clear all filters: Allow users to clear all filters by clicking the Clear All Filters button in search
results.

◦ Show applied filters: Show all the filters that have been applied

• The Search Categories section and the rest of the sections on this tab don't apply to Classic Sales.
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Specify the Sales Pages Where Your Configuration Applies and Complete the Configuration
Entering the application pages is a one-time setup. If you're editing a configuration you created, then you don't need to
reenter the page codes again. You can skip this step.

1. Enter codes (view IDs) for the applications or pages where you want your configuration to apply. Here are the
entries for Classic Sales:

View Type View ID

Application
 

CRMPerformanceApp%
 

Application
 

ORA_CRM_SERVICESAPP%
 

Application
 

ORA_CRM_UIAPP%
 

Application
 

ORA_SERVICEAPP%
 

Application
 

SalesApp%
 

Application
 

ORA_FSCM_UIAPP%
 

You can obtain other codes in Setup and Maintenance, using the Manage Taxonomy Hierarchy task as
described the linked topic: Specify the Pages or Applications That a Global Search Configuration Applies To.

2. At the top of the page, select the Default option.
3. Click Save and Close.
4. Clear your browser cache and navigate to any of the sales pages to test your configuration.

55



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 5
Search

56



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 6
Saved Searches

6  Saved Searches

Saved Searches in Sales for Redwood and Classic Sales  
This chapter outlines how you create saved searches for different roles in the sales organization. You can create, share,
and manage the saved searches in two separate UIs: one in Sales for Redwood and the other in Classic Sales. Which UI
you use doesn't matter. The result is the same.

Salespeople can use the saved searches in any of the UIs that use Adaptive Search. In Sales for Redwood, this includes
all list pages and some lists of values (smart pickers). In Classic Sales, this includes Workspace and the work areas
powered by Adaptive Search. The saved searches you create are also available in CX Sales Mobile.

Note:  This guide explains how to create saved searches for UIs that use Adaptive Search. For an explanation of how
to create saved searches for the legacy work areas that still use CRM Search, see the topic Overview of Work Area
Search Setup in the Implementation Reference guide.

Overview of Saved Search Setup  
Here's an overview of how you can create saved searches for different roles in your organization.

Step Description Navigation Where to Get More Details

1 If you haven't already, review the
list of fields available in Adaptive
Search and make changes before
you create saved searches.

N/A Adaptive Search Configuration
Provided by Oracle

2
 

Create saved searches for different
job roles in the sales organization.
 

On any list page Create Saved Searches for the Sales
Organization
 

Saved Searches in Sales for Redwood  

Saved Searches Targeted at Different Users  
As a sales administrator, you can configure saved searches targeted to different job roles in the sales organization.

Note:  The saved searches you create in Sales for Redwood are identical to those you create in other work areas
powered by Adaptive Search. You can create, delete, and otherwise manage searches in either application, and the
saved searches are available to users of both applications.
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Configuring the saved searches for each work area involves two steps:

1. Create the saved searches in the landing page for each sales object. When you name your searches, keep in
mind that users see them listed in alphabetic order.

2. Use the Manage Saved Searches page to share your saved searches with everyone or with the appropriate job
roles. You can configure different lists of saved searches for different job roles, specify the search that runs by
default when users open the work area, and you can hide the saved searches provided by Oracle.

While you can configure saved searches for the sales organization, every user can personalize the list of saved searches
in each work area for their own use. They can save their current search criteria and their preferred way of displaying
search results as a new saved search. Every user can specify which saved search runs by default whenever they open
that particular work area. Users can also hide any saved searches they don’t want to see.

Review What Searches Are Available for a Sales Object  
Here's how to review saved searches available for a particular sales object.

1. Navigate to the appropriate work area landing page. Each business object has its own list of saved searches.
2. Click in the search field and select Manage Saved Searches .
3. From the Manage Saved Searches page, Visible To list, select Me. The Me list includes saved searches you created

and haven’t shared, the saved searches visible to everyone, and all of the saved searches visible to the job roles
assigned to you. Saved searches provided by Oracle are shared with everyone and list Oracle as the owner.

4. Different job roles may have saved searches available to them that won’t appear on your Me list. To ensure you see
all of the saved searches, cycle through all the job roles in the Visible To list.

Create Saved Searches for the Sales Organization  
Creating a saved search that you can share with the sales organization is as simple as clicking the save button on the
landing page.

The new saved search includes not only your current search criteria and keywords, but also your preferred way of
displaying and sorting the results. Here are the details:

1. Click Actions > Save on the list page.
2. In the dialog box, enter the name for your saved search.
3. Click Save.

Your new saved search is now listed in the Manage Saved Searches page. You’re now ready to share the saved
search with the sales organization. For details, see the topic How do I share a saved search with everyone or
with specific job roles?.

Manage Saved Searches Page  
As a sales administrator, you can use the Manage Saved Searches page to specify saved searches for others in the sales
organization. You can also use the page to maintain your own list as does any other user, as described in the Using Sales
for Redwood guide.
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Here's what you can do on the Manage Saved Searches page:

• Share saved searches you created.

• Remove from use any saved searches provided by Oracle that you don't need. You can’t delete the saved
searches Oracle provides, but you can unshare them.

• Specify which saved search appears by default when users navigate to the work area.

• Delete any saved searches you created.

• Create different lists of saved searches for different job roles.

• For contacts and leads, you can choose to display the first record in the list rather than the list itself.

Here's an annotated screenshot to give you an overview:

Callout Number Column Explanation

1
 

Visible To
 

Access the different lists of saved searches for
different job roles. Each role can have its own
configuration.
 

2
 

Name
 

Clicking on the name of the saved search
displays the search results.
 

3
 

Created By
 

You can only delete saved searches created
by your organization. You can’t delete saved
searches created by Oracle, but you can
unshare them so they're visible only to you.
 

4
 

Shared With
 

Saved searches you create are personal (Shared
With Only Me) unless you share them.
 

5
 

Open As
 

List: The saved search displays results as a
list. For lead and contact saved searches only,
 you can instead open the first record in the list
(Detail).
 

6
 

Actions
 

The Actions menu (three dots) displays the
available actions for each saved search.
 

7 Show in List Indicates if the saved search is visible or hidden
from you when you put your cursor in the
search field on the landing page.

8 Default For each list of saved searches, you can specify
a different saved search to run by default when
users open the landing page. Users can always
specify their own default.
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How do I share a saved search with everyone or with specific job
roles?  
You can configure the saved search setup to specify the saved search that appears by default whenever a user opens
the work area. You can also setup saved searches to share with everyone or to share with each specific job role.

After you create a saved search, it’s initially visible only to you. Here’s how to share it with the whole sales organization
or with individual job roles.

1. Navigate to the work area.
2. Click in the search field and select Manage Saved Searches.
3. From the Visible To list, select Me.
4. Click Actions (the three dots in the Actions column) for the saved search you want to share and select Edit.
5. Make a selection from the Shared With list:

◦ If you’re making the saved search available to the whole sales organization, select Everyone.

◦ If you’re making it available for specific roles, here’s how to add them:
i. Select Specific Roles.

ii. Click Add.
iii. Select the role.
iv. Click Save (the check mark icon).

6. Click Save.
If you shared the saved search with job roles that aren’t assigned to you, then the saved search is no longer visible on
your page. To see it, select one of the job roles assigned to it from the Visible To list.
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Remove a Saved Search from Use by Unsharing It  
As an administrator, you can remove saved searches from use entirely by unsharing them. Doing so removes them
from the lists of saved searches for all users except yourself. Use this method to remove from use any saved searches
provided by Oracle that you don't need.

1. Place your cursor in the search field on the landing page and select Manage Saved Searches.
2. On the Manage Saved Searches page, click Actions (the three dots) for the saved search you want to remove,

and select Edit.

3. On the edit page, click Shared With and select Not shared (callout 1 in the screenshot).

4. Click Save.
The saved search is now visible only to you. It's removed from use for the entire organization.
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Specify Which Saved Search Appears for Users by Default  
For each business object, you can specify the saved search that appears by default whenever a user opens the work
area. You can specify different defaults for each job role.

1. Navigate to the object's list page.
2. Click in the search field and select  Manage Save Searches.
3. From the Visible To list, select the job role where you want to define the default.
4. Click Actions (the three dots in the Actions column) for the saved search and select Set as Default.

Rename a Saved Search  
You can rename saved searches you created. Saved searches are listed in alphabetic order for users when they put their
cursor in the search field.

1. Navigate to the work area.
2. Click in the search field and select Manage Saved Searches.
3. From the Visible To list, select Me to see the lists that you shared with everyone and those you haven’t shared yet. If

you shared the list with a specific job role, and that job role isn’t assigned to you, then you must select that job role to
see the saved search that you want to rename.

4. Click Actions (the three dots in the Actions column) and select Edit.
5. Enter a new name.
6. Click Save.

Delete a Saved Search You Created  
You can delete saved searches you and other administrators created. Your action deletes the saved search for every role
where it is shared. You can't delete saved searches provided by Oracle, but you can hide them.

1. Navigate to the work area.
2. Click in the search field and select  Manage Saved Searches.
3. From the Visible To list, select Me to see the lists that you shared with everyone and those you haven’t shared yet. If

you shared the list with a specific job role, and that job role isn’t assigned to you, then you must select that job role
from the list to see the saved search you want to delete.

4. Click Actions (the three dots in the Actions column) and select Delete.
5. Click Save.
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Saved Searches in Classic Sales  

Create Saved Searches  
Here's how you can create saved searches in the Classic Sales UI either for yourself or for others in the organization. The
saved searches you create are the same ones you create in Sales for Redwood. You're just creating them in a different
UI.

1. In Workspace, select a saved search as your starting point. For example, the All Accounts saved search
provided by Oracle lets you create your saved search for all the accounts you can see.

2. Enter your search terms. You can enter search terms in the Search box, add filters, select filter values, or any
combination of these.

3. You can add or change the columns displayed in the search results by clicking Edit Columns (the pencil icon
highlighted by callout 2 in the following screenshot).
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4. Click Save As (highlighted by callout 1).

5. Enter the name for your saved search. Remember that the saved searches are listed in alphabetic order.
6. To make this saved search the default saved search for you personally, select the Set as my default saved

search option. The default saved search is what you see whenever you navigate to Workspace.
7. Specify how you want to share the saved search you're creating. There are three options:

◦ Only Me

◦ Everyone

◦ Specific Roles

8. If you selected Specific Roles, click Search (the people icon) and select the job roles.
9. Click Create.
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Overview of the Manage Saved Searches Page  
Use the Manage Saved Searches page to manage your own list of saved searches, manage the lists sales users see, and
to specify the default saved search different roles see when they open Workspace.

My List
On the My List tab, you can manage your own personal lists of saved searches (there's a separate list for each business
object).

• You can specify which saved search displays when you navigate to Workspace by making a selection from My
Default Saved Search (callout 1 in the screenshot).

• To view the saved searches for a specific business object, just make a selection from Manage List (Callout 2 in
the screenshot).

• You can hide individual saved searches by deselecting Show in List.

• You can delete only saved searches that you created.

While you can't delete saved searches provided by Oracle, you can hide them.

Workspace List
On the Workspace List tab, you can share saved searches with everyone, with specific user roles, or with no one.
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For each business object that you select from Manage List (callout 1 in the following screenshot), you can:

• Specify who can view each saved search by specifying a value in the Shared With column (callout 2 in the
screenshot).

◦ For saved searches provided by Oracle, you can either share the saved search with everyone or not share
it at all, effectively hiding it from use.

◦ For saved searches created by you or other administrators, you can select one of the following:

- Only Me

Makes the saved search a personal saved search that you can manage on the My List tab.
- Everyone

Makes the search available to all roles.
- Specific Roles

Makes it possible for you to specify one or more specific job roles that can see the saved search.
- Not Shared

Removes the search from use.

• You can delete only saved searches that you created (callout 3 in the screenshot).

While you can't delete saved searches provided by Oracle, you can remove it from use by selecting the Not
Shared value in the Shared With column.

Defaults by Role
Use the Defaults by Role tab to define the default saved search for each job role. This is the saved search that users
with the job role see when they open Workspace.
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Specify the List of Saved Searches for Different Job Roles  
Specify the lists of saved searches that are available for each business object in Workspace. You can create different lists
for different job roles. The saved searches appear in ascending alphabetic order in the list.

The same saved searches show up as filters in actionable infolets. For example, because All Accounts starts with the
letter A, users see All Accounts when they view the My Accounts actionable infolet, unless you create a different saved
search to appear on top. To display the most critical sales information for sales users by default, remove the All Account
saved search from the list by hiding it and replace it with a more appropriate saved search. If need be, you can recreate
saved searches and rename them to get the order you want.

Here's how to configure the list:

1. In Workspace, click the drop-down list you use to select the object and saved search.
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2. Select Manage Saved Searches (highlighted in the screenshot).

3. Click Workspace List.
4. Select the business object in Manage List (callout 1 in the following screenshot)
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5. Specify who sees which saved searches for each object. Here's how:

◦ For each saved search, specify who can see it by making a selection in the Shared With column (callout 2
in the screenshot).

- For saved searches provided by Oracle, you can either share the saved search with everyone or not
share it at all, effectively hiding it from use.

- For saved searches created by you or other administrators, you can select one of the following:

◦ Only Me

Makes the saved search a personal saved search that you can manage on the My List tab.

◦ Everyone

Makes the search available to all roles.

◦ Specific Roles

Makes it possible for you to specify one or more specific job roles that can see the saved
search.

◦ Not Shared

Removes the search from use.

◦ You can delete only saved searches that you created (callout 3 in the screenshot).

While you can't delete saved searches provided by Oracle, you can remove it from use by selecting the
Not Shared value in the Shared With column.

6. To specify the default saved search users see when they open Workspace, click Defaults by Role and select the
default saved search for each role.

7. Click Save and Close.
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Specify What Users See When They Open Workspace  
For each job role, you can specify which business object and saved search they see when they open Workspace or a
work area for an object.

1. In Workspace, click the drop-down list you use to select objects and saved searches.
2. Select Manage Saved Searches.
3. In the Manage Saved Searches page, click Defaults by Role.
4. Select the default saved search for each role
5. Click Save and Close.
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7  Accounts and Contacts

Account and Contact Basics  
Some basic terminology first. Your sales application is set up for business-to-business sales, so accounts are the
organizations you sell to. The account Type field indicates if an account is a prospect or a customer. You can create
contacts for a specific account or you can create standalone contacts.

Accounts in the Classic Sales UI
You can track lots of information for accounts in the various tabs, but most of the information comes from other
business objects. For account-specific information, you use the Overview and Profile tabs. Here's what you can tell
about the sample account in the screenshot just by looking at the Overview tab:

• You know that this account is an existing customer because the account Type field (callout 1) is set to Customer.

• The Industry field displays the primary industry for this customer (callout 2).

You can add multiple industries for each account, but, if you're assigning accounts by industry, then the
account gets assigned using the primary industry.

Tip:  If you're planning to assign accounts by industry, you may want to make entry in the Industry field
required when salespeople create accounts. While you can use Application Composer to make most fields
required, Industry isn't one of them. For Industry, you must use a combination of Page Composer and some
Groovy scripting. See these Oracle Support documents: 2261254.1 and 2193779.1.

• The tab displays the primary address (callout 3) and information about the primary contact (callout 4).

• The account owner (callout 5) is usually the person who created the account, but can be reassigned.

• If you're tracking account relationships, clicking the Ultimate Parent field (callout 6) gets you to the top of the
account hierarchy. You must expose this field during setup.

• The Parent Account (callout 7) just gets you to the immediate parent account.

• You can view and edit the whole account hierarchy by clicking Manage Account Hierarchy (callout 8).
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On the Edit Account, Profile tab, salespeople can add additional industry classifications for the account (callout 1 in the
following screenshot). Without further setup, sales territory assignment uses only the primary industry, indicated by the
check mark icon.

There are multiple ways that you can configure the Profile tab. For example, you can:

• Capture multiple emails, phones, and names and tack customer and contact preferences (callout 2).

• Capture multiple addresses. Only the primary address is used for opportunity assignment (callout 3)

• Display additional fields, including your own classifications that you can use for opportunity assignment (callout
4).
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Accounts in the Sales for Redwood UI
Accounts in the Sales for Redwood UI are very different. Gone are the tabs and much of the detail on the overview page.
Records are divided into three sections:

• Summary (callout 1 in the screenshot)

Lists the primary information about the account and contact.

• Ask Oracle bar (callout 2)

Instead of clicking on tabs as you do in Classic Sales, you enter commands to view and enter detailed
information about the account.

• Panels with key information (callout 3)

Key related information about the account is displayed in panels and linked pages. You access other
information using the Ask Oracle bar.
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For more information about the way Sales for Redwood has transformed the UI layout and functionality see the topic
Anatomy of a Record.

Industry Classification Category Types for Accounts
You can specify which industry classification category you want to use for your accounts. By default, the application
uses the CUSTOMER_CATEGORY classifications created by Oracle. The other classification available categories include:

• 1972 SIC

• 1977 SIC

• 1987 SIC

• CUSTOMER_CATEGORY

• NACE

• NAF

• NAICS_1997

• NAICS_2002

You can add other classification categories, such as NAICS 2012 and NAICS 2017, to this list as described in the topic:
Add to the List of Available Industry Classification Categories.

If you plan to enrich your account records with Dun & Bradstreet Corporation data available from Oracle Data as a
Service (DaaS), then you must either select the 1987 SIC category or add another supported category, such as NAICS
2017, to the list.
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Related Topics
• Add to the List of Available Industry Classification Categories

• Enable Address Usage Types for Accounts

• Enable Display of Multiple Addresses

How do I create an account - from scratch or from an
existing sales account, supplier, partner, or a financial
customer?  
If you are using Oracle Financials, you may already have financial customer (Buying Customer) records that were
created for Fusion Order Management (FOM) orders. In Oracle Sales, you can convert these financial customer
account records into sales accounts. These records become dual usage party records. For example, when an order is
placed directly from a company commerce website, Sold To party is created as a financial customer account (Buying
Customer). Later a sales representative decides to pursue this financial customer account and creates a sales account.
This also helps you to prevent creating duplicate sales accounts.

Similarly, you can copy supplier and partner records as accounts. This helps you to connect a Sales Account (customer)
to Partner and Supplier organizations to provide a consolidated 360 view for sellers.

Prerequisites
• We recommend that you run the Synchronize Financial Accounts and Contacts with CX Cloud scheduled

process before you create a sales account. For more information, see the Synchronize Financial Accounts and
Contacts with CX Cloud topic in the Understanding Scheduled Processes guide.

• Optionally, enable the Organization Links Enabled (ORA_HZ_OPT_IN_ORG_LINK) profile option:

a. Click Navigator > My Enterprise > Setup and Maintenance work area.
b. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
c. Search using the profile option code ORA_HZ_OPT_IN_ORG_LINK.
d. Change the profile value.

Here's how you create a sales account:

1. Go to Navigator > Redwood Sales > Accounts.
2. Click Create Account.
3. Specify a name and click Create. All existing sales accounts and financial customer accounts that match the

name are displayed.

◦ To use an existing sales account:
i. Click the account and click View Details.

ii. Click Details.
iii. Edit as required and click Save.

◦ To use an existing financial customer account:
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i. Click the financial customer account and click Convert to Account. This financial customer account
is now also a sales account.

ii. Click Details.
iii. Edit as required and click Save.

◦ To use an existing supplier or partner:
- If you have set the profile value of the profile option Organization Links Enabled

(ORA_HZ_OPT_IN_ORG_LINK) to Y, do this:
a. Click any partner or supplier and click Copy.
b. Click Save and Link.

This creates a sales account and links the supplier or partner with the new sales account.
- If you set the profile value of the profile option Organization Links Enabled

(ORA_HZ_OPT_IN_ORG_LINK) to N, do this:
a. Click any partner or supplier and click Convert to Account.
b. Click Details.
c. Edit as required and click Save.

◦ To create a new sales account:
i. Click Create without selecting any existing sales account or financial customer account and provide

the details of the account.
ii. Click Save.

The new account is displayed on the My Accounts page.

◦ To use any existing record of type Other:
i. Click the Other record and click Convert to Account.

ii. Click Details.
iii. Edit as required and click Save.

How do I create an account - from scratch or from
an existing account, partner, supplier, or a financial
customer while creating a new contact?  
If you are using Oracle Financials, you may already have financial customer (Buying Customer) records that were
created for Fusion Order Management (FOM) orders. In Oracle Sales, you can convert these financial customer
account records into sales accounts. These records become dual usage party records. For example, when an order is
placed directly from a company commerce website, Sold To party is created as a financial customer account (Buying
Customer). Later a sales representative decides to pursue this financial customer account and creates a sales account.
This also helps you to prevent creating duplicate sales accounts.

Similarly, you can copy supplier and partner records as accounts. This helps you to connect a Sales Account (customer)
to Partner and Supplier organizations to provide a consolidated 360 view for sellers.
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Prerequisites
• We recommend that you run the Synchronize Financial Accounts and Contacts with CX Cloud scheduled

process before you create a sales account. For more information, see the Synchronize Financial Accounts and
Contacts with CX Cloud topic in the Understanding Scheduled Processes guide.

• Verify that you have access to hubOrganizations.

• Optionally, enable the Organization Links Enabled (ORA_HZ_OPT_IN_ORG_LINK) profile option:
a. Click Navigator > My Enterprise > Setup and Maintenance work area.
b. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
c. Search using the profile option code ORA_HZ_OPT_IN_ORG_LINK.
d. Change the profile value.

Here's how you create a contact:

1. Go to Navigator > Redwood Sales > Contacts.
2. Click Create Contact.
3. (Optional) Associate the contact with an account:

◦ Select an existing account from the drop-down.

◦ Click ellipses (...) of the Account drop down. The Create Account popup is displayed.
i. Specify a name and click Create. All existing accounts and financial customers that match the

name are displayed.
◦ To use an existing sales account:

1. Click the account and click View Details.
2. Click Details.
3. Edit as required and click Save.

◦ To use an existing financial customer account:
1. Click the financial customer and click Convert to Account. This financial customer is

now also a sales account.
2. Click Details.
3. Edit as required and click Save.

◦ To create existing supplier or partner:
• If you have set the profile value of the profile option Organization Links Enabled

(ORA_HZ_OPT_IN_ORG_LINK) to Y, do this:
a. Click any partner or supplier and click Copy.
b. Click Save and Link.

This creates a sales account and links the supplier or partner with the new sales
account.

• If you set the profile value of the profile option Organization Links Enabled
(ORA_HZ_OPT_IN_ORG_LINK) to N, do this:

a. Click any partner or supplier and click Convert to Account.
b. Click Details.
c. Edit as required and click Save.

• To use any existing record of type Other:
a. Click the Other record and click Convert to Account.
b. Click Details.
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c. Edit as required and click Save.
• To create a new sales account:

a. Click Create without selecting any existing sales account or financial
customer account and provide the details of the account.

b. Click Save.
4. Provide the remaining details such as name, email, phone, and the customer's preference to be contacted for

each contact method.
5. Click Create.

The new Contact is displayed on the My Contacts page.

How do I get advice for my Oracle sales accounts?  
As a sales representative, account manager, or a strategic account planner, you can gain key insights, next steps and
answers to specific queries related to a sales account using the Account Advisor.

This AI agent provides the following information:

• Customer brief based on research conducted

• Key contacts relationship information

• Status of assets, subscriptions, orders, opportunities

• Next steps

• Key insights based on following:

◦ purchase trends

◦ involvement of contacts

◦ open opportunity

◦ lead statuses and so on

• Account health status

• Account potential and nurturing advise

Enable the Account Advisor Smart Action
1. Enter an active sandbox and navigate to Application Composer >  Smart Actions.
2. Search for Account Advisor.
3. Ensure that the Enabled checkbox for Account Advisor is selected.
4. Save your changes and publish the sandbox.

Use Account Advisor

1. Go to Redwood Sales >  Accounts and select the required account.
2. Search for Account Advisor.
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3. Select one of the available questions or type a question. For example, select "Give me a brief overview of this
account". You can then ask any followup or new questions.

Account Addresses  
As delivered, the Classic Sales accounts pages display a single primary address for each account. You can make it
possible for salespeople to view and enter additional addresses by configuring the Profile tab on the Edit Account page.
This setup isn't required for Sales for Redwood. Sales for Redwood accounts can store multiple addresses without any
setup.

When you expose multiple addresses, salespeople can indicate the address type and they can designate any one of the
addresses as the primary address. The application uses the primary address for assigning accounts, opportunities, and
leads by address. The primary address is also the address that gets displayed automatically wherever addresses are
listed.

Single Address
By default, the Profile tab of the Edit Account page displays the Address section with the primary address for the
account. Here's a screenshot.

The single address UI doesn't display the address type, which is set as "Sell to" under the covers. You can set a different
default type using the system profile option Default Address Type for Account.

Multiple Addresses
When you configure the Profile tab to display multiple addresses, salespeople see the Addresses section listing the
multiple addresses. On the tab, you can select any address as primary or delete it. You drill down on an address to edit it
or change its type. Here's a screenshot of the tab.
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You add addresses by clicking Add. Here's a screenshot of the Add Address window.

You select one of the available address types from the Type list. An account can have multiple addresses of the same
type. You must display the Type field in the window as part of your setup.

Overview of Account and Contact Setup  
Here's an overview of the setups covered in this chapter:

Step Applies To Description Navigation Where to Get More Details

1
 

Both Sales for Redwood
and Classic

Select the industry
classification category
you want to use to classify
your accounts in the
system profile option
MOT_INDUSTRY_CLASS_
CATEGORY.
 

• In Setup and
Maintenance, go to
the following:

◦ Offering: Sales

◦ Functional Area:
Territories

See the topics:
 

• Specify the Industry
Classification
Category for Accounts

• Add to the List of
Available Industry
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Step Applies To Description Navigation Where to Get More Details

If the classification category
you want to use isn't
available in the system
profile, you may be able to
add it to the list of available
categories using the task
Manage Classification
Groups.
 
If you're planning to enrich
your data with the Oracle
Account and Contact
Enrichment by Dun &
Bradstreet (D&B) service,
 you must use the 1987 SIC
category unless you add
additional classification
categories supported by
the service, such as NAICS
2017.
 
Choose the classification
carefully, especially if you're
using the industry of an
account for assignment
and forecasting. Switching
industry categories after
you enable sales territories
and import account data is
complicated. You must load
and activate sales territory
dimensions again and
reimport your account data
with the new classification
codes.
 

◦ Show: All Tasks

◦ Manage Classification
Groups

• In Setup and
Maintenance, go to
the following:

◦ Offering: Sales

◦ Functional Area: Sales
Foundation

◦ Manage Administrator
Profile Values

Classification
Categories

2
 

Both Sales for Redwood
and Classic

Prevent salespeople from
entering duplicate contacts
and accounts in the UI
by enabling automatic
duplicate checking.
There are just two setups
required:
 

• Enable the duplicate
matching server.

• Activate the
duplicate matching
configuration
provided by Oracle.

• In Setup and
Maintenance, go to
the following:

◦ Offering: Sales

◦ Functional Area: Sales
Foundation

◦ Show: All Tasks

◦ Manage Server
Configurations

Manage Enterprise
Data Quality Matching
Configurations

See the topic: How do I
enable duplicate checking
in Sales?
 

3
 

Classic Sales As delivered, the accounts
UI displays and enables
the entry of one primary
address for each account.
If you need more than
one address, you can use
Application Composer to
enable multiple addresses
on the Edit Account page,

Navigator >
Configuration >
Sandboxes
 

See the topic: How can I
enable multiple addresses
for accounts?
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Step Applies To Description Navigation Where to Get More Details

 Profile tab. Salespeople can
view and enter additional
addresses on this tab. Other
accounts pages continue
to display the primary
address.
 
When they add or edit
addresses on the Profile
tab, salespeople select an
address type to indicate
how the address is
used. You must use the
Application Composer tool
to expose the Type field on
the Add Address window.
 

4
 

Classic Sales You can make it possible
for salespeople to go
directly to the top account
in the account hierarchy,
 by exposing the Ultimate
Parent field in the Edit
Account page Overview
tab. You can make this
Application Composer
UI change in the same
sandbox as the previous
step.
 

Navigator >
Configuration >
Sandboxes
 

See the topic: Display the
Account at the Top of the
Account Hierarchy in the
Account Overview Tab
 

5
 

Both Sales for Redwood
and Classic

By default, the Type field
lists three address types:
 

• Bill to

• Ship to

• Sell to

You can specify different
and additional address
types by editing the lookup
type Party Site Use Code
(PARTY_SITE_USE_CODE).
This lookup type is shared
with other Oracle Fusion
applications. Only values
tagged with SALES_CLOUD
are available for use in the
sales application.
 

In Setup and Maintenance,
 go to the following:
 

• Offering: Sales

• Functional Area: Sales
Foundation

• Show: All Tasks

• Manage Standard
Lookups

See the topic: Manage
Address Types
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Add to the List of Available Industry Classification
Categories  
Use these steps to add to the list of available industry classification categories. For example, if you want to use NAICS
2017 for your accounts, you can add it as described here.

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Accounts and Contacts

◦ Task: Manage Classification Groups

2. Click Search without entering any search criteria.
3. Highlight the row for Industrial Categories in the search results.
4. Click Edit (the pencil icon).
5. On the Edit Classification Category Group: Industrial Categories page, click Add Row (the plus sign icon).
6. From the Classification Category list, select the classification category you want to add, for example,

ORA_HZ_NAICS_2017.
7. Click Save and Close.
8. On the Manage Classification Category Groups page, click Done.

Specify the Industry Classification Category for Accounts
 
Specify the type of industry classifications you want to use for accounts.

1. Open the task Manage Administrator Profile Values from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Search: Profile Option region, Profile Option Code field, enter MOT_INDUSTRY_CLASS_CATEGORY.
3. Click Search.
4. If you don't see the classification category you need, try adding additional classification categories to this list as

described in the topic: Add to the List of Available Industry Classification Categories.
5. Select the classification category from the Profile Value list.
6. Click Save and Close.

Related Topics
• Add to the List of Available Industry Classification Categories
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How do I enable duplicate checking in Sales?  
You can have the application automatically check for possible duplicates whenever a salesperson creates an account or
a contact. If you're using Oracle Financials, the application checks for potential duplicates in financial accounts as well as
sales accounts. Salespeople see the possible duplicates in a separate window and get to decide if they want to continue
creating the new record or edit an existing one instead. If they select a financials record that doesn't yet exist in sales,
the basic in formation from that record becomes available in Sales as well. Setup is simple: just enable the duplicate
checking server, activate the built-in duplicate matching, set a couple of profile options, and you're ready to go.

Here's a screenshot of the window salespeople see when the try to create an account with possible duplicates.

In the background, the application uses sets of rules, called matching configurations, to identify potential account
and contact duplicates. If you license Oracle Customer Data Management, you can create matching configurations of
your own and you can also check for duplicates in your data in batches. Oracle Customer Data Management includes
industrial-strength data cleansing features, but the basic duplicate checking you're enabling here's available free of
additional charges.

If you're using Oracle Financials, the application checks for potential duplicates in financial accounts as well as sales
accounts.

Enable the Server Used for Duplicate Matching
1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Server Configurations
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2. Click the Enabled option for EDQ Realtime and Batch Basic Match Server.

3. Click Save and Close.

Activate the Existing Duplicate Matching Configurations

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Enterprise Data Quality Matching Configurations
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2. Activate each of the matching configurations provided by Oracle:

◦ Account Duplicate Identification

◦ Contact Duplicate Identification

◦ Address Duplicate Identification

Here's how:

a. Drill down into the configuration to edit it.
b. In the Edit Match Configuration page, click Rebuild Keys.

The application warns you that all existing keys will be purged.
c. Click Yes.

The application starts the key generation process, which takes a few minutes to complete. The page
doesn't automatically refresh the status, but you can monitor the progress of the process in the
Scheduled Processes work area (Navigator > Tools > Scheduled Processes)

Here's a partial screenshot of the Edit Match Configuration page highlighting the Rebuild Keys button
(callout 1), which is disabled after you start the process. When the process completes, the page displays
the Active option (callout 2).

d. Select the Active option.
e. Click Save and Close.
f. Reply Yes to the warning.

g. In the Incremental Key Generation window, click Submit.

When you're done, all three configurations should now have a check mark in the Active column on the Manage
Enterprise Data Quality Matching Configurations page.
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Set Profile Options for Account Matches
Set two profile options:

• Duplicate Account Notification (ZCM_ACC_DUP_NOTIFICATION)

This profile option enables the UI that shows notifications of potential duplicate accounts. Make sure that this
profile option is set to TRUE.

• Exact Account Name Match (ZCM_ACC_EXACT_NAME_MATCH)

If the data quality matching configuration fails to identify potential account duplicates, this profile option
enables checks for potential duplicate records using exact name matches. Setting this profile option to TRUE is
optional because the data quality checking configuration uses multiple attributes, including the name, D-U-N-S
number, tax ID, and address to identify potential duplicates. The exact name match is just an extra check.

1. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. From the search region of the Manage Administrator Profile Values page, Profile Option Code field, enter the
profile option code name for one of the profiles:

◦ ZCM_ACC_DUP_NOTIFICATION

◦ ZCM_ACC_EXACT_NAME_MATCH

3. Click Search.
4. Set the profile option value to the TRUE.
5. Click Save and Close.

How can I enable multiple addresses for accounts?  
Here's how to enable multiple addresses for accounts. You can use similar steps to enable multiple addresses for
contacts and for other sales objects that display addresses, such as households.

Create and Enter a Sandbox
Create and enter a sandbox with the Application Composer tool enabled.

1. In the Navigator, click Configuration > Sandboxes.
2. Click Create Sandbox.
3. Enter a sandbox name.
4. Select Active for Application Composer.
5. Click Create and Enter.
6. From the sandbox Tools menu, select Application Composer to enter the tool.
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Display Multiple Addresses on the Account Profile Tab
While in Application Composer, expose Multiple Addresses in a custom layout:

1. Open the Standard Objects node on the left panel.

Open the Account node.
2. Click Pages
3. On the Application Pages tab, scroll down to the Details Page Layouts section.
4. Select Standard Layout and click Duplicate.
5. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
6. Drill down into your layout.
7. Click the Profile tab in the Subtabs Region.
8. Scroll down until you see the Primary Address and Multiple Address selections.
9. Click the Show link for Multiple Address.

10. Click Hide for the Primary Address.

Multiple Address now displays Hide and Primary Address displays Show. Here's a screenshot:

Note:  You can't expose both regions at the same time.

11. Click Done to leave Application Composer.
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Expose the Type Field
Expose the address Type field in the Add Address window. As they add addresses, salespeople use the field to indicate if
an address is a sell-to address, a bill-to address, and so on. Exposing the field on the Add Address window automatically
adds it to the Edit Address window as well.

1. While in the sandbox and Application Composer, open the Standard Objects node on the left panel.

Open the Address node.
2. Click Pages
3. On the Application Pages tab, Creation Page Layouts section, select the Standard Layout and click Duplicate.
4. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
5. Drill down into your layout.
6. Click Edit (the pencil icon) for Create and Edit Address.
7. In the Configure Detail Form section, locate the Type field in Available Fields pane and move it to the Selected

Fields pane.
8. Click Save and Close.
9. Click Done to leave Application Composer.

Publish Your Sandbox

1. Click Navigator > Configuration > Sandboxes.
2. On the Sandboxes page, click the name of the sandbox.
3. Click Publish.
4. Click Continue to publish.
5. When the sandbox completes publishing, click Done.

Disable the Account Summary Banner  
A banner appears at the top of the sales Account UI page when viewing a sales account and provides a snapshot of the
account’s engagement and overall health.

The banner enables teams to view the status of a sales account without searching through data or reports. It highlights
the most relevant and recent interactions, upcoming milestones, or immediate risks.

The account summary is displayed by default. You may want to disable the summary for all accounts to save the space
on the UI page.

1. As a setup user, go to Enable Generative AI Features using Setup and Maintenance.
2. Clear the Show Account Summary Banner selection under Account.
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Manage Business Plans  

What are business plans or account plans in Oracle Sales?  
A Business Plan, also known as account plans, helps you with strategic planning, improving sales account engagement,
and drive revenue growth.

As a sales representative or a sales manager, you can use business planning to achieve the following goals:

• Capture your needs, goals, or objectives.

• Define measurable strategies to grow your sales account.

• Record strengths, weaknesses, opportunities, and threats (SWOT).

• Create activities or an action plan.

• Align internal teams for consistent customer engagement.

• Associate open opportunities to the strategies to track using the business plan.

Which privileges do I need to manage business plans or account
plans?  
You must have the ZCA_CREATE_SALES_BUS_PLN_PRIV privilege added to any of your roles to manage business plans
or account plans.

Create Business Plans or Account Plans  
Business plans or account plans provide a centralized view of goals, strategies, opportunities, and activities for key
accounts of sales teams.

1. Go to Redwood Sales > Accounts and select the required account.
2. Search for Create Business Plan.
3. Specify the required fields and select Create.

View a Business Plan or Account Plan  
Business plans are also known as account plans.

1. Go to Redwood Sales > Accounts and select the required account.
2. Search for Show Business Plans and view the business plan.
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Generate Goals and Strategies  
You can use AI to set business goals and set strategies to achieve those goals as part of your business plans or account
plans. This reduces time spent on manual planning and tracking by offering a structured and automated approach.

1. Go to Redwood Sales >  Accounts and select the required account.
2. Search for Show Business Plans and select the required business plan.
3. Search for Generate Goals and Strategies.
4. Drag and drop the required files in PDF format. For example, 10K, annual reports, meeting notes and so on.
5. Select Generate.

AI analyzes your files and suggests goals and strategies.
6. Review the suggestions, select the ones you require, and select Save.

Associate Opportunities to Strategies  
Strategies to improve your business must be part of your business plan, also known as account plans. You can make
improved forecasting by associating opportunities to strategies.

1. Go to Redwood Sales >  Accounts and select the required account.
2. Search for Show Business Plans and select the required business plan.
3. Expand a strategy that you want to associate with an opportunity, select the ellipses, and select View

Opportunities.
4. Go to the Unassociated tab, select Move to Plan for the required opportunity, and save your changes.

Associate Opportunities to a Business Plan or an Account Plan  
You may have opportunities that are associated to an account but not to a business plan or an account plan. Such
opportunities are named as unassociated opportunities.

1. Go to Redwood Sales >  Accounts and select the required account.
2. Search for Show Business Plans and select the required business plan.
3. Go to the Opportunities tab and select the Unassociated tab.
4. Select Move to Plan button on the Actions column of the required opportunity.
5. Specify the goals and strategy and select Add.

Add Teams to a Business Plan or an Account Plan  
You can add team members to business plans or account plans so that they can collaborate with their teams to discuss
prospective plans.

1. Go to Redwood Sales >  Accounts and select the required account.
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2. Search for Show Business Plans and select the required business plan.
3. Search for Add Team Member.
4. Select Add Member from Another Account.
5. Specify the required information and select Add.

Add Attachments to a Business Plan or an Account Plan  
You can attach relevant documents to your business plan or account plan as referential information.

1. Go to Redwood Sales >  Accounts and select the required account.
2. Search for Show Business Plans and click the required business plan.
3. Go to the Attachments tab.
4. You can specifiy the URL of your attachment or drag and drop files.

Generate a SWOT Analysis of a Business Plan or an Account Plan
Using AI  
You can analyze the strengths, weaknesses, opportunities, and threats of the business plan or account plan in the
context of your key sales accounts.

1. Go to Redwood Sales >  Accounts and select the required account.
2. Search for Show Business Plans and select the required business plan.
3. Search for Generate SWOT.
4. Drag and drop the required files in PDF format. For example, 10K, annual reports, meeting notes and so on.
5. Select Generate.
6. You can review the generated analysis, select all or parts of it, and select Save to add them to the business or

account plan.

Connect an Activity to a Business Plan or an Account Plan  
Yes. Create an activity like a task or an appointment. Create a business plan. An Activities tab shows up by default in the
Edit Business Plan page.

Display the Account at the Top of the Account Hierarchy
in the Account Overview Tab  
You can make it easy for salespeople to see the top of the account hierarchy by exposing the Ultimate Parent field on
the Edit Account Overview tab. If you don't expose this field, salespeople can still view the top account, but they must
traverse the account hierarchy itself.
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1. Create and enter a sandbox with Application Composer.
2. In the navigation tree, expand Standard Objects, and then expand Account
3. Click the Pages node.
4. Ensure that the Application Pages tab is selected.
5. In the Details Page Layouts region, open a custom layout or create a custom layout by duplicating the standard

layout.
6. In the custom layout, click Edit (the pencil icon highlighted in the screenshot) for the Account Overview Subtab.

7. In the Configure Detail Form, select Ultimate Parent from the list of Available Fields and move it to the list of
Selected Fields.

93



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 7
Accounts and Contacts

8. Move the field right above the Parent Account field.

9. Click Save and Close.
10. Click Done.
11. To test the changes, view the Account Overview page for an account.
12. Publish the sandbox.

Manage Address Types  
You can specify what address types are used in your sales application by editing the lookup type Party Site Use Code
(PARTY_SITE_USE_CODE).

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Manage Standard Lookups

2. On the Manage Standard Lookups page, search for the lookup type PARTY_SITE_USE_CODE or the meaning
Party Site Use Code.

3. Your sales application uses only those values that are enabled and include the tag SALES_CLOUD.
Here are the available values for sales:

Lookup Code Meaning

BILL_TO
 

Bill to
 

SELL_TO Sell to
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Lookup Code Meaning

  

SHIP_TO
 

Ship to
 

4. You can enable additional values for your sales application by entering SALES_CLOUD in the Tag field.
5. You can also create address types of your own using the New button.
6. Click Save and Close.

Related Topics
• Can I modify the phone types for accounts and contacts?

Show Account Invoices to the Sales Team  
Let your sales team see the outstanding and paid invoices of accounts they handle. Enable the Invoices panel on an
account foldout view so that invoices related to the account show up on the panel.

What You Need to Have Before Setting Up
• Sales and Oracle Financials integrated.

• The Sales accounts need to link to the financial billing accounts for the invoices to show up.

• Verify that you have the following privileges and add them privilege to the sales administrator, sales manager,
and sales representative roles:

◦ ORA_AR_ACCOUNTS_RECEIVABLE_MANAGER_JOB

◦ AR_ACCOUNTS_RECEIVABLE_MANAGER_ALL_BUSINESS_UNITS_DATA

◦ ORA_AR_ACCOUNTS_RECEIVABLE_SPECIALIST_JOB

◦ AR_VIEW_RECEIVABLES_INVOICE_PRIV

• Assign users who need to see the invoices

Setups Involved
• Add the AR_VIEW_RECEIVABLES_INVOICE_PRIV privilege to the sales administrator, sales manager, and sales

representative roles, and assign users who need to see the invoices.

• Enable the Show Invoices checkbox in Smart Actions in Application Composer.

• Enable the Invoices Panel on an object’s foldout view using the Visual Builder Studio.

Enable Show Invoices in Smart Actions  
1. Enter an active sandbox and navigate to Application Composer > Smart Actions.
2. Search for Show Invoices.
3. Ensure that the Enabled checkbox for Show Invoices is selected.
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4. Save your changes and publish the sandbox.

Enable the Invoices Panel on an Object’s Foldout View Using Visual
Builder Studio  

1. Create a workspace in Visual Builder Studio.
2. Sign in to the sales application and Visual Builder Studio simultaneously.
3. In Sales for Redwood, go to the foldout view of any account to add the Invoices panel.
4. On the Account foldout view, click your user name in the global header and select Edit Page in Visual Builder.
5. In the Visual Builder Studio, open the workspace you just created and click the Source icon on the navigation

pane.
6. From Source, navigate to extension 1 > sources > self > applications > digital-sales > flows >

mycustomers > pages > accounts-page.json.
7. In the JSON tab, add the Invoices panel to the displayProperties list.
8. Click the play icon to see the preview of the account foldout view with the Invoices panel.
9. Click Publish.

The Invoices panel appears on the account foldout view.
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8  Mass Update and Inline Editing

Mass Update  
With mass update, salespeople can update fields on multiple records at the same time with a few clicks. No need to
drill into and edit each record individually. In Sales for Redwood , this feature is available by default. In classic Sales, you
must complete the updates listed in this chapter.

In the Workspace classic Sales UI and in the new work areas that use Adaptive Search, updating ownership and status of
multiple leads is as simple as selecting the leads in the landing page list, right-clicking, and selecting the Update action.

Salespeople get a list of fields they can update such as the one shown in the screenshot.

Mass update is also available in the classic Sales UI legacy work areas that haven't been converted to Adaptive Search,
including Business Plans, Competitors, Service Requests, and Products. Because these work areas use the older CRM
Search technology, you must set these up separately. Inline editing is available only in these legacy work areas.

Note:  Mass update isn't available for dynamic choice list (DCL) fields with dynamic filters.

Setup Overview  
Here's how to enable mass update and inline editing in Classic Sales UIs.
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Step Applies To Description Navigation Where to Get More Details

1
 

Classic Sales Enable mass update of
records in Workspace and
the new single-object work
areas, including Accounts,
Contacts, Leads, and
Opportunities.
 

Setup and Maintenance >
Sales > Sales
Foundation > Configure
Adaptive Search >
Parameters
 

See the topic: Enable Mass
Update
 

2
 

Classic Sales Optionally, enable mass
update of records in the
work areas that haven't
yet been converted to
the new Adaptive Search
technology. You can do
this by adding the Update
action to a custom layout
of the landing page in
Application Composer.
You can also specify the
maximum number of
records users can update in
a profile option.
 

• Navigator >
Configuration >
Application
Composer

• Setup and
Maintenance >
Sales > Sales
Foundation >
Manage
Administrator Profile
Values

See the topics in the section
Inline Editing in Legacy
Work Areas:

• Enable the Mass
Update Action

• Enable Inline Editing
of Records Displayed
in Lists

 

3
 

Classic Sales Optionally, you enable the
inline editing in the legacy
work areas, by setting the
profile option Click-to-Edit
on Landing Page Enabled
to Yes.
 

Setup and Maintenance >
Sales > Sales
Foundation > Manage
Administrator Profile
Values
 

See the topic: Enable
Inline Editing of Records
Displayed in Lists
 

Enable Mass Update  
Here's how to make it possible for salespeople to update multiple records at the same time while using Workspace,
Accounts, Contacts, Leads, Opportunities, and the other work areas in Classic Sales that now use Adaptive Search.

1. Navigate to the Setup and Maintenance work area, open the Configure Adaptive Search task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Show: All Tasks

◦ Task: Configure Adaptive Search

2. On the Configure Adaptive Search page, click Parameters (callout 1).
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3. Click Edit.

Here's a screenshot of the page after you click Edit.

4. In the Enable Mass Update row, Current Value column, enter Y (callout 2).
5. Click Save and Close.

Enable Mass Update and Inline Editing in Legacy Work
Areas  

Enable the Mass Update Action  
You enable mass update for the legacy work areas that still haven't been updated to behave like Workspace, by creating
a custom layout of the landing page in Application Composer. Within the layout, you specify which fields users can
update.

Create and Activate a Sandbox

1. Click Navigator  > Configuration  > Sandboxes.
2. On the Sandboxes page, click Create Sandbox.
3. Enter a name for your sandbox.
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4. In the All Tools section, select Application Composer as the tool you want to activate for this sandbox.
5. Click Create and Enter to create and enter the sandbox.

The application displays a bar at the top of the page with the sandbox name.

Enable the Update Action and Specify the Fields in a Custom Layout

1. Open Application Composer, Navigator > Configuration > Application Composer.
2. In the navigation tree, expand Standard Objects, and then expand the object you want to modify. For example,

expand the Opportunity object.
3. Within the object you're modifying, click the Pages node.
4. Ensure that the Simplified Pages tab is selected.
5. In the Landing Page Layouts region, select the Standard Layout and click Duplicate Landing Page Layout (the

document icon).
6. In the Duplicate Layout window, enter a name for your layout. The Standard Layout is the source.
7. Click Save and Edit.

Notice that your new layout is now active. The Standard Layout you copied is inactive.
Here's a screenshot of Application Composer showing the Opportunity: Pages region. Callouts highlight some
of the features.

Callout Number Description

1
 

Pages node
 

2
 

Duplicate Landing Page Layout button
 

3
 

Role Name (down arrow icon) that you use to specify job roles that see the layout.
 

8. Edit the new layout to add the Update action and select the fields that users can update. Here are the steps for
the Opportunities landing page:

a. Click Edit (the pencil icon) on the Fuse Opportunity Overview Table.
b. Navigate to the Configure Detail Form: Buttons and Actions region.
c. In the Available Actions window, move the Update action to the Selected Actions pane. You can either

double-click or use the arrow buttons.
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d. Scroll down to the Configure Mass Update Fields region.
e. Move the fields you want users to update to the Selected Fields column.

Tip:  If entry in a field depends on the value of another field, you must expose both fields. For example,
users can't enter a sales stage unless they select the sales method first.

f. Click Save and Close, then Done.
9. By default, your custom layout is available to everyone. Here's how to restrict use of layout to specific job roles:

a. Select the layout and click Role Name (the down arrow icon).
b. In the Select: Roles window, click Show available predefined roles and Specific Roles.
c. Move the job roles to the Selected Roles column and click OK.

Test and Publish the Sandbox
Test your new layout in the work area where you enabled it and publish the sandbox.

1. Click on the sandbox name in the sandbox toolbar and select Publish.
2. Click OK in the dialog box to navigate to the Sandbox Detail page.
3. In the Sandbox Detail page, click Publish again.
4. Click Continue to Publish in the warning message to confirm that you want to publish.

Specify the Maximum Number or Records Users Can Update at
the Same Time  
You can specify the maximum records users can update at the same time in the legacy work areas by setting two profile
options.

Note the following:

• By default, users can update a maximum of 25 records at the same time.

• The maximum number of records you can update is 500.

• For custom objects, the maximum number is set to 25 records. You cannot change this number.

Application Object Profile Option

Activities
 

Activity Mass Update Threshold Value (ZMM_MASS_UPDATE_THRESHOLD)
 

• Accounts

• Assets

• Contacts

• Leads

• Opportunities

Mass Update Threshold Value (ZBS_MASS_UPDATE_THRESHOLD)
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Set the Profile Options
Here's how to set the profile options:

1. In Setup and Maintenance, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the Manage Administrator Profile Values page, search by the profile option name or code.
3. Click the profile option name link.
4. Set the profile option value.
5. Save your changes.

Enable Inline Editing of Records Displayed in Lists  
Enabling inline editing of records in landing page lists saves the extra clicks it takes to drill down into individual records.
Inline editing is available in the legacy work areas.

You enable the feature by setting the system profile option Click-to-Edit on Landing Page Enabled.

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. In the search region of the Manage Administrator Profile Values page, enter the profile option code name
ZBS_ENABLE_CLICK_TO_EDIT in the Profile Option Code field.

3. Click Search.
4. Click on the profile option name in the search results.
5. Set the profile option value to Yes.
6. Click Save and Close.
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9  Leads

How to Handle Leads from External Sources  
The leads you get from the web, from trade shows, from marketing campaigns, or from lists you purchased aren't
always of the highest quality. You want to contact the potential customer and verify the information before creating new
account and contact records in your application. And you don't want to pass worthless leads to your highly paid and
busy field sales.

This chapter outlines how you can set up a process for creating, verifying, and qualifying these kinds of net new leads.
We are calling these leads "net new" leads because the account and contact information stays in the lead until the
lead is qualified and converted. Our use case follows the common practice of using inside sales to do the initial lead
qualification. But there's nothing stopping you from modifying the use case to suit your needs.

Use Case Overview
The fictitious company, Vision Corp., uses a team of inside sales representatives to verify the information in leads. All
qualified leads are automatically assigned to field sales representatives for further assessment and conversion into
opportunities. Here's an overview of the process:

1. Net new leads can get created in one of three ways:

◦ The leads are imported, perhaps by a sales administrator using the import macro you download from My
Oracle Support.

◦ The leads get created from an integration with a marketing application, such as Oracle Eloqua.

◦ A salesperson can also create net new leads manually in the UI.

2. Using an assignment rule you create, the application automatically assigns all inside sales representatives to
the sales team on each of the imported leads. Being on the sales team, makes it possible for the inside sales
representatives to view and update the leads, but it doesn't assign them ownership of the leads. Salespeople
become owners of a lead only when they accept a lead.

3. Individual inside sales representatives review the list of leads and accept the leads they want to work on.
Accepting a lead lists you as the lead's owner.

4. The inside sales representatives verify the information in each lead. They check for potential duplicates, contact
the customer, and answer a standard list of questions in a qualification template that you set up for them.

5. When leads meet the qualification criteria, the inside sales representatives set the leads to the qualified status.
6. If the leads don't meet the criteria, the inside sales representatives retire them instead.
7. The application automatically assigns the qualified lead to sales territories in the field sales organization.
8. Field sales representatives review the individual leads assigned to them, and convert the promising ones to

opportunities.

The representative doing the conversion becomes the owner of the new opportunity.
9. During the conversion process, the application creates new account and contact records of type prospect. The

lead is automatically set to a converted status and linked to the account and opportunity records.

Here's a diagram that illustrates the processes:
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How Inside Sales Works Sales Leads
Here's how salespeople work leads in the Classic Sales UI. Because of the changed UI, the process in the Sales for
Redwood UI is a bit different. For information about working with Leads in Sales for Redwood, see the Leads chapter in
the Using Sales for Redwood guide.

1. To find the imported leads to work on, the inside sales representatives select the Unaccepted Leads list (callout
1 in the screenshot).

You create the saved search for this list during setup.
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2. Representatives accept ownership of the leads that they want to work on, either by:

◦ Selecting the Accept from the Actions list (callout 2).

◦ Or by drilling down on the lead name (callout 3) and clicking the Accept button in the Edit Lead page.

By accepting the lead, a representative becomes the lead owner and can now see the lead listed in the My
Open Leads list.

3. Inside sales representatives check if the account and contact information in the lead duplicates information
already in the sales application. In our use case, the representatives check for duplicates manually in the leads
UI by selecting the Check for Duplicates action.

4. The representatives contact the customer and qualify the leads, guided by the questions you set up as part of a
qualification template. Using the qualification template, while not mandatory, ensures that everyone follows the
same procedure for qualifying leads.

Note:  Qualification templates are replaced by Orchestration processes in Sales for Redwood.

Here's a screenshot of a sample qualification template in the Classic Sales UI. Salespeople access the template
on the Qualification tab (callout 1) of the Edit Lead page. They answer the questions that you provide (callout
2). These questions are organized in question groups, which serve as headings on the page. As they answer the
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questions, salespeople get visual feedback on the quality of the lead (callout 3). You select the ratings and color
schemes during qualification template setup.

5. When inside sales representatives set the lead status to Qualified, an assignment process assigns the lead to
the appropriate sales territory. The process also adds the appropriate field sales representatives to the sales
team.

6. The field sales representatives convert the lead to an opportunity by selecting the Convert from the Actions
menu after viewing the lead.

7. You can rename the opportunity and change ownership in the Convert Lead window (shown in the screenshot).
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How You Import Leads Depends on the Lead Type
How you import leads depends on whether you're importing the net new leads described in this chapter or leads linked
to existing accounts and contacts. Here are the main differences:

• Net new leads
You import the account and contact as part of the lead business object. Account and contact records are
created only when the sales representatives convert the leads to opportunities. You can use the Excel macro
provided by Oracle to import these types of leads.

• Leads linked to existing accounts and contacts
You must use IDs to reference the existing accounts and contact record in your import file. You can use the IDs
you generated in your account and contact import files or you can export IDs from your application. You cannot
use the leads import Excel macro for this type of import.

This chapter discusses only the import of net new leads using the import macro. See the Understanding Import and
Export Management for Classic Sales and Fusion Service guide to understand how to import the other types of leads.

Overview of Leads Setup  
Here are the setup steps required to set up the sample leads use case covered in this chapter.

Step Applies To Where to Find More Information

Step 1
To let salespeople enter account and contact
information as text in net new leads in classic
Sales, you must expose two fields, New Account
and New Contact, on the appropriate lead
pages.
 
In Sales in the Redwood UX, salespeople can
enter information as text or select existing
accounts and contacts in the same field. No UI
change is required.
 

Classic Sales Make Changes to the Lead Pages Add the New
Account and New Contact Fields to the UI

Step 2
Create the assignment rule to assign the leads
to the inside salespeople who will qualify them.
 

Both classic Sales and Sales in the Redwood UX Set Up the Assignment Rule for Assigning Leads

Step 3
Set two profile options to enable lead
assignment. Setting Lead Assignment Mode
to Both enables both rule-based and territory-
based assignment. Setting the Assignment Rule
for Rule Based Lead Assignment profile option
tells the application which rule category to use.
 

Both classic Sales and Sales in the Redwood UX Enable Lead Assignment

Step 4 Both classic Sales and Sales in the Redwood UX Change the Values for Lead Rank and Lead
Channel
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Step Applies To Where to Find More Information

Before importing your leads, you can optionally
change the values provided by Oracle for lead
rank and the lead source channel. Salespeople
can use lead rank, for example, hot or cold, to
prioritize leads to work on next. The lead source
channel indicates if the lead came from the
web, an email, and so on.
 

Step 5
Import leads using the lead import macro. You
can import up to 5,000 leads at a time.
 

Both classic Sales and Sales in the Redwood UX Import Leads Using the Import Macro

Step 6
Run the lead assignment process twice: the
first time to assign the imported leads to inside
sales and the second time to assign qualified
leads to field sales. You can also schedule
assignment process to run at regular intervals.
 

Both classic Sales and Sales in the Redwood UX Run the Lead Assignment Process

Step 7
Create a list that inside salespeople use to view
the imported leads that are available for them
to work on.
 

Sales in the Redwood UX only Display List of Unaccepted Leads

Step 8
Sign in as one of the inside salespeople and one
of the field salespeople to test your setup.
 

Both classic Sales and Sales in the Redwood UX Verify Your Leads Setup

Step 9
Schedule the process Update Leads with Most
Recent Contact and Account Information to
run periodically in order to make sure any
changes to account and contact information are
reflected in leads.
 

Both classic Sales and Sales in the Redwood UX Update Leads with Most Recent Contact and
Account Information

Step 10
Create a list that inside salespeople use to view
the imported leads that are available for them
to work on.
 

Classic Sales only Display List of Unaccepted Leads

Step 11
Specify which qualification template you want
to appear in a lead by default by setting the
profile option Advanced Lead Qualification
Enabled. You can specify one template as the
default for all leads, or have different defaults
for different users and products.
 

Classic Sales only Select Default Lead Qualification Templates
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Set Up the Assignment Rule for Assigning Leads  
You can use assignment rules to automatically assign your leads to sales resources or to sales territories. In this
example, you set up a rule that assigns imported leads to sales resources, the inside sales representatives.

Creating an assignment rule involves the following three major steps:

1. Create a rule set.
2. Create the rule.
3. Publish the rule set.

Create the Rule Set
You must create a rule set before you create your rule. The rule set makes it possible for you to have more than one rule
for your lead assignment.

1. Open the Manage Sales Lead Assignment Rules task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Show: All Tasks

◦ Task: Manage Sales Lead Assignment Rules

2. Select the Sales Lead Resource Rule Category from the Category list. You're assigning resources to the leads.
3. Create a rule set:

a. Click Add Row (plus sign icon) in the Rule Sets region toolbar.
b. Enter a rule set name in the Name field and an optional description.
c. Make sure that All is selected as the Filter.

The All setting ensures that all the inside sales representatives are assigned to all of the lead sales teams
so each sales representative can work any of the leads you import.

If you selected Random as your filter value, then the inside sales representatives are assigned to the lead
teams at random. Each representative would be assigned approximately to the same number of leads,
but the representatives could not view and work on the leads assigned to the others.

d. Save.

Create the Rule
Now create the rule to assign the inside sales representatives to all imported leads that are unqualified.

1. With the rule set you just created selected, click Create (the plus sign icon) in the Rules region.

The Create Rule page appears.
2. Enter a rule name and an optional description.
3. In the Conditions region, make sure the All conditions met operator is selected for the Rule Applies If field.
4. Click Add Row (the plus sign icon).
5. Now enter the first of the two conditions. This first condition ensures that the rule only assigns imported leads.
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Field Selection

Object
 

Sales Lead
 

Attribute
 

Import Activity Identifier
 

Operator
 

Is not blank
 

6. Click Add Row again and enter the second condition. This condition assures that the rule assigns only
unqualified leads.

Field Selection

Object
 

Sales Lead
 

Attribute
 

Status
 

Operator
 

Equals
 

Value
 

Unqualified
 

7. In the Action region, enter the names of the inside sales representatives who work the imported leads:

a. Click  Select and Add (plus sign icon).
b. Search by name in the Select and Add window.
c. Select the name.
d. Click OK.

Clicking Apply instead keeps the window open so you can add additional resources.
8. Click Save and Close.

You're returned to the Manage Sales Lead Assignment Rules page.

Publish the Rule Set
For the rule to become active, you must publish the rule set after each change by clicking Save and Publish on the
Manage Sales Lead Assignment Rules page. The application lists the day and time when the rule was last published.
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Enable Lead Assignment  
Enable lead assignment using both rules and sales territories by setting these two system profile options. Territory
assignment assigns sales territories to the lead, not individual resources. Resources are added to the lead only by
resource assignment rules.

System Profile Option Display Name Value to Enter Description

Lead Assignment Mode
 

Both
 

Specifies if you're using rules, sales territories,
or both for assigning leads. Vision Corp. is using
both.
 

Assignment Rule for Rule-Based Lead
Assignment
 

Sales Lead Resource Rule Category
 

Specifies the rule category for the rule used for
lead assignment.
 

Here's how to set the profiles:

1. Open the task Manage Sales Lead Profile Options from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Profile Options

2. Enter the profile option name in the Profile Display Name field.
3. Click Search.

The application displays the profile option information.
4. For the Assignment Rule for Rule-Based Lead Assignment profile, click Add (the plus sign icon) in the Profile

Values region and select Site as the Profile Level. For the Lead Assignment Mode system profile option, Site is
already entered for you.

5. In the Profile Values region, select the value from the  Profile Value list.
6. Click Save or Save and Close.

Change the Values for Lead Rank and Lead Channel  
Optionally, you can change the values for lead rank and lead channel by editing their lookup types. Salespeople use lead
ranks to prioritize leads to work on. The lead channel records the source of the lead.

The lookup type Lead Rank (MKL_LEAD_RANK_SETID) includes these predefined values:

• Cold

• Hot

• Warm
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The lookup type Lead Channel (MKL_LEAD_CHANNEL_SETID) includes these predefined values:

• Direct Mail

• E-Mail

• Fax

• Model-based prediction

• Phone

• Rules-based prediction

• Sales visit

• Web

• Wireless Message

Here's how to change the existing values and to add new ones:

1. Open the task Manage Set Enabled Lookups from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Show: All Tasks

◦ Task: Manage Set Enabled Lookups

2. On the Manage Set Enabled Lookups page, search for either of the lookup type names by entering Lead Channel
or Lead Rank in the Meaning field.
The lookup type and the available values, called lookup codes, appear below.

3. Here's how to change a lookup codes:

◦ For the existing values, you can change the wording displayed to the user by modifying the meaning or
you can end date values you do not need.

◦ You can add new values, by clicking New (the plus sign icon).

4. Click Save and Close when you are done.
5. If you made changes, you must remember to enter the changes on the Lead Channel and Lead Rank 

worksheets in the lead import macro.

Run the Lead Assignment Process  
Here's how you assign leads using the rules you set up. For implementations similar to the Vision Corp. use case, you
may need to run the assignment process multiple times. Vision Corp. runs it the first time to assign the imported leads
to the inside sales representatives for lead qualification. The second time, the process assigns the qualified leads to field
sales for conversion to opportunities. Assignment is not automatic, so you must run the process at regular intervals,
perhaps once every hour.

1. Open the task Manage Lead Processing Activities from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Lead Processing Activities
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2. On the Lead Processing Activities page, click Create Lead Processing Activity.
3. To assign the leads you imported to inside sales for qualification, enter these parameters:

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
 

Lead Selection
 

Status
 

Unqualified
 

Lead Selection
 

Assignment Status
 

Unassigned
 

Schedule
 

Schedule Mode
 

Immediate
 

4. Click Submit.
5. Now create and submit a second activity to assign the leads to field sales after the leads are qualified. Enter

these parameters:

UI Region Field Entry

Activity Details
 

Process Type
 

Assignment
 

Lead Selection
 

Status
 

Qualified
 

Schedule
 

Schedule Mode
 

Assignment is not automatic. You must
run this activity on a repeating schedule to
make sure that the leads are transferred to
field sales as soon as they are qualified by
inside sales.
 
To run the activity regularly, select Repeats,
 enter a frequency (1 hour, for example),
 a start date, and an end date far into the
future. You must enter both a start date and
an end date for the process to run.
 

6. You can monitor the processes on the Manage Lead Processing Activities page. This page lists all of your
processing activities.
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Display List of Unaccepted Leads  
Use these steps to create a saved search list of the leads you imported in the Leads work area. Inside sales
representatives use the list to review incoming leads and accept the leads they want to work on. After sales
representatives accept a lead, the lead displays among the leads they own and no longer appears on the list.

Saved searches store all of your search criteria, filters, and formatting of results for reuse. Use saved searches to create
lists of information useful to you in each work area. For example, you can create a saved search for the leads you
imported in the Leads work area. Inside sales representatives use the list to review incoming leads and accept the leads
they want to work on. After sales representatives accept a lead, the lead displays among the leads they own and no
longer appears on the list.

Your saved search saves whatever you added to your search, including keywords, filters, columns, and sort order of the
results. You can create lists for the whole organization or lists targeted to specific job roles. Here's an overview of the
steps:

1. Navigate to the Leads work area.
2. Click in the Ask Oracle bar and select Manage Saved Searches.
3. Click Actions (the three dots in the Actions column) and select Edit.
4. Modify the list to create a saved search for the leads you imported.
5. Click Save.

Verify Your Leads Setup  
Test your leads setup. Sign in first as an inside sales representative to accept and qualify the lead. Then sign in as a field
sales representative to convert the lead to an opportunity.

Sign In as an Inside Sales Representative

1. Sign in as one of the inside sales representatives and navigate to the Leads work area.
2. Select the list of unaccepted leads you created.

The list should contain all your imported leads.
3. Open one of the leads and click Accept.

You should now be listed as the lead owner.
4. Click the Sales Team tab to make sure all the appropriate sales representatives are listed.
5. Make sure that the information in the lead you're qualifying is sufficient to assign the lead to the field service

representative you're using for testing.

In our use case, qualified leads are assigned to sales territories by state. Make sure that the contact address in
the lead includes one of the states in the US that belong to the territory of the field sales representative you're
using for testing.

6. Click Qualify to indicate the lead is qualified.
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Sign In as a Field Sales Representative

1. Ensure that the assignment process you scheduled previously has successfully completed. If you have not run
the assignment process, then you must run the process again, this time, immediately.

2. Sign in as the field sales representative who owns the territory the qualified lead is assigned to.
3. Navigate to the Leads work area.
4. Select the Open leads where I am on the team list.
5. Edit the lead.
6. From the Actions menu, select Convert.

The Convert window appears.
7. Optionally, change the opportunity name to something more meaningful.
8. Click Submit.
9. The opportunity work area view automatically opens in the current tab replacing the leads work area.

10. You can open the opportunity and view the created account and contact from there.

Update Leads with Most Recent Contact and Account
Information  
Schedule the process Update Leads with Most Recent Contact and Account Information to run periodically in order to
make sure any changes to account and contact information are reflected in leads.

1. Open Navigator > Tools > Scheduled Processes .
2. On the Overview page, click Schedule New Process and click the Search Name button (down arrow) on the

right side of the Name field.
3. Click the Search link at the bottom of the list.
4. In the dialog box, search for Update Leads with Most Recent Contact and Account Information.
5. Select the process and click OK
6. In the Process Details window, click Advanced.
7. Under Advanced Options, select Schedule.
8. Select Using a schedule and enter information about how often you want to update the lead information.

Related Topics
• What are scheduled processes?

Classic Sales Only  

Create a Lead Qualification Template  
You can use a lead qualification template to set up questionnaires that guide salespeople through the lead qualification
process. You can set up multiple qualification templates, each for a different product.

115

https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20030383


Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 9
Leads

1. Open the task Manage Sales Lead Qualification Template from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Qualification Template

2. Click Create (the plus sign icon) to create a new template, or you can copy and modify the template provided by
Oracle.

Enter Basic Template Details
Make these entries in the Enter Details page:

1. Enter a template name. For example: Imported Web Leads.
2. Select Lead as the Template Type.
3. For the Template Set, select Common Set.

Sets make it possible for you to target different qualification templates for different business units, but the
application covered in this guide uses only one business unit. For an explanation of how you can tailor your
sales application for multiple business units, see the Implementation Reference guide.

4. Click Next.

Configure Ratings
Ratings group question responses in a template into different categories. There are three predefined ratings: Poor,
Average, and Good. You can add your own ratings or modify the predefined ratings. When you're done, click Next.

Create Question Groups, Questions, and Responses
Create the question groups, which serve as headings in the template, and the questions within each group.

1. Click Create (the plus icon) and select Create Question Group.
2. Enter a name, which appears as the heading for this group of questions, and click Save and Close.
3. Now create your questions for this group. For each question:

a. Click Create (the plus icon) and select Create Question.
b. In the Create Question window, enter the question text.
c. Enter a weight indicating how important this question is in the qualification process. You have a chance

to revisit and adjust the weights to all the questions at a later stage.
d. Click Save and Close.

4. Enter the possible responses for each question:
a. Enter the response, score and rating.

Here are the response entries for a yes or no question, for example: Did you reach the contact by phone?

Response Score Rating

Yes
 

100
 

Excellent
 

No
 

0
 

Poor
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b. When you complete entering your questions, you can reorder the questions by clicking Move (the double
right arrow).

5. Click Next.

Edit Question Weights, Configure Score Ranges, and Associate Task Templates
Use these steps to edit the question weights, configure score ranges, and associate task templates:

1. On the Edit Question Weights page, the weights in the Weights column for each question until the total equals
100.

2. Click Save and then Next.
3. The application derives the score range for ratings using the scoring to response mapping in the questions and

responses that you entered earlier. On the Configure Score Range Attributes page, you can select the Override
Score Ranges option to edit the automatically derived score ranges. You can also set different start and end
scores for the ratings. You can use the Graph Color list to change the colors shown in the various score ranges.

Deploy the Qualification Template
When you're ready to deploy the qualification template, do the following:

1. Click Save.
2. Click Deploy.
3. Click OK to close the confirmation window.

The application displays any errors in setup. For example, if you did not enter question weights which total 100.

Note:  After you deploy a template, you can't change its name or edit many other aspects. If you need to
make changes, make changes in a copy, and then deploy the copy.

Select Default Lead Qualification Templates  
To turn on lead qualification, you set the profile option Advanced Lead Qualification Enabled to the lead templates you
want to use by default. You can specify one template for use for the whole sales organization, you can specify different
templates for different products, and you can assign specific templates to different users. The settings aren't mutually
exclusive. You can provide a default template for the whole organization, but target different template to individual users
or product groups, for example.

1. Open the task Manage Sales Lead Profile Options from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Leads

◦ Task: Manage Sales Lead Profile Options

2. Enter Advanced Lead Qualification Enabled in the Profile Display Name field.
3. Click Search.
4. Select the profile option.
5. In the Profile Values section, click New (the plus sign).
6. If you're using only one template, then select Site from the Profile Level list. The options are:

◦ Site
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The same template is used for the entire organization unless you specify additional templates for product
and user.

◦ Product

The template is used for a product group. All other product groups are assigned the template you specify
at the site level.

◦ User

The template is used for the user you enter. All other users are assigned templates for the product or the
site.

Select the name of the template from the Profile Value list.
7. Repeat the previous steps for additional products and users.
8. Click Save and Close.

Configure the Classic Sales Leads UI  

Make Changes to the Lead Pages  
If your sales organization handles large volumes of unqualified leads using the Classic Sales UI and you want to prevent
your sales data from getting cluttered with unverified account and contact information, read on.

With a bit of setup, you can store account and contact names in the lead as text and create the account and contact
records only after salespeople verify that the information is legitimate and accurate. If a lead doesn't pan out, the
information just stays in the lead.

Lead Pages Handle Only Leads for Existing Accounts
Here's how the application act by default:

• When creating a lead in the Classic Sales UI, salespeople can only enter accounts and contacts that already exist
in the application. If they want to create leads for completely new accounts and contacts, they must first create
the appropriate account and contact records.

• If you import completely new leads, as you do using the import macro, the leads get imported, but the new
accounts and new contacts names don't show up on the Edit page.

Here's what the default Create Lead page looks like from the Classic Sales UI. The screenshot highlights the Existing
Contact and Existing Account fields.
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Two Fields Enable Net New Leads in Classic Sales
You enable salespeople to view and enter the account and contact names as text in net new leads by exposing the New
Account and New Contact fields in the Classic Sales UI.

Here's a screenshot of the Create Lead page highlighting the fields in the Classic Sales UI.

119



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 9
Leads

You must expose these same two fields in the Edit Lead page and other pages required for your leads process. These
pages include the Leads landing page and the pages used to convert leads into opportunities.

Here's how salespeople see net new leads in the Edit Lead page from the Classic Sales UI.
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Leads for existing accounts, display the existing contacts and accounts as links:

No UI Changes Required in Sales for Redwood
In the Sales for Redwood UI, salespeople can enter accounts and contacts as text or select existing accounts and
contracts in the same field, so no UI changes are required. The screenshot highlights the Existing Account and
Existing Contact columns on the list page. Salespeople can enter an account or contact as text or select an existing
record in these fields.

You can also use the Account Name and Contact Name  fields for the same purpose. These fields are equivalent.
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Add the New Account and New Contact Fields to the UI  
You must add the New Account and New Contact fields to the leads pages that salespeople use to create and qualify net
new leads.

You may want to add the two fields to these pages. The table gives the Classic Sales page names and lists the equivalent
names in Application Composer.

UI Page Name Application Composer Page Name Comments

Leads
 

Landing Page
 

This is the landing page that opens when you
navigate to the work area. Salespeople should
see the New Account field displayed in the list
of leads.
 

Create Lead
 

Creation Page
 

Add the fields to the create page if you want
salespeople to create net new leads manually
in the UI. If a salesperson comes back with a
few business cards from a trade show, she may
want to create leads individually.
 

Edit Lead
 

Details Page
 

This is the page that inside sales agents will use
to verify the contact and account information,
 so you must expose both the fields. You must
expose the fields here to display any net new
leads you import using the lead import macro.
 

Convert Lead
 

Lead Convert Page
 

Converting a lead from a net new lead creates
a new account, a new contact, and a new
opportunity. Expose both fields so agents can
see what they are converting.
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UI Page Name Application Composer Page Name Comments

 

Convert Leads
 

Mass Lead Convert Page
 

Page you use to convert multiple leads at the
same time using the Qualify action from the list
page.
 

If you're adding the fields to the Sales for Redwood UIs, then you must use VB Studio instead of Application Composer.
For an example, see "Add a Custom Field to the Edit Contact Page" in the Oracle Fusion Cloud Sales Automation
Extending Sales for Redwood (Next Gen Sales) guide. To access this guide, contact your Oracle representative.

If you're adding the fields to Classic Sales UIs, follow these steps:

1. Create and activate a sandbox.
2. Create custom layouts for the appropriate pages and add the fields.
3. Review your work in the leads pages.
4. Publish the sandbox.

Create and Activate a Sandbox
To start customizing the Classic Sales UI, activate a sandbox.

1. Click Navigator  > Configuration  > Sandboxes.
2. On the Sandboxes page, click Create Sandbox.
3. Enter a name for your sandbox.
4. In the All Tools section, select Application Composer as the tool you want to activate for this sandbox.
5. Click Create and Enter to create and enter the sandbox.

The application displays a bar at the top of the page with the sandbox name.

Add the New Account and New Contact Fields to the Classic Sales Lead UIs

1. In the Navigator, click Application Composer located under the Configuration heading.
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2. In the left pane of the Application Composer page, search for the Sales Lead object (callout 1 in the screenshot).

3. Open the Sales Lead object (callout 2).
4. Click Pages (callout 3).
5. For each of the pages where you need to expose the fields, do the following:

a. Locate the page.
b. Click Duplicate (callout 4).
c. In the Duplicate Layout window, enter a new name for your layout or just click Save and Edit.
d. On the Layout page, click Edit (the pencil icon).
e. Scroll down in the Available Fields column to locate the New Account and New Contact fields and move

them to the Selected Fields column.
f. Use the arrow buttons to move the fields where you want them.

g. Click Save and Close.

You're returned to the Layout page, which reflects your changes.
h. Click Done.

You're returned to the Application Composer page.

Test Your Changes
Here's how to test changes you made in Classic Sales pages:

1. Click Home (the icon located at the top of the page).
2. Navigate to the Leads work area by clicking Sales > Leads.
3. Check to see if the New Account field displays as a column on the list page.
4. Click Create Lead.
5. Enter a lead name only.
6. Click Save and Continue.
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7. On the Edit Lead page, enter test data in the New Account  and New Contact  fields.
8. Click Save.
9. Click Actions > Convert.

10. On the Convert Lead page, click Submit.

After the lead processing completes, the Edit Lead page displays the converted lead. The contact displays as a
link in the Existing Contact field. And the account as a link in the Existing Account field.

11. You can drill down in the account and contact links to see that the account and contact records have been
created for you. From the Opportunity tab on the lead, you can also drill down into the opportunity created
from the lead.

12. If you need to make further changes, you can go back to Application Composer and edit the layouts again.

Publish Your Sandbox
After testing, publish your sandbox:

1. Click on the sandbox name in the sandbox toolbar and select Publish.
2. Click OK in the dialog box to navigate to the Sandbox Detail page.
3. In the Sandbox Detail page, click Publish again.
4. Click Continue to Publish in the warning message to confirm that you want to publish.

Add the Redirect to Opportunity After Conversion Checkbox  
Sales administrators can add the Redirect to Opportunity After Conversion check box to the Convert Lead page so that
users can choose whether to be redirected immediately to the opportunity page after the successful conversion.

This reduces the time spent going to the Opportunities subtab on the Lead and finding the right opportunity to open.

Note:  The redirect to opportunity feature is available for single lead conversions only. The check box is deselected by
default and isn't available from the Mass Convert Layout Pages for Leads.

Use these steps to add the Redirect to Opportunity After Conversion check box to the Convert Lead page.

1. Sign in as a sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Application Composer, in the Configuration category.
4. In the navigation tree, expand Standard Objects, expand Sales Lead, and click Pages.
5. Ensure that the Application Pages tab is selected.
6. On the Application Pages tab, under the Lead Convert Page Layouts section, duplicate the standard layout to

create a new layout to edit.
7. Type a new layout name and click Save and Edit.

The Lead Convert Page Layout page appears.
8. Click the Edit icon next to  Lead Convert Page Layout.
9. From the Configure Detail Form region, move the Redirect to Opportunity After Conversion field from the

Available Fields area to the Selected Fields area.
10. Click Save and Close.
11. On the Edit Layout page, click Done and ensure that the layout status for your Lead Convert Page Layout is set

to Active.
12. Verify that you can see the Redirect to Opportunity After Conversion  check box on the Convert Leads page

for a selected lead that you want to convert.
13. Publish your sandbox.
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FAQs for Sales Leads  

How can I provide Account team access to Leads?  
A user with the IT Security Manager job role can provide access to the leads associated with an account team by
creating a new data security policy for the Sales Lead database resource.

Using the security console, they can specify the access level such as view or update sales lead data, and then assign
what role, such as Sales Representative or Sales Manager, to apply to the security policy. Finally, they must specify a
condition for the new data security policy. For example,

Access the sales lead for table MKL_LM_LEADS where they are a member of the lead sales account team or in
 the management chain
 of a lead sales account team member.

For more information, see the Create a Data Security Policy for a Database Resource section in the topic Manage
Database Resources topic of the Oracle CX Securing CX Sales and Fusion Service guide on Oracle Help Center (https://
docs.oracle.com).

Related Topics
• Manage Database Resources

Can I update a lead number?  
No. A lead number can't be updated after the lead record is created. The only option is to delete the existing lead and
recreate it with the data you want.

How come I don't see products in leads or opportunities?  
You must enable and publish products and product groups in Adaptive Search before you see them in the leads and
opportunities UIs. You can do this either using Setup Assistant or using this procedure.

1. In Setup and Maintenance go to: Sales offering > Sales Foundation functional area > Configure Adaptive
Search task.

2. Click the Setup tab.
3. Select Product and Product Group and any other object you want to enable.
4. From the Actions menu, select Full Publish.
5. You can monitor the progress of the publish process on the Monitor tab.

Related Topics
• Sales Products High-Level Setup Steps

• Overview of the Setup Assistant
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How do I notify a lead owner by email when a lead is assigned to
them?  
You can create email notifications using the Routines feature. Routines is the fastest way of creating email notifications.
It doesn't require any Groovy scripting, and automatically appends a link to the lead in the email.

The following steps apply mainly to Redwood User Experience (UX) users. However, Simplified UI users can also use
these steps but note that some options on the Trigger page aren't available for Simplified UI users.

1. Open Application Composer outside a sandbox (Navigator > Configuration >  Application Composer).
2. Click Routines.
3. Click Create Routine.
4. Click Skip Templates.
5. Enter a name and description. For example: Email Notification for New Lead Owner. Notify owner that a lead

was assigned to them.
6. Select the object, in this case Sales Lead.
7. Click Next.
8. On the Trigger page:

◦ Redwood UX users have the following options:
- Hourly
- Daily
- Weekly
- Monthly
- Yearly
- Record created
- Record deleted
- Attribute changed

◦ Simplified UI users have the following options:
- Hourly
- Daily
- Weekly
- Monthly
- Yearly

Note:  For Simplified users, if the existing options don't suit your requirements, you can use Rules to specify
a trigger when the routine should run. For example, you can create and apply certain rule conditions to
Attribute Owner ID, or Last Update Date, or Status and so on to trigger and submit the routine.

9. For Redwood UX users, select Attribute changed and then select Owner ID from the list of attributes because
you're sending the email after the owner is updated in the record.

Note:  Redwood User Experience (UX) users will have access to more triggers to specify when the routine
runs. For example, in addition to the defined recurring schedules, they can choose to run the routine as soon
as an attribute is changed or when a record is created, updated, or deleted.

10. Click Next.
11. On the Actions page, select Send Email as the action type.
12. In the To field, select Owner ID.
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13. In the Subject and Body fields, you can enter both text and mail-merge attributes. For example, to include the
lead name, enter Name in the Attribute search box, press Return, and click Lead Name. Your action enters the
mail-merge field {{$Name}}.

Note:  The email sent to the new owner gets automatically appended with a link to open the lead.

14. Optionally, you can add another action. For example, in addition to sending the email you can create a task by
selecting Create Task from the Action Type list and entering the task attributes.

15. Click Next.
16. In the Rules, page you can create rules and groups of rules that select the leads the notification runs on. In this

example, we're notifying the owner when any lead is assigned to them, so you can skip this step.
17. Click Next.
18. On the Review page, review your entries and click Submit.

See Overview of Routines for more information about routines.
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10  Competitors

About Sales Competitors  
The sales organization can track and analyze the impact competitors are having on sales by recording the competitors
in each opportunity. By default, the sales application requires salespeople to enter the primary competitor whenever
they close an opportunity. Unless you changed that default, you must create the list of competitors to enable
opportunity closing.

To create the list of competitors, you're only required to enter competitor names. However, you can track more details
about each competitor in the Competitors work area. You can enter company details, including its line of business, and
status.

The Opportunities tab automatically displays all of the opportunities where that competitor has been selected as the
primary competitor. Access to the Competitors work area is restricted to users with the Sales Administrator job role.
However, sales managers and others in the sales organization can access preconfigured reports to view the effects of
the competitors entered in opportunities.

Setup Assistant and Competitors
You can create up to 15 competitors using Setup Assistant. For each competitor you can enter:

• Name and suffix

• Line of business

• Threat level

• Organization size

You must go to the Competitors work area in Sales to enter the other details.

Related Topics
• Overview of Sales Competitors

• Manage Sales Competitors

Review the List of Competitors and Create Additional
Ones  
Here's how to review the list of competitors you created using Setup Assistant, add more information, and create new
ones. The names of the competitors you create are available for selection in opportunities in both Classic Sales and
Sales for Redwood.
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Here's how to create a competitor in the Classic Sales UI. Salespeople enter the names of competitors when they close
opportunities in both Sales for Redwood and Classic Sales. However, detailed information about each competitor is
available only in the Competitors work area in the Classic Sales UI.

1. Click Navigator > Sales > Competitors.
2. To create a new competitor:

a. On the Review Competitors page, click Create.
b. In the Create Competitor page, enter the competitor name in the Organization Name field.
c. You can enter a suffix, such as Ltd. or Co., in the Name Suffix field.

The suffix is automatically appended to the name in the application.
d. Select a threat level. Salespeople can use the threat level to filter their competitor searches.
e. Optionally, enter additional information about the competitor.

Any additional information you enter is only visible in the Competitors work area. Only the competitor
name is visible while selecting competitors in opportunities.

f. Click Save and Edit.
g. The application checks to see if any other organizations are potential duplicates. If there are existing

companies with a similar name, you can choose to edit one of these instead.
h. You can enter additional competitor information on the Edit Competitor page.

3. To review or edit an existing competitor, click on the competitor name link.

Related Topics
• Manage Sales Competitors

• Enable Competitors in Opportunities

• View Competitor Information Outside Opportunities

• Associate Competitors with Opportunities

• Enable Competitors in Leads
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11  Opportunities

Overview of Guided Sales Processes  
You can guide salespeople through a structured sales process as they pursue an opportunity from the initial qualifying
stage to closing the deal. In Classic Sales, you build the guided sales process exclusively as a sales method. In Sales for
Redwood, sales methods provide the scaffolding for a much more full-featured process provided by orchestrations.
Using sales methods in Classic Sales, you can provide only a single set of linear recommendations. Orchestrations in
Sales for Redwood, by contrast, can have multiple branches to suggest different actions when a particular step in the
sales process does or doesn't succeed.

Each opportunity must be associated to a sales method that takes the salesperson through a series of sales stages. For
each sales stage, you can specify any of the following:

• Prepopulate the win probability for opportunities at that stage.

If you're including opportunities in forecasts using win probability, then prepopulating a default win probability
ensures that opportunities don't get left out by mistake.

• Specify which field entries are required

For example, you may require salespeople to enter the close date or budget for opportunities that are about to
close.

For Sales for Redwood, you suggest appropriate tasks, documents, and actions for each sales stage by creating
orchestrations. At each sales stage, you specify what information the salesperson needs to provide and what actions
they need to take to move the opportunity to the next sales stage. You can also provide automated steps that take
actions behind the scenes to follow up when things don't go as planned. For example, you can automatically send a
follow-up email if a customer doesn't respond when a salesperson contacts them. See the topic Guide Salespeople
Through Best Practices for more information.

Classic Sales doesn't include orchestrations, but, for each sales stage, you can specify any of the following:

• The tasks you want assigned

• Documents you want to provide as part of Sales Coach

See the topic Overview of Sales Methods, Sales Stages, and Sales Coach in the Implementation Reference guide.

• Assessments

See the topic Overview of Assessments in the Implementation Reference guide.

Oracle provides several predefined sales methods, which you can modify to your needs. These include:

• Accelerated Sales Process

A sales process for deals that involve a single decision maker and short time frame.

• Standard Sales Process

A sales process designed for longer sales cycles, where decisions are made by committee.

You can create multiple sales methods for different sales situations and products. By default, all opportunities use
the sales method you specified as the default in the Configure Opportunities quick setup page. In Sales for Redwood,
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salespeople get to choose one of the available sales methods when they create an opportunity. If you want to give
salespeople the same option of choosing a sales method in Classic Sales opportunity pages, then you must use
Application Composer to display the Sales Method field in the UI.

Setup Assistant and Opportunities  
You use Setup Assistant to configure basic opportunity behavior, but you must still supply the details of the sales
process you want the sales organization to follow.

What You Can Do in Setup Assistant
• Select the default sales method.

• Add, edit, or reorder sales stages.

• Specify if win or loss reasons are required when closing opportunities.

• Specify the default close date for opportunities.
If salespeople don't enter a close date in an opportunity, the close date is set to the creation date plus the
number you entered. The close date affects the way opportunities are forecast in the Classic Sales UI.

What You Must Complete Manually

• Create the content for the sales method that you selected.
For example, for each sales stage in Classic Sales, you can suggest action items, make some entries required,
and provide documents and assessments.

• Edit the list of opportunity statuses.

• Edit the list of win/loss reasons salespeople enter when closing opportunities.

• In Sales for Redwood, specify what information the salesperson needs to provide and what actions they need to
take to move the opportunity to the next sales stage and to complete the sale. See Guide Salespeople Through
Best Practices.

Summary of Opportunity Setup  
Configure opportunities to guide salespeople through a structured sales process that's appropriate to your business.

Here's a summary of the setup tasks covered in this chapter.

Step Applies To Description Navigation Where to Get More Details

1
 

Sales for Redwood and
Classic Sales

You can review and change
the default sales method
and change the opportunity
close behavior on the

Setup and Maintenance >
Sales > Opportunities >
Quick Setup (gears icon)
 

See the following topics in
this chapter:
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Step Applies To Description Navigation Where to Get More Details

opportunity Quick Setup
page.
 
However, you must use the
Manage Sales Methods
and Sales Stages task to
create new sales methods
or properly configure the
one you chose.
 

Setup and Maintenance >
Sales > Opportunities >
Manage Sales Methods
and Sales Stages
 

• What Opportunity
Behavior You Can
Configure and Where

• Configure Basic
Opportunity Behavior

• Create and Edit Sales
Methods and Stages

2
 

Sales for Redwood and
Classic Sales

Optionally, configure
opportunity statuses.
 

Setup and Maintenance >
Sales > Opportunities >
Manage Sales Methods
and Sales Stages
 

See the topic: Modify
Opportunity Statuses
 

3
 

Sales for Redwood and
Classic Sales

Optionally, configure the
list of win/loss reasons
salespeople enter when
they close opportunities.
 

Setup and Maintenance >
Sales > Opportunities >
Manage Set Enabled
Lookups
 

See the topic: Modify
the List of Reasons
Opportunities Are Won or
Lost
 

4
 

Sales for Redwood and
Classic Sales

You can enable further
aggregations on custom
opportunity fields and
define the aggregation
label. For example, for
Deal Size, you might want
to aggregate a custom
revenue field or aggregate
a different custom revenue
field for an Expected
Revenue aggregation.
 

Setup and Maintenance >
Sales > Configure
Adaptive Search  >
Configure UI  >  Enable for
Group By
 

See the topic:
 
Enable Group By and
Custom Aggregations for
Opportunities

5
 

Sales for Redwood only
 

Before salespeople can
create recurring revenue
schedules in Sales for
Redwood, you must first
enable the feature. You do
this in Oracle Visual Builder
Studio.
 
You must then enable the
Revenue Lines UI elements
for Sales for Redwood.
 

In Sales for Redwood,
 navigate to the page that
displays the area you want
to extend. For example,
 navigate to an opportunity
record and then click
View All Products on the
Products panel. Redwood
Sales > Opportunities >
View All Products
 
Under the Settings and
Actions menu, select Edit
Page in Visual Builder.
 
Configuration >
Structure > Revenue Lines
 

See the topic:
 

• Enable Revenue Lines
UI Element
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What Opportunity Behavior You Can Configure and
Where  
You can configure opportunities to support your specific sales process. For basic configuration, you can use either
Setup Assistant or the Configure Opportunities quick setup page (the two are equivalent). You must use other tasks to
make more substantial changes.

Here's an overview of default opportunity behavior for Sales for Redwood and Classic Sales UIs and some of the ways
that you can change it.

Default Opportunity Behavior Applies To Changes You Can Make in Setup
Assistant or in the Configure
Opportunities Quick Setup Page

Additional Setup

Opportunities follow the Standard
Sales Process sales method
provided by Oracle.
 

Sales for Redwood and Classic
Sales
 

Oracle provides two sales methods:
 

• Standard Sales Process (the
default)

• Accelerated Sales Process

You can select any one of these
sales methods as the default and
modify its sales stages. Or you
can select a sales method that you
created from scratch.
 
In Setup Assistant or Quick Setup
page, you can edit the sales
method sales stage names and add
your own stages. To enter or edit
the stage details, you must use the
Manage Sales Methods and Sales
Stages task.
 

Use the Manage Sales Methods
and Sales Stages task to populate
the details of each sales stage,
 including:
 

• What fields are required

• The actions you want
salespeople to take

• The tasks you want assigned
(Classic Sales Only)

• Documents you want to
provide as part of Sales Coach
(Classic Sales Only)

• Assessments (Classic Sales
Only)

• For the Sales for Redwood UI,
 you can suggest appropriate
actions to each of the sales
methods and sales stages
you create using Sales
Orchestration processes.

See the topic: Guide
Salespeople Through Best
Practices.

Salespeople are required to
enter a win or loss reason for an
opportunity when they close it.
 

Sales for Redwood and Classic
Sales
 

You can make the entry of the win
or loss reason optional. Your entry
is the equivalent of setting the
profile option Close Opportunity
Win/Loss Reason Required.
 

You can modify the list of win and
loss reasons. See the Modify the
List of Win/Loss reasons topic for
details.
 

Salespeople must also enter at
least one competitor before closing
opportunities.
 

Sales for Redwood and Classic
Sales
 

You can make competitor
entry optional. Your setting is
the equivalent to setting the
profile option Close Opportunity
Competitor Required.

If you want salespeople to enter
competitors, you must set them
up as described in the Competitors
chapter.
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Default Opportunity Behavior Applies To Changes You Can Make in Setup
Assistant or in the Configure
Opportunities Quick Setup Page

Additional Setup

 

When a salesperson creates
an opportunity, the application
automatically sets the close date
to 20 days after the creation date
unless the salesperson enters a
different date. The close date can
affect opportunity forecasts.
 

Sales for Redwood and Classic
Sales
 

You can change the default close
date. Your entry is the equivalent to
setting the Opportunity Close Date
Default profile option.
 

By default, when the salesperson
closes an opportunity, the close
date is automatically updated to
the actual date. You can retain the
previous date, by setting the profile
option Opportunity Close Date
Retain on Closure to Yes.
 

A salesperson closes an
opportunity by selecting one of the
closed statuses: Won, Lost, or No
Sale.
 

Sales for Redwood and Classic
Sales
 

None
 

You can modify the list of
opportunity statuses using the
Manage Sales Status task. For
more details, see the Modify
Opportunity Statuses topic.
 

Configure Basic Opportunity Behavior  
Here's how to select and modify a sales method for your opportunities and to change opportunity close requirements. If
you're satisfied with the entries you made in Setup Assistant, you can skip this step.

1. Click Quick Setup (gears) icon for the Opportunities functional area in Setup and Maintenance:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Quick Setup

2. You can make these modifications to the sales method:

◦ Select a different sales method from the Default Sales Method list.

◦ Edit an existing sales stage name, description, or win probability.

◦ Select a different phase and status for a sales stage.

◦ Enter a new sales stage:
i. Click Add Row (the plus sign icon).

ii. Enter the sales stage information.
iii. In the Order column, enter a decimal number to insert the new stage between new stages. For

example, enter 1.5 to enter a stage between stage 1 and stage 2. To enter a sales stage at the
beginning, enter a value smaller than 1, for example, 0.5 or 0.75.

Note:  You shouldn't change the order of existing sales stages. An existing sales stage associated
with the Won status should be the last stage in the sales stage order. The reason is if the status
of your opportunity changes to Won, then the expected behavior for the sales stage in the sales
method moves to the last number in the Order column.

3. Modify opportunity close behavior:
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◦ Make the entry of the competitor and win or loss reason optional by selecting the No option for each.

◦ Enter a different number of days in the Default Close Date in Days After Opportunity Creation field.

If salespeople don't enter a close date in an opportunity, the close date is set to the creation date plus the
number you entered. The close date affects the way opportunities are forecast.

Manage Sales Methods and Stages  
Use these steps to edit an existing sales method, including one of those predefined by Oracle, or to create a new sales
method entirely.

Here's how to create and edit sales methods.

1. From Setup and Maintenance, open the task Manage Sales Methods and Sales Stages:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Sales Methods and Sales Stages

2. On the Manage Sales Methods page, edit a sales method by clicking its name or click Create.
3. Leave the default value of Common Set for the Set field. Other values apply for implementations that require

different sales methods for different business units.
4. Enter a name for the sales method and an optional description. These entries aren't visible to salespeople by default,

but can be made visible when you configure the UI.
5. To provide a default close date for opportunities when they're created, enter a number of days in Close Window.

Create or edit the sales stages for the sales method as described in the following section.
6. Save your changes.

Note:

◦ The Enable Revenue Line Set Capability option is used only for multiple business unit
implementations.

◦ You can use the Disable option to remove any unused sales methods from use. You can't delete sales
methods after you create them.

Create or Edit Sales Stages for Sales Methods  
Here's how to create or edit sales stages for a sales method.

1. Edit a sales stage by clicking its name link or click Create.
2. Enter basic information about the sales stage, including predefined values for win probability and analytics reports:

Field Description

Name
 

Stage name visible in the UI.
 

Phase Select a classification of the sales stage.

136



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 11
Opportunities

Field Description

 
(For Classic Sales only)

 
You can define the sales stage phases by using the Manage Sales Stage Phase Codes task from the
Setup and Maintenance work area.
 

Description
 

Description visible in the UI.
 

Status
 

Use the status of Open for all stages representing opportunities that are still in progress.
 

Order
 

Enter a number for the order of this sales stage in the sales method.
 

Quota Factor
 

Enter any number in this field. This number is used only for legacy reports, but entry is required.
 

Disable
 

Select the Disable option to remove any unused sales stages from view. You must not disable sales
stages after they're used in opportunities.
 

Win Probability
 

Enter a default win probability for opportunities in this stage.
 

Duration
 
(For Classic Sales only)
 

The number of days this stage should last. When an opportunity is in a sales stage longer than the
duration, the opportunity is considered stalled. Stalled opportunities appear on the Stalled Deals
Infolet and underlying report.
 

Stalled Deal Limit
 

This field is no longer in use.
 

If you're including opportunities in forecasts using win probability, then prepopulating a default win probability
ensures that opportunities don't get left out by mistake. For example, if you automatically forecast all opportunities
with a 70 percent or greater win probability, then you can set up the following predefined win probabilities. Your
setup ensures opportunities in the Agreement, Negotiation, and Closed stages are included in forecasts even if a
salesperson forgets to manually enter a win probability.

Sales Stage Win Probability

Qualification
 

10
 

Opportunity
 

20
 

Building Vision
 

30
 

Presentation
 

50
 

Agreement
 

70
 

Negotiation
 

90
 

Closed 100
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Sales Stage Win Probability

  

3. Add any fields that you want to make required for opportunities in the Additional Required Fields region.
4. For the Classic Sales UI, add any activity templates you have created in the Activity Templates region. The

activity templates can automatically create tasks and appointments, which appear in the Activities tab of the Edit
Opportunity page in the Classic Sales UI.

5. Save your changes.

What to do next
For the Sales for Redwood UI, you can suggest appropriate actions to each of the sales methods and sales stages you
create using Orchestration. For more information, see the topic Guide Salespeople Through Best Practices.

Clear Cache if New Values Don't Show Up in the UI  
If you don't see a new value that you created for a list of values in the Sales for Redwood UI, try clearing your browser
cache. For performance reasons, Sales for Redwood uses the browser cache to store data such as lists of values and
dynamic choice lists. A process clears the cache automatically every hour.

For example, if you're adding a sales stage to a sales method, you won't see the new sales stage in the Sales for
Redwood UI until the automatic process runs and clears the browser cache. You see the new sales stage in the Classic
Sales UI immediately.

Modify Opportunity Statuses  
The application comes with four predefined opportunity statuses: Lost, No Sale, Open, and Won. Follow these steps to
add new statuses or modify the existing ones.

1. From the Setup and Maintenance work area open the Manage Sales Status task:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Show: All Tasks

◦ Task: Manage Sales Status

2. Here's how to add a new status:

a. Click Add (the plus sign icon).
b. Enter a name without spaces in the Status Code field. The code doesn't display to users.
c. Enter a display name in the Status field. This name displays in the opportunity pages in alphabetic order.
d. Select the Active option.
e. Select from one of the predefined values for Status Category.

3. You can modify an existing status by selecting its row.
4. Save your changes.
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Modify the List of Reasons Opportunities Are Won or
Lost  
When they close an opportunity, salespeople enter the reasons why the opportunity was won or lost. The application
comes with a predefined list that you can modify to suit your business:

• Customer not ready

• Good lead

• Install base

• Lost to competition

• Lost to internal development

• Lost to no decision

• No bandwidth

• No budget

• Other

• Price

• Product

• Relationship

• Track record

Use these steps to modify the reasons:

1. Open the task Manage Set Enabled Lookups from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Opportunities

◦ Task: Manage Set Enabled Lookups

2. On the Manage Set Enabled Lookups page, Lookup Type field, enter MOO_SETID_WIN_LOSS_REASON.
3. Click Search.
4. Here's how you can add a new reason in the Lookup Codes section:

a. Click Add (the plus sign icon).
b. Enter an internal name in the Lookup Code field. No spaces permitted.
c. Select Common Set from the Reference Data Set list.
d. Select Enabled.
e. Optionally, enter a start and end date.
f. Enter the wording salespeople see as they close an opportunity in the Meaning field.

5. You can modify an existing win/loss reason by selecting its row.
6. Save your changes.
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Enable Group By and Custom Aggregations for
Opportunities  
Additional predefined fields are now available for Group By and Aggregations for opportunities.

Previously, salespeople could group opportunities by Quarter, Month, and Sales Stage, and aggregate opportunity
records by Opportunity Count and Revenue Amount fields. With Sales for Redwood, they now have access to other
group-by options including group ranges and values. You can also enable the group-by feature on any supported
opportunity fields including custom fields and configure aggregations to display predefined enabled aggregated fields
in the opportunity pipeline list.

For example, a salesperson might want to group opportunities by a custom Invoice Date field that isn't based on the
predefined Close Date field or they might want to group by Deal Size with specified defined ranges. You can enable
further aggregations on custom fields and define the aggregation label. For example, for Deal Size, you might want to
aggregate a custom revenue field or aggregate a different custom revenue field for an Expected Revenue aggregation.

Manage Opportunity Group By Field
Predefined fields are available for Opportunities for display as filters for your Group By search in Workspace, but you
can specify field values for display as a filter in your Group By search by going to the Configure Adaptive Search  >
Configure UI  >  Enable for Group By.

This list contains the standard predefined configuration for opportunity group by fields.

• Sales Stage

• Win Probability (PrimaryRevenue.WinProb)

• Month - on close date (EffectiveDate)

• Quarter - on close date

• Account (CustomerAccount)

See the related topics, Set Up Search Results in Groups, and Supported Objects and Predefined Fields for Group By from
the Adaptive Search and Workspace chapter of the Implementation Reference guide for more information.

Enable Revenue Lines UI Element  
The Revenue Lines UI element isn't displayed as part of the Sales for Redwood predefined object configuration. Use the
Structure page to enable the UI elements for the revenue lines object.

Revenue lines let salespeople view which products are being sold and how much credit they receive.

When configured, they can click the revenue lines icon under Redwood Sales in the Navigator or springboard to launch
the Revenue Lines landing page. The Revenue Lines UI elements include:

• Revenue Lines icon on the springboard

• Revenue Lines link in the Navigator
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• Revenue Lines landing page

Enable the Revenue Lines UI elements for Sales for Redwood as follows:

1. Sign in as the sales administrator or as a setup user.
2. Activate a sandbox.
3. Navigate to Configuration > Structure.
4. In the Navigation Configuration page, select Revenue Lines under the Redwood Sales section.
5. In the Edit Page Entry: Revenue Lines page, select Yes for the Show on Navigator and Show on Springboard options.
6. Click Save and Close.
7. Publish the sandbox.
8. Verify that the Revenue Lines item is visible under the Redwood Sales group and that you can view the Revenue

Lines landing page.

Related Topics
• Get Started with Configuring Navigation

• Create and Edit Groups

Enable Credit Receiver Record Set Values  
You can enable credit receiver related values that appear in the opportunity search filter record sets. From the
Setup and Maintenance work area, go to the Manage Standard Lookups and you can set the lookup types from the
ORA_MOO_OPTY_SRCH_RS_WS: Lookup Codes page.

Prerequisites
Keep in mind the following prerequisites when salespeople assign sales credits in opportunities:

• Territories have been set up and your company is using territories for assignment of opportunity products.

• The user must have Full access to the opportunity to assign sales credits.
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The record set called I or my subordinate am a credit receiver returns records where the signed in resource or their
subordinate is a credit receiver for the opportunity. This allows sales managers and sales VPs to view the revenue lines
for their entire team and see who is receiving credit.

The I am a credit receiver record set returns records where the signed in resource is a credit receiver for the
opportunity. These record sets are predefined but they must be enabled before your salespeople can use them in Sales
for Redwood.

Note:  Record sets involving subordinates, which are resources within an organization or a line manager's hierarchy,
are available only to managers.

Here are the steps to enable I am a credit receiver and I or my subordinate am a credit receiver values for the
opportunity search filter record set.

1. Navigate to the Setup and Maintenance work area, and use the following:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Standard Lookups

2. In the Meaning field, enter Opportunity Filter Record Sets for Workspace.
3. Click Search.
4. Select the lookup type you want to enable in the ORA_MOO_OPTY_SRCH_RS_WS: Lookup Codes page.

◦ Scroll to the ORA_CREDITRECEIVER_ISME (I am a credit receiver) lookup code and select Enabled.

◦ Scroll to the ORA_CREDITRECEIVER_MYORG (I or my subordinate am a credit receiver) lookup code and
select Enabled.

5. Click Save and Close.
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12  Sales Quotas

Overview of Sales Quota Setup  
Quotas are targets salespeople strive to reach. Set up this feature to simplify assigning quotas to salespeople and to
track their progress. This chapter covers the basic setup for quota management using the UI. It doesn't cover quota
import or advanced quota calculation features. Quotas functionality is available only in the Classic Sales UI.

Here are the setup steps.

Step Applies To Description Navigation Where to Get More Details

1
 

Classic Sales You previously set up
sales territories. Each
salesperson eligible to
receive a quota must be
assigned to an active
territory. Quota calculations
rely on territory coverage.
If you plan to use quota
calculations, then make
sure that territories have
dimensional coverage
defined.
 

Navigator > Sales >
Territories
 

See the Sales Territories
and Assignment chapter.
 

2
 

Classic Sales Seasonality applies
percentages to split a quota
over months or quarters
to factor in seasonal
fluctuations. Seasonality
factor groups can be
associated with quota plans
or specific territories to
account for variations in
sales seasonality among
different territories. Instead
of entering quotas for each
period of the year, you rely
instead on seasonality to
split your annual quota into
period quotas. This task is
optional.
 

Setup and Maintenance >
Sales > Quotas > Manage
Sales Quota Seasonality
Groups
 

See the topic: Set Up Sales
Quotas
 

3
 

Classic Sales The sales revenue goal is
predefined for revenue
quotas. You can add other
types of goals, such as
volume. This is optional.
 

Navigator > Quotas >
Tasks (the side panel) >
Manage Sales Goals
 

See the topic Sales Goals
in the Implementation
Reference guide
 

4
 

Classic Sales Create a sales quota plan
for your fiscal year. One
plan per fiscal year is
required for tracking quotas

Setup and Maintenance >
Sales > Quotas > Manage
Sales Quota Plans
 

See the topic: Set Up Sales
Quotas
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Step Applies To Description Navigation Where to Get More Details

for the entire territory
hierarchy. The plan must
be activated before you can
allocate sales quotas.
 

5
 

Classic Sales Allocate sales quotas
starting from the root
territory down the sales
territory hierarchy.
 

Navigator > Sales >
Quotas
 

See the topic: Set Up Sales
Quotas
 

Set Up Sales Quotas  
Your sales organization sets sales quotas starting at the top of the territory hierarchy. Quotas pass down through the
hierarchy to territories and the owners.

You create a sales quota plan to track the quotas for a year. Seasonality factors automatically split yearly quota into
period quotas according to known seasonal fluctuations.

Create a Sales Quota Plan
This sales quota plan uses seasonality, which isn't required.

1. Open the Manage Sales Quota Seasonality Groups task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Quotas

◦ Task: Manage Sales Quota Seasonality Groups

2. Create a new group.
3. In the Seasonality Factors region, enter the factor percentages for time periods. Percentages must add up to

100.
4. Click Save and Close.
5. Open the Manage Sales Quota Plans task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Quotas

◦ Task: Manage Sales Quota Plans

6. Click Create.
7. Enter information for your new sales quota plan.

Field Value

Calculate Default Territory Quota
 

Deselect. If selected, the application calculates the quotas for each of the territories using the
default territory quota formula.
 

Track Select. Only one plan can track quotas for the year.
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Field Value

  

Copy Quotas From
 

Leave Blank. After creating your first sales quota plan, copy a previous plan for a quick way to
create a new plan.
 

8. Click Save and Close.
9. On the Options tab, select the name of your seasonality factor group.

Here's the Options tab.

10. Click Save.
11. With your new quota plan selected in the list of plans, click the Activate button.
12. Set the activation to right now plus a few minutes in the future.
13. Click OK.

The initial status is Pending Activation. Refresh the page to verify that the status changed to Active.
14. A sales revenue goal is automatically assigned to every territory owner during the annual quota planning

process. Upon activation, sales managers can sign in to the application and begin allocating revenue quotas to
their teams. Click Synchronize if you suspect the territory hierarchy for quotas isn't current.

Allocate Sales Quotas
Use the following steps to allocate sales quotas to territories. Allocate quotas to each territory from the top of the
territory hierarchy down. You can allocate a quota to a territory only after you allocate the quotas for all the territories
higher in the territory hierarchy.

1. Navigate to Quotas.
2. Select your activated quota plan.
3. In the Edit Sales Quotas region, verify that the territory quotas and owners' quotas are zero.
4. Select the root territory in the hierarchy.
5. Enter a territory quota amount and a resource quota amount for the year for the whole organization.
6. Click Publish and verify that the status changed from Not Published to Published.
7. For each child territory of the root territory, enter a territory quota amount and an owner's quota amount.
8. Select the parent territory and click Details for the territory.

The Details table shows the rollup quotas total for the child territories and the variance from the parent quota.
9. Click Save.
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10. Click the Territory Quota tab and verify that as part of the publish process, seasonality was automatically
applied to split the annual quota into period quotas.

11. In the Manage Sales Quotas page, select a child territory of the root territory and click Publish.

Note:  If the Publish button is disabled, this could be the result of one of the following:

◦ You did not publish the parent territory.

◦ You don't own the parent territory.

◦ The territory was already published. You can't republish a territory at the bottom of the hierarchy.

12. Verify that the status is Published.

The application notifies the territory owner and the analyst that the territory was published.
13. Click Save.

The following table lists common publishing errors and their solutions.

Error Steps to Resolve

You can't publish quota for the territory
because the territory has revenue
quota assigned prior to the territory
quota start date.
 

a. Select the parent territory.
b. Click Details to navigate to the Edit Sales Quotas page.
c. Select the territory.
d. Select the Territory Quota tab.
e. Set the period quota to zero for any period prior to the territory quota start date.

The total quota of all quarters for the
territory doesn't equal the annual
quota.
 

a. Select the parent territory.
b. Click Details to navigate to the Edit Sales Quotas page.
c. Select the territory.
d. Select the Territory Quota tab.
e. Update the period quotas so their sum equals the territory quota.

You can't perform this action for the
selected record.
 

This error occurs when you attempt to publish a quota for a territory that you own. Only
administrators and owners of parent territories can publish quotas for this territory.
 

Schedule Quota Processes  
Sales managers or administrators frequently make changes to active territories directly, using territory proposals, or
through web services. Schedule synchronization to run frequently to provide the latest structure for allocating quotas.

1. Click Navigator > Tools > Scheduled Processes.
2. Click Schedule New Process.
3. For the Type field, select Job.
4. In the name field list, click Search.
5. Search for Synchronize Quotas.
6. Select Synchronize Quotas and click OK.
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7. In the Parameters region of the Process Details page, select the sales quota plan.
8. Click Advanced.
9. In the Schedule tab, select Using a schedule.

10. Select the Daily frequency.
11. Change the start date to when you want to start running the process, and select the time of day when you want

it to run.
12. Change the end date to a future date.
13. Use the Notification tab to add notifications to specific people when the process completes.
14. Click Submit.
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13  Configure the Navigator and Home Page

A Single Page for All Your Sales Activities  
In the default home page design provided by Oracle, salespeople can access both the different work areas they need
as well as the reports and analytics that highlight key sales information. Here's a brief description of the home page
sections. You can configure the different sections and even hide some, but you can't change their order on the page.
The home page is shared both by Sales for Redwood and Classic Sales.

Global Toolbar and Springboard with Navigation Icons

Callout Number Region Description

1
 

Global region with toolbar.
 

The toolbar includes icons to open the
Navigator, Home page, and the Settings and
Actions menu, among others. The toolbar,
 described in a separate topic, is available on all
pages.
 

2
 

Tabs that group navigation icons.
 

Which tabs users see depends primarily on
their security privileges. Because setup users
have broad privileges, you see many more
tabs than sales users. For example, sales users
never see the Service or Help Desk tabs, as
these aren't part of Classic Sales or Sales for
Redwood.
 
Sign in as a Sales Representative or a Sales
Manager to get an idea of how the application
is set up by default for each user.
 
Using the Structure tool, you can rename the
tabs, hide them, change heir order, and move
their contents.
 
The tabs correspond to the groupings you
see in the Navigator, but you can choose to
display only a subset of what's available in the
Navigator.
 

3
 

Navigation icons within the tab you selected.
This region is called the springboard.
 

Navigation icons within the tab you selected.
 
The navigation icons correspond to the
selections you see in the Navigator.
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Things to Finish and News
The middle of the page includes two regions that you can hide during setup:

• Things to Finish

Displays the same notifications you can view using Notifications (bell icon) in the global toolbar.

• News and Announcements

You can create company-wide announcements as described in the topic Create and Enable an Announcement
in the Oracle Applications Cloud Implementing Applications guide.
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Analytics and Key Classic Sales Information Displayed in Infolets
The Analytics section displays tabs grouping infolets. Infolets are containers that display key sales information in Classic
Sales. In Sales for Redwood you display the information in the Sales Dashboard instead.

You can display different infolets for different job roles in the organizations and salespeople can configure what
information they want to see on their own page.

There are two types of infolets you can display:

• Infolets with business intelligence reports provided by Oracle or those you create in Oracle Business Intelligence
Answers (BI).
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• Workspace infolets that summarize sales information and make it possible to take action on individual items
without drilling down into individual records.

Here's a screenshot of the Sales Infolets tab displaying two Workspace infolets.

Note:  By default, your application displays an older type of infolet, called actionable infolet, rather than the
Workspace infolets. As described in this chapter, new customers should switch to using Workspace infolets
because they're designed to work with Workspace. Actionable infolets are designed to work with individual
work areas and the saved searches created in them.

Related Topics
• Workspace Infolets on the Classic Sales Home Page

Workspace Infolets on the Classic Sales Home Page  
In Classic Sales, Workspace infolets summarize key sales information in the Sales Infolet tab in the Analytics section at
the bottom of the home page. They provide salespeople with many of the features they use in Workspace, such as quick
actions and filters.

For example, from within the My Accounts Workspace infolet, salespeople can take notes, log calls, schedule
appointments, and even create opportunities for a specific account in the list. They can also create accounts directly
from the infolet. Here's a screenshot of the My Accounts infolet provided by Oracle:

Callout Number Function What You Can Configure

1 Infolet title. Edit the title.
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Callout Number Function What You Can Configure

   

2
 

Select a Workspace saved search as a filter.
 

Specify which Workspace saved searches are
available as filters.
 

3
 

Review basic information about accounts and
drill down to edit
 

You can specify which fields display in each
record in the list.
 

4
 

Take actions on an account without drilling
down. On an account, you can take notes, log
calls, and even create opportunities.
 

You can enable, disable, or reorder the smart
actions using Application Composer.
 

5
 

Create new accounts.
 

N/A
 

6
 

Navigate to Workspace.
 

N/A
 

Oracle provides you with 10 Workspace infolets. Six are preconfigured and four blank:

• My Accounts

• My Appointments

• My Contacts

• My Leads

• My Opportunities

• My Tasks
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• Additional Actionable Infolet

• Additional Actionable Infolet

• Additional Actionable Infolet

• Additional Actionable Infolet

As a sales administrator or setup user, you can configure the information in each of the infolets, even those that
are preconfigured. You can specify which Workspace saved searches are available as filters, change the infolet title,
and decide how you want the infolet information to display. You can configure Workspace infolets to display any
combination of saved searches from Workspace. Suppose, for example, that you created a project custom object to
track projects involving multiple customers. You could configure one of the Workspace infolets as My Projects to track
the accounts and the tasks involved.

Setup Overview  
Here's an overview of the steps to configure your home page and navigation to application features.

Home Page
Here's a summary of the steps to configure your home page appearance. The home page is shared by both Classic Sales
and Sales for Redwood.

Step Applies To Description Navigation Where to Get More Details

1
 

Both Classic Sales and Sales
for Redwood

Create a sandbox with the
Appearance tool.
 

Configuration >
Sandboxes
 

See the video and topic:
Configure Home Page
Appearance
 

2
 

Both Classic Sales and Sales
for Redwood

Upload your company
logo and save your new
configuration.
 

In the sandbox, select
Tools > Appearance
 

Covered in the same video
and topic.
 
For additional configuration
options, see the
Configuration of Home
Page and Navigation
chapter of the Oracle
Applications Cloud
Configuring and Extending
Applications guide.
 

3
 

Both Classic Sales and Sales
for Redwood

You can remove the Things
to Finish and the News
and Announcements
sections of the home page,
 by clicking Home Page
Display (top icon in the
Appearance tool) and
setting Visible to No.
 

In the Appearance tool,
 click Home Page Display
 

Covered in the same video
and topic.
 

4
 

Both Classic Sales and Sales
for Redwood

Publish your sandbox.
 

Click Publish in the
sandbox.

Covered in the same video
and topic.
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Step Applies To Description Navigation Where to Get More Details

  

Navigation and Infolet Tabs
Here's an overview of the steps to configure navigation and specify which infolet tabs appear in the Analytics section.
Infolets are important only for Classic Sales.

Step Applies To Description Navigation Where to Get More Details

1
 

Both Classic Sales and Sales
for Redwood

Sign in as users with the
different job roles you
are using and review the
default navigation for each
to see which items you
want to hide or configure.
Classic Sales icons appear
in the Sales tab. Sales
for Redwood icons in the
Redwood Sales tab.
 

Not applicable.
 

See the topic: What
Different Sales Job Roles
See in the Navigator and
Springboard
 

2
 

Both Classic Sales and Sales
for Redwood

Create a sandbox with the
Structure tool.
 

Configuration >
Sandboxes
 

See the video and topic:
Configure Navigation
 

3
 

Both Classic Sales and Sales
for Redwood

Specify which items
salespeople see on the
Navigator and which icons
they see on the home
page springboard and
in which order. You can
hide unwanted items from
everyone or you can add
EL Expression conditions
to make them visible
only to a subset of users.
You can make features
accessible from both the
Navigator and the home
page springboard, or from
the Navigator only.
 

In the sandbox, select
Tools > Structure
 

Covered in the same video
and topic.
 

4
 

Classic Sales For Classic Sales, specify
which infolet tabs in the
Analytics section appear
and in which order. All of
the Workspace infolets you
need to display key sales
information are available
within the Sales Infolet tab,
 so you can hide the rest
unless you need them.
 

In the Structure tool, click
the Home Configuration
tab.
 

Covered in the same topic.
 

5
 

Both Classic Sales and Sales
for Redwood

Publish your sandbox.
 

Click Publish in the
sandbox.
 

Covered in the same topic.
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Workspace Infolet Configuration

Step Applies to Description Navigation Where to Get More Details

1
 

Classic Sales Create and enter a sandbox
with Page Composer as
your tool. If you want to
display different Workspace
infolet configurations for
different job roles, you can
specify a job role.
 

Configuration >
Sandboxes
 

See the topic: Create and
Enter a Sandbox with Page
Composer as Your Tool
 

2
 

Classic Sales Specify which Workspace
infolets you want to expose
on the page and how you
want the page to look.
 

While in Page Composer,
select each infolet you want
to display from the Infolet
Repository.
 

See the topic: Specify Which
Workspace Infolets Display
and In What Order
 

3
 

Classic Sales Configure the content of
each Workspace infolet. You
can:
 

• Change the infolet title

• Specify which
Workspace saved
searches salespeople
can select

• Choose the fields that
display in each record
for each saved search

While in Page Composer,
 open each Workspace
infolet and go to Actions >
Configure
 

See the topic:Configure
Workspace Infolets
 

4
 

Classic Sales Remove any unused
infolets from the list of
infolets available for display.
 

While in Page Composer,
 open each Workspace
infolet and go to Actions >
Edit Visibility
 
 

Covered in the same topic.
 

5
 

Classic Sales Save your work by
clicking Close in the Page
Composer toolbar, and
publish your sandbox.
 

Click Close in Page
Composer and then
Publish in the sandbox.
 

N/A
 

6
 

Classic Sales In Application Composer,
 you can enable, disable, or
reorder the actions users
can take for each object.
This setup is optional.
 

Application Composer >
Common Setup > Smart
Actions
 

See the topic Overview
of Smart Actions in the
Configuring Applications
Using Application
Composer guide.
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Configure Home Page Appearance  
Oracle provides you with a default home page design that salespeople can use to access all of the navigation icons and
key sales information they need. While you can still use alternate multipage designs that are more configurable, Oracle
recommends that for Classic Sales, you use the default theme and limit your configuration to uploading your logo and
hiding sections of the page you don't need. You can't change the order of the sections on the page.

Watch video
 

1. Create and enter a sandbox with the Appearance tool enabled:

a. In the Navigator, click Configuration > Sandboxes.
b. Click Create Sandbox.
c. Enter a sandbox name.
d. Select Active for the Appearance tool.
e. Click Create and Enter.
f. From the sandbox Tools menu, select Appearance to enter the tool.

2. In the Logo field, select File from the list and upload your logo.

The logo image must be saved as a .png file with a transparent background with a recommended maximum
size of 200 pixels wide and 50 pixels high.

3. If you're hiding the Things to Finish and News and Announcements sections, there's no point in uploading an
image using Cover Image. The image appears in the center of the page under these sections.

4. Remove either or both of the Things to Finish and News and Announcements sections of the page if you
aren't using them. Things to Finish displays notifications you can also access from the toolbar. News and
Announcements can display your company-wide announcements. Here's how to hide them:

a. Click Home Page Display, the top icon on the page.
b. Click in the Visible column for each section and select No.

5. View your new home page configuration while inside the sandbox by clicking Home.
6. Publish the sandbox:

a. Click the sandbox name and select Publish.
b. On the Sandbox Detail page, click Publish.

You can check the progress of the publish process in the Current Status section.
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Configure Navigation  

The Different Factors That Determine What Users See on the
Home Page  
Which selections users see in the Navigator, and which icons and infolets they see on the home page depends on a
number of factors:

• Security roles

What users see in the UI is primarily determined by their security roles. For example, users you provision with
any of the standard sales job roles, get to see all of the sales navigation, including Opportunities, Accounts,
Leads, Contacts, and so on. But they don't see the Security Console, a feature only available to users with the
IT Security Manager job role. Because users are granted the Employee abstract role, they get many human
resources features on the Navigator that aren't pertinent to sales unless you're implementing Oracle HCM
Cloud.

• Configuration in the Structure tool

Use the Structure tool to fine-tune the access granted by the security roles:

◦ Specify if navigation is available in the Navigator and the springboard or hidden from users. You can
create, edit, and change the order of the different headings (called groups) and even create new groups.

◦ Specify which sales infolet tabs appear and in which order.

You can add conditions (EL Expressions), to display or hide specific items or groups. For example, you can
remove an item from view for a specific user or a specific job role. Sales representatives have the security
permissions to import accounts and contacts and monitor background processes, but you may want to leave
these rather technical tasks for sales administrators. Some selections already include EL Expressions that make
items visible depending on system profile option settings or only when you enable a particular functional area
of an offering. You can append additional conditions to the existing expressions.

• Default infolet views you create

Using Page Composer, you can specify which infolets appear in an infolet tab by default and in which order.
Hiding an infolet doesn't remove the infolet entirely. Users can always add it back to their home page. If you
want to hide infolets from users entirely, you must edit the visibility of each one. See the Enable and Configure
Workspace Infolets section for details.

• Personalization

Individual users can create their own personal views of the navigation icons they see on their springboard, but
they can't change what displays on the Navigator. Users can also select the infolets they want to display and
change their display order. Any personalization supersedes the default Infolet views you created.

Here's a diagram that illustrates the different factors that together determine what a user sees in the Navigator, on the
springboard, and in the infolet tabs.
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Navigation Configuration
The Navigation Configuration page displays all the feature selections available to all users of Oracle Fusion Cloud
applications. It's not filtered by the security roles. So, you don't have to hide selections that are never displayed to sales
users. To change the display setting and to add EL Expression conditions, you must drill down into each item.
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Infolet Tab Configuration
Use the Home Configuration page in the Structure tool to specify which infolet tabs users get to see in the Analytics
section of the home page. Just like the Navigation Configuration page, this page shows you the selections for all
applications. You can hide, add EL Expressions, rename, and reorder.
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What Different Sales Job Roles See in the Navigator and
Springboard  
To help you configure navigation, here's an overview of what users with common sales job roles see by default in the
Navigator and springboard. The different Navigator items are grouped under headings.

The table lists all the headings, but not every item under every heading. If it makes sense to hide the whole heading,
there's no need to list each item. For each of the common job roles, you learn if the item or category is displayed in both
the Navigator and springboard, in the Navigator only, or in neither.

Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Me
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

All of the items under
the Me category
come from the Oracle
Human Resources
Cloud. Unless you're
implementing HCM,
remove all of the items
here except Roles and
Delegations.
 
Salespeople can use
Roles and Delegations
to see which security
roles are assigned to
them, and request
more, depending on
your security setup.
 

My Team, Users and
Roles
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove. Only setup
users can use Users
and Roles to create
and manage sales
users.
 

Partner Management
 

Neither
 

Neither
 

Neither
 

Both
 

Remove unless you're
using Oracle Partner
Management
 

Sales, Leads
 

Both
 

Both
 

Both
 

Both
 

Sales leads work area.
 

Sales, Deal
Registrations
 

Neither
 

Neither
 

Neither
 

Both
 

Remove unless you're
using Oracle Partner
Management
 

Sales, Forecasts
 

Both
 

Both
 

Both
 

Both
 

Sales work area where
you submit, adjust,
 and review sales
forecasts.
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Sales, Activities
 

Both
 

Both
 

Both
 

Both
 

Work area where
salespeople manage
their calendar and
tasks, log calls and
emails, and other
activities.
 

Sales, Products
 

Neither
 

Neither
 

Neither
 

Both
 

Create and manage
products for the sales
catalog, and upload
product images.
 

Sales, Competitors
 

Both
 

Both
 

Both
 

Both
 

View and manage
sales competitors.
Sales Administrators
can create
competitors. The other
sales roles can only
view them.
 

Sales, Opportunities
 

Both
 

Both
 

Both
 

Both
 

Work area for
managing sales
opportunities.
 

Sales, Accounts
 

Both
 

Both
 

Both
 

Both
 

Work area salespeople
use to manage their
accounts.
 

Sales, Analytics
 

Both
 

Both
 

Both
 

Both
 

Central work area for
viewing BI reports.
 

Sales, Price Books
 

Neither
 

Neither
 

Neither
 

Both
 

Price the products
you're selling and to
offer discounts.
 

Sales, Territories
 

Neither
 

Navigator only
 

Both
 

Both
 

Sales territory
management for Sales
Managers and Sales
Administrators.
 

Sales, Campaigns
 

Navigator only
 

Both
 

Neither
 

Navigator only
 

Marketing campaign
information from
Oracle Marketing
Cloud.
 
Remove unless
you're implementing
integration with Oracle
Marketing Cloud
(Eloqua).
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Sales, Quotes and
Orders
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove unless
you're implementing
integration with Oracle
Configure, Price, and
Quote (CPQ) Cloud.
 

Sales, Contacts
 

Both
 

Both
 

Both
 

Both
 

Sales contacts work
area.
 

Sales,
 Recommendations
 

Neither
 

Both
 

Both
 

Both
 

Remove. No longer
used.
 

Sales, Lightbox
 

Both
 

Both
 

Both
 

Both
 

Enables salespeople to
share and collaborate
on presentations.
 

Sales, Promotions
 

Neither
 

Neither
 

Neither
 

Both
 

Sales administrators
can create promotions
to offer discounts.
 

Sales, Quotas
 

Neither
 

Both
 

Both
 

Both
 

Enables sales
managers and sales
administrators to set
sales quotas for their
directs.
 

Help Desk
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove unless you're
implementing Oracle
Help Desk.
 

Business Plans
 

Both
 

Both
 

Both
 

Both
 

Salespeople and
managers can use it to
create business plans
for the accounts they
serve.
 

Contract Management
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Remove. Sales users,
 including Sales
Administrators cannot
use contracts without
additional security
roles.
 

Incentive
Compensation
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Manage sales
compensation.
 

Procurement
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove unless
you're implementing
purchasing.
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

My Enterprise,
 Offerings
 

Neither
 

Neither
 

Neither
 

Both
 

Sales administrators
and setup users
enable the offerings
related to the
applications they
purchased. You must
enable the offering
and its features for
implementation.
 

My Enterprise, New
Features
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Sales administrators
and setup users
 

My Enterprise,
 Subscriptions
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Oracle Subscription
Management
information.
 
Remove unless
you're implementing
Oracle Subscription
Management.
 

Tools, Set Preferences
 

Both
 

Both
 

Both
 

Both
 

Lets users reset their
password and upload
their picture. The
same Set Preferences
is also available in the
Settings and Actions
menu that you can
open by clicking on
your user initials or
image.
 

Tools, Spaces
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove. Oracle Web
Center Portal.
 

Tools, Scheduled
Processes
 

Both
 

Both
 

Both
 

Both
 

Lets you monitor
and run background
processes.
 

Tools, File Import and
Export
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove. Imports
Oracle Web Center
content. Not used in
Oracle Classic Sales.
 

Tools, Smart Text
 

Neither
 

Neither
 

Neither
 

Navigator only
 

A feature
administrators and
implementors can use
to change UI text and
prompts.
 

Tools, Deep Links
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Deep links make it
possible to navigate
from your company's
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

pages directly to a
page within your sales
application without
going through the
menu structure.
 

Tools, Contact Search
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Remove if you aren't
using the telephony
(CTI) feature.
 

Tools, Import
Management
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Import accounts,
 contacts, products
and other sales
information from a
file.
 

Tools, Download
Desktop Integration
Installed
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Remove if you aren't
deploying Oracle Sales
for Outlook.
 

Tools, Notification
Preferences
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Remove. Not used
in sales. Feature to
trigger automatic
notifications.
 

Tools, Worklist
 

Both
 

Both
 

Both
 

Navigator only
 

Worklist notifications.
 

Tools, Reports and
Analytics
 

Both
 

Both
 

Both
 

Navigator only
 

Create BI reports you
can display in your
sales application.
 

Tools, Export
Management
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Export accounts,
 contacts, products
and other sales
information as a file.
 

Tools, Mass Transfer
 

Neither
 

Neither
 

Neither
 

Both
 

Transfer data to other
environments, for
example, from test to
production.
 

Configuration,
 Appearance
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Change application
home page layout,
 logos, icons and other
feature.
 

Configuration,
 Structure
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Change Navigator and
springboard layout.
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Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

Configuration,
 Business Objects
 

Neither
 

Neither
 

Neither
 

Navigator only
 

Configure additional
business objects for
your application.
 

Others, Resource
Directory
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

View the sales
organization hierarchy.
 

Others, My Dashboard
 

Both
 

Both
 

Both
 

Both
 

Remove. Provides an
alternative home page
for your company.
 

Others, Setup and
Maintenance
 

Neither
 

Neither
 

Neither
 

Both
 

Access setup tasks.
 

Others, Social
 

Both
 

Both
 

Both
 

Both
 

Opens the Oracle
Social Network UI.
 

Others, Marketplace
 

Both
 

Both
 

Navigator only
 

Both
 

Links to Oracle Cloud
Marketplace where
you can view partner
applications.
 

Others, Getting
Started
 

Both
 

Both
 

Both
 

Both
 

Access short videos to
help users get started.
Your organization can
add your own videos
here.
 

Others, Cloud
Customer Connect
 

Navigator only
 

Navigator only
 

Navigator only
 

Navigator only
 

Opens Cloud
Customer Connect
where users can
interact with other
users and ask
questions.
 

Workspace
 

Both (after you enable
Workspace)
 

Both (after you enable
Workspace)
 

Both (after you enable
Workspace)
 

Both (after you enable
Workspace)
 

Workspace appears
both in the Navigator
and springboard
automatically when
you enable the feature.
 
The Home
Configuration page
includes two versions
of Workspace. One
provides access to
Workspace for sales
job roles. The second
version provides
access for service job
roles.
 
The service version
includes the ability to

166



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 13
Configure the Navigator and Home Page

Navigator Heading,
 Item

Sales Representative Sales Manager Sales VP Sales Administrator Recommendation

view records in nested
tabs (the dynamic tabs
feature).
 
Users see only one
of these items,
 depending on their
security privileges.
 

Configure Navigation  
Use the Structure tool to configure which selections appear in the Navigator, which icons area available on the
springboard, and which infolet tabs are visible to users.

Watch video
 

Create and Enter a Sandbox with the Structure Tool
Create and enter a sandbox with the Structure tool:

1. Navigate to Configuration > Sandboxes.
2. Click Create Sandbox.
3. In the Create Sandbox page, enter a name and select Structure as the tool.
4. Click Create and Enter.

The Sandbox toolbar appears at the top of the page.
5. From Tools, select Structure to open the Structure page.

Specify What Users See on the Navigator and in the Springboard
With the Navigation Configuration tab selected, you can configure what appears on the Navigator and springboard.
Just click the item or group name to edit.

• Specify where and for whom the item shows up by making a selection from Show on Navigator and Show
on Springboard. You can choose to display individual items in the Navigator only, in both the Navigator
and springboard, or in neither. You can't display an item in the springboard only. If you hide an item in the
Navigator, it gets automatically hidden on the springboard as well. Here are the options:

◦ Yes: displays the item for all users with the right security permissions.

◦ No: hides the item from all users in all applications.
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◦ EL Expression: lets you add an EL Expression that must be true to display the item.

Add EL Expression conditions to display items or groups selectively to users with specific job roles, or
even by user name. Here are some examples of EL Expressions you can use:

Who can see the group or page
entry

EL Expression and Example

Only users having any of the specific
roles
 

#{securityContext.userInRole['<Role_Name>']}

 
#{securityContext.userInRole['ORA_FND_APPLICATION_ADMINISTRATOR_

JOB,ORA_PER_EMPLOYEE_ABSTRACT']}

 

Only users not having any of the
specific roles
 

#{!(securityContext.userInRole['<Role_Name>']}

 
#{!(securityContext.userInRole['ORA_FND_APPLICATION_ADMINISTRATOR_

JOB,ORA_PER_EMPLOYEE_ABSTRACT'])}

 

Only users having all of the specific
roles
 

#{securityContext.userInAllRoles['<Role_Name>']}

 
#{securityContext.userInAllRoles['ORA_FND_APPLICATION_

ADMINISTRATOR_JOB,ORA_PER_EMPLOYEE_ABSTRACT']}

 

Only users not having all of the
specific roles
 

#{!(securityContext.userInAllRoles['<Role_Name>']}

 
#{!(securityContext.userInAllRoles['ORA_FND_APPLICATION_

ADMINISTRATOR_JOB,ORA_PER_EMPLOYEE_ABSTRACT'])}

 

Only users having access to specific
resources, for example, the Social
work area
 

#{securityContext.userGrantedResource['resourceType=FNDResourceType;resourceName=FND_

Launch_Social_Menu;action=launch']}

 

• Rename a group and change its icon.

• Move items to a different group by using the arrow keys, or by selecting a different group while editing the item.
You can't nest groups within other groups.

For example, move both Workspace items from the Workspace group to the Sales group. There are two
Workspace items because Oracle provides two different versions of Workspace: one for sales and one for
service. Users see only one icon on their home page, depending on their security settings.

• Copy items.

• Move items within a group using the up and down arrow keys.

For example, you may want to move the Workspace icon to be the first icon users see on their page.
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• Get rid of the Others group.

Any top-level items (items that aren't part of a group in the Structure tool) display in the Others group in the UI.
You can't rename that category or move it, but you can hide the group by moving or hiding all items in it.

• Create new groups and add your own content.

You can create new groups from the Create menu and display them selectively by adding EL Expressions. You
can copy items into the group or create your own items by selecting Create Page Entry from the Create menu.

Note:  To simplify future functionality updates, don't create groups to provide different views for different
sets of users, however. Add the EL Expressions to individual items instead.

Example of Hiding a Whole Navigator Group You Don't Use
If you aren't implementing Oracle Global Human Resources Cloud, then hide the whole Me group, which appears in the
Navigator for all sales users by default.

1. Click the Me group name.
2. Set Show on Navigator to No. Hiding the group hides all of the individual items in the group as well.

Example of Hiding an Individual Sales Feature You Don't Use
If you aren't implementing Oracle Marketing Cloud, then remove the Campaigns item from both from the Navigator
and springboard:

1. Open the Sales group to display the different sales features.
2. Click Campaigns
3. In the Edit Page Entry page, set Show on Navigator to No.

Removing the selection from the Navigator automatically removes the link from the springboard as well. You
can't display a selection on the springboard if it's not displayed in the Navigator
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Selectively Hide Navigation
You may want to leave technical tasks, such as importing data or monitoring scheduled processes, to sales
administrators. To remove the navigation links for a subset of users, you edit the EL Expression for these items and add
your conditions. For example, here's how to remove the Scheduled Processes navigation from both the Navigator and
springboard for all salespeople with the Sales Representative job role:

1. Open the Tools group to display its selections.
2. Click the second Scheduled Processes item.

Here's a screenshot of a portion of the Navigation Configuration page highlighting the item.

Note:  Oracle includes two Scheduled Processes items in the list because it supports two different interfaces
for scheduled processes. If you aren't sure which item to edit, add your condition to both.

3. Click Edit for Show on Navigator to edit the EL Expression.
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The Expression Editor displays the expression provided by Oracle. In this example:
#{(securityContext.userGrantedResource['resourceType=FNDResourceType;resourceName=FND_Scheduled_Processes_Menu;action=launch'])

and(Profile.values.ESS_ALLOW_CLASSIC_INTERFACE ne null) and (Profile.values.ESS_ALLOW_CLASSIC_INTERFACE

ne 'Y')}

4. In the Expression Editor, append the condition: and!
(securityContext.userInRole['ORA_ZBS_SALES_REPRESENTATIVE_JOB']) to the original expression.

Here's the resulting expression:
#{(securityContext.userGrantedResource['resourceType=FNDResourceType;resourceName=FND_Scheduled_Processes_Menu;action=launch'])

and(Profile.values.ESS_ALLOW_CLASSIC_INTERFACE ne null) and (Profile.values.ESS_ALLOW_CLASSIC_INTERFACE

ne 'Y')and!(securityContext.userInRole['ORA_ZBS_SALES_REPRESENTATIVE_JOB'])}

5. Click Validate to check for errors.
6. Click OK.
7. It's a good idea to click Save after each edit to make sure your changes are saved.
8. Repeat the steps to add the condition to the Show on Springboard  EL Expression.

Here's a screenshot of the Expression Editor with the edited Show on
Springboard expression: :#{(Profile.values.ESS_ALLOW_CLASSIC_INTERFACE
ne 'Y' and Profile.values.ESS_ALLOW_CLASSIC_INTERFACE ne null)and!

(securityContext.userInRole['ORA_ZBS_SALES_REPRESENTATIVE_JOB'])}
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Specify Which Infolet Tabs Appear and in Which Order
You can specify which infolet tabs appear and in which order.

1. While in the Structure tool, click the Home Configuration tab.
2. Use the arrow keys to change the order of the infolet tabs.
3. To edit the infolet tab name and to specify how the infolet page gets displayed, click its name:

◦ Yes: displays the infolet tab for all users with the right security permissions.

◦ No: hides the infolet tab from all users in all applications.

◦ EL Expression: lets you add an EL Expression condition that must be true to display the infolet page.

4. To create additional infolet tabs with your own content, you can edit the five sales tabs crated for this purpose:
Sales Page 1 through Sales Page 5.

Related Topics
• What are the supported and unsupported EL expressions?

• Get Started with Configuring Navigation

Enable and Configure Workspace Infolets (Classic Sales)  

Enable Workspace Infolets for the Classic Sales Home Page  
Enable the infolets on the Home page by setting the profile Enable Workspace Infolets
(ZCA_ENABLE_ADAPTIVE_INFOLETS) to Yes. Here's how:

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

2. On the Manage Administrator Profile Values page, search for the profile option by entering
ZCA_ENABLE_ADAPTIVE_INFOLETS in the Profile Option Code field.

3. Click Search.
4. In the ZCA_ENABLE_ADAPTIVE_INFOLETS: Profile Values section, set the profile value to Yes.
5. Click Save and Close.

Create and Enter a Sandbox with Page Composer as Your Tool  
You can create different Workspace infolet configurations for the whole enterprise, or for specific job roles. If you're
configuring different configurations of Workspace infolets for different job roles, then you must create separate
sandboxes for each job role.

1. Navigate to Configuration > Sandboxes.
2. Click Create Sandbox.
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3. In the Create Sandbox page, enter a name and select Page Composer as the tool.
4. If you want to create different infolet configurations for different user roles, select the job role:

a. Click Edit in the Support Context column for Page Composer.
b. In the Edit Sandbox Context window, select Job Role and select the job role you want to configure.

Each job role can access different saved searches and can have a different infolet configuration on their
page.

c. Click OK.
5. Click Create and Enter.

The Sandbox toolbar appears at the top of the page.
6. Click Home to return to the home page.
7. In the sandbox, select Page Composer from the Tools menu.

The Page Composer toolbar appears underneath the sandbox toolbar.

Specify Which Workspace Infolets Display and In What Order  
Use this procedure to specify which infolets salespeople see when they open the page and in which order.

1. With Page Composer and your sandbox open, scroll down to the Analytics section, Sales Infolets tab, where the
Workspace infolets are located.
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2. You must expose Workspace infolets one by one. Here's how:

a. Click Infolet Repository (the file icon on the top right side of the Analytics heading highlighted in the
screenshot).

b. Select one of the 10 Workspace infolets. If the list includes two infolets with the same name, select the
second one on the list. For example, the Infolet Repository list may include two entries for My Account,
My Opportunities, and so on.

Note:  Even though you set the profile to use the Workspace infolets, the older version of actionable
infolets remains present when you configure the view for a site, for example. These older infolets are
present on the list during configuration, but not displayed to users because of the value of the EL
Expressions they contain.

c. Make sure the infolet that's displayed on the page is a Workspace infolet. Workspace infolets include the
Workspace icon (callout 1) and the three dots for quick actions (Callout 2). Here's a screenshot of the My
Accounts Workspace infolet.

If you displayed the wrong infolet by mistake, just expose the second one.
3. Change the order of the infolets by dragging them around. Alternately, you can click the Infolet Repository

icon, scroll down in the list and select Reorder Infolets.
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4. If you are done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.

Configure Workspace Infolets  
You can configure any of the 10 Workspace infolets provided by Oracle, including the six that are predefined for you.

1. With Page Composer and your sandbox open, scroll down to the Analytics section, Sales Infolets tab, where the
Workspace infolets are located.

2. If the infolet you want to configure isn't displayed in the Sales Infolets tab, you must display it on the page.
Here's how:

a. Click Infolet Repository (the file icon on the top right side of the Analytics heading highlighted in the
screenshot).

b. Select the Workspace infolets you want to configure. If you're configuring one of the predefined infolets,
and the list includes two infolets with the same name, select the second one on the list. For example, the
Infolet Repository list may include two entries for My Account, My Opportunities, and so on.

Note:  Even though you set the profile to use the Workspace infolets, the older versions of the
predefined infolets remain present when you make site-level configurations. These older actionable
infolets are present on the list during configuration, but not displayed to users. You can recognize
which infolet is which because the predefined Workspace infolets include the Workspace icon and the
three dots for quick actions.

Change the Infolet Title

1. In the right top corner of an infolet, click Actions (the down arrow) and select Edit Title and Views.
2. Edit the title.
3. Click Save and Close.

Note:  You can't add use the other sections of this window to configure Workspace infolets. You can't display
BI reports or other content on the back of this type of infolet.

4. If you're done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.

Specify Which Saved Searches Appear in the Infolet

1. In the right top corner of an infolet, click Actions (the down arrow) and select Configure.
2. In the Manage Infolet window, Filters tab, use the arrows to move the saved searches you want to display in

the infolet to the Selected column. The saved searches determine what information salespeople can display
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in the infolet. You aren't limited to selecting saved searches for just one object. For example, you could select
Accounts: My Accounts and Assets: My Customer's Active Assets.

3. If you're done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.

Specify What Fields Display for Each Saved Search
Here's how to determine which fields display on the infolet for each record. You must configure each saved search you
are using separately.

1. In the right top corner of an infolet, click Actions (the down arrow) and select Configure.
2. In the Manage Infolet window, select the Layout tab (callout 1 in the screenshot).
3. Select the saved search you want to configure (callout 2).
4. Add the fields you want to display (callout 3). Be sure to always display the Name field: it provides the link that

salespeople use to drill down into the record.
5. You can adjust the relative width of the columns using the slider (callout 4).
6. Keep the Show quick actions option selected to display the actions for each record (callout 5).

7. If you're done with your configurations, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.
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Hide Unused Workspace Infolets from Users  
Remove unused Workspace infolets from use by changing their visibility. Unless you change their visibility, infolets are
listed in the Infolet Repository list and available for display by salespeople even if you remove them from the page.

You may want to remove the four blank infolets (Additional Actionable Infolets) if you aren't using them, for example.
Here's how:

1. With Page Composer and your sandbox open, scroll down to the Analytics section, Sales Infolets tab, where the
Workspace infolets are located.

2. Before you can change their visibility, you must expose the Workspace infolets you want to remove. Here's how:

a. Click Infolet Repository (the file icon on the top right side of the Analytics heading highlighted in the
screenshot).

b. Select one of the Workspace infolets you want to remove. If you're removing one of the predefined
infolets, and the list includes two infolets with the same name, select the second one on the list. For
example, the Infolet Repository list may include two entries for My Account, My Opportunities, and so on.

Note:  Even though you set the profile to use the Workspace infolets, the older versions of the
predefined infolets remain present when you make site-level configurations. These older actionable
infolets are present on the list during configuration, but not displayed to users. You can recognize
which infolet is which because the predefined Workspace infolets include the Workspace icon and the
three dots for quick actions.
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3. In the right top corner of the infolet, click Actions (the down arrow identified by callout 1) and select Edit
Visibility (callout 2).

CAUTION:  Don't select Delete. Deleting removes the infolet entirely. If you delete an infolet by accident, you
must contact Oracle Support to restore it.

4. In the Edit Visibility window, Visible list, select No.

5. Click Save and Close.

The Workspace infolet is grayed out on the page. The infolet remains in listed in your Infolet Repository list, but
it doesn't appear to users after you publish the sandbox.

6. If you're done with your configuration, be sure to click Close on the Page Composer toolbar to save your
changes before publishing the sandbox.
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14  Microsoft 365 Integration for Redwood UX

Overview of Microsoft Exchange Sync and Redwood
Add-In  
The Redwood UX add-in, known as the Oracle Sales for Outlook add-in, features task-oriented flows to simplify
salespeople's daily sales activities. Optimized for Outlook, the intuitive UIs provide 360-degree sales information for
meetings and emails, directly in the context of those meetings and emails. Salespeople can share meetings and emails
with Sales. Emails are shared as conversation messages.

In addition, salespeople see a daily summary of appointments that they can act on. You can set a default saved search
for each object across the organization and salespeople can set their preferred saved searches for sync using the add-in.

To begin implementing, start with the How do I implement Microsoft 365 for Oracle Sales Redwood UX? playbook on
Oracle Help Center > Sales > Playbooks page.

View this video on Oracle Cloud Customer Connect to view an introduction to the app: CX Sales Add-in for Microsoft
Outlook.

Capture Activities Automatically
The integration supports bidirectional sync for appointments, tasks, and contacts, as well as the automatic sync of
appointments from Exchange to Sales. Appointments, tasks, and contacts can be synced from Sales to Exchange based
on Workspace-defined saved searches.

Seamless Email Integration with Microsoft Exchange
With this integration, emails in Microsoft Outlook can be shared directly from the Redwood UX add-in or through the
email sync feature. Salespeople can categorize these emails as “Shared with Oracle”, with replies automatically synced
for seamless tracking and follow-up.

In addition, with the Microsoft Exchange email integration, emails can be sent via Microsoft Exchange directly from the
Oracle Redwood web application. The Microsoft Exchange email integration is fully compatible with this integration's
email sync functionality and the Redwood UX add-in, ensuring seamless connectivity and an enhanced user experience.
Once enabled, this integration allows emails sent from Oracle Sales – such as those related to accounts or opportunities
– to be delivered via Microsoft Exchange, with replies automatically synced back to Oracle.

See Exchange Email Integration for Digital Sales for more information.

Task-Oriented Functionality and Insights
The add-in's task-oriented functionality is directly geared to salespeople's day-in-the-life scenarios, in the context of
Outlook interactions and interface.

Salespeople begin their day with a daily briefing, right in the add-in. Insights from Sales further help them engage with
their customers, easily schedule and prepare for meetings, and review and respond to emails.
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Improved Sign-In Experience
The add-in provides a better and more secure sign-in experience. Based on your company's policy, the add-in utilizes
OAuth, a feature that allows salespeople stay signed in for longer.

Easily Customize and Deploy the Add-In
The add-in comes with predefined layouts to use as-is. If customizations are required, the predefined layouts can be
easily tailored using the new Oracle Sales for Outlook tool in Application Composer. The tool makes it easy to migrate
customizations from the earlier CX Sales for Microsoft 365 add-in or from the Oracle CX Sales Mobile application, so you
don't need to manually rebuild the customizations for this integration.
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15  Mobile

Overview of CX Sales Mobile  
The Oracle CX Sales Mobile app helps your users manage their day effectively and develop customer relationships using
their phone or tablet.

Read the following sections to learn more.

To begin implementing Mobile, start with Overview of CX Sales Mobile Setup.

Manage Sales Activities
Sales teams can manage Sales activities. Here are the highlights:

• Use the action-driven, configurable home page that contains a sales briefing, letting salespeople track the sales
pipeline and stay on top of daily activities.

• Leverage optimized task-based flows for key sales functions: Accounts, contacts, leads, opportunities,
activities, assets, service requests, partners, and custom objects.

• View, create, and edit tasks, appointments, and call reports.

• Saved searches that are shared across CX Sales Mobile and Workspace lists, for consistency across applications.

• View your recently accessed records in the app when using the global search, or when sharing notes from an
external app.

• Add contacts and leads to CX Sales Mobile from the mobile device's address book.

• Create contacts and leads by using a photo of a business card.

• Scan an asset's bar code to search for an asset and automatically enter the asset serial number.

• Share notes, photos, videos, documents, or files from mobile to Sales accounts, opportunities, or other records.

• Plan your sales activities around your current location by viewing your nearby contacts, accounts,
opportunities, and leads plotted on an interactive map. You can also plan future appointments in a city or near
an address with an easy location search.

• View your quotes in the app and stay updated on the quote status. View and send quote proposal documents
to customers, or share them with your team for feedback.

• View reports and analytics with modern visualizations optimized for mobile displays, such as bar graphs,
funnels, bubble charts, and more. Role-based layouts let sales administrators provide unique experiences to
salespeople, managers, and others.

Manage Partner Relationship Management Activities
Partners can manage Oracle Partner Relationship Management activities:

• Partner users can effectively manage and improve channel sales on-the-go.

• Channel Managers can track overall channel sales and also easily manage partners, partner contacts, and
related information.

• Partner role-based restriction features let you configure the app according to your business requirements.
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Oracle Sales Assistant Chatbot
Integrate with the Oracle Sales Assistant chatbot to get these features:

• Oracle Sales Assistant helps salespeople perform their daily sales-related tasks. Using their phones, they
can type or use your voice to ask questions, and the sales assistant retrieves the information or acts on the
requests.

• Sales Assistant reduces manual data entry and makes it easier to view and update sales records using voice
commands or typing.

Note:  If you need help enabling the Sales Assistant, send us a message on the Sales Assistant forum on
Oracle Cloud Customer Connect.

New Design for Efficiency on the Go
Take advantage of these new design for efficiencies on-the-go:

• Modern and intuitive user experience, designed to boost productivity with fast and seamless interactions.

• At-a-glance record views for a quick grasp of summary, key, and related information.

• Access contextual actions everywhere for fast and easy record updates.

• Improved picker experience powered by Adaptive Search.

Global Search
These global search features make finding records efficient:

• Fast and simple search across all objects in one place.

• Use the multi-keyword search across multiple fields for faster and easier access to information.

• Search more easily with recent searches and type ahead results that display results as you type.

• Filter search results by object types.

New and Improved Sign-In Experience
This version of the mobile app has a new and improved sign-in experience:

• Scan a QR code to sign in easily using your single sign-on credentials or using basic authentication.

• Use face or fingerprint recognition to securely sign in to the app.

• View new configurations with fast download and instant activation of your configurations.

• Enable OAuth authentication token support to let users stay signed in to the app for longer.

Use a Phone or Tablet
Use either a phone or tablet to access the app. Using a tablet changes the display to 2x portrait mode.
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Easy Configuration
Implement Mobile using these easy configuration aspects:

• Configure the app using the new interface designer.

• Create criteria for page layouts for both standard and custom objects.

• Download your configurations to the app quickly and easily. Mobile automatically signs you in to the correct
sandbox without restarting the app.

• Create custom scripts that enforce custom validations and business logic for both top-level parent and child
objects.

Use Offline
Salespeople can use Mobile in offline mode when they're not able to be online:

• View and edit Sales data in areas with no network connection.

• Sync automatically when a connection is re-established.
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16  Account Data Enrichment and Verification

Two Services to Enrich and Verify Your Data and Save
Salespeople Time  
Perhaps nothing is more important for your sales effort than having up-to-date and actionable information about your
customers and contacts and minimizing the time salespeople spend entering data. Oracle provides two services that
enrich your customer data, improve its accuracy, and eliminate data entry time.

For account and contact information, you can obtain information on millions of companies worldwide by subscribing to
the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B). A second service, Oracle Address, Email, and
Phone Verification, ensures that you have the correct postal addresses, that your emails don't bounce, and your calls go
through.

Note:  Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) is the new name for Data as a Service
(DaaS).

Here's an overview of the 2 services:

Service Oracle Account and Contact Enrichment by
Dun & Bradstreet (D&B)

Oracle Address, Email, and Phone
Verification

Purpose
 

Account and contact search, enrichment, and
prospecting.
 

Address, phone, and email address verification.
 

What It Does
 

Instead of entering data themselves when
they create accounts, salespeople can look
up the organizations they sell to from Dun &
Bradstreet Corporation, one of the premier
sources of business information. The service
provides access to more than 347 million
account records and more than 135 million
contact records worldwide. Included is
information about more than 90 different
company attributes, including sales volume,
 growth data, hiring trends, competitors, and so
on.
 
Users can also filter the data by using over 60
company or contact attributes such as industry,
 revenue, company hierarchy, private or public
indicator, contact title, contact department.
 
The service also provides information about
account hierarchies, showing the linkages
between a corporation's subsidiaries, branches,
 and divisions. You can also schedule account or
contact enrichment on thousands of records at
the same time.
 

Salespeople can search and validate addresses
in more than 248 countries using data from
Loqate.
 
They can verify addresses when creating or
editing an account: correct misspellings, add
missing elements (such as the postal code), and
standardize elements (for example, changing
"Drv" to "Dr"). You can also schedule address
verification on thousands of records at the
same time.
 
The service automatically checks if phone
numbers and email addresses exist and informs
you if they're invalid. No more bounced emails
or calls that don't go through.
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Service Oracle Account and Contact Enrichment by
Dun & Bradstreet (D&B)

Oracle Address, Email, and Phone
Verification

Oracle licenses account and contact enrichment
separately. You subscribe to the Oracle Account
Enrichment Cloud Service and the Oracle
Contact Enrichment Cloud Service.
 

How It Works
 

Salespeople start typing the account name,
 and the application suggests possible matches
straight away. Selecting a match automatically
fills in all the rest of the information.
 
Salespeople can add contacts to accounts by
job role. Selecting the Enrich action for existing
accounts gets the latest information.
 
The account and contact information
continues to be updated automatically based
on synchronization rules setup by your
administrator.
 

Salespeople start typing the street address
in the search field and the application starts
suggesting possible matches. Selecting one of
the suggestions fills in the rest of the address
fields.
 
You can also enable a Verify Address button
that salespeople can use to verify addresses
for a particular country. That's useful if you
added nonstandard fields to the address or if
salespeople don't always use the search field to
look up an address.
 
You can also verify and update addresses in
bulk.
 
The service informs salespeople if phone
numbers and email addresses are invalid as
soon as they enter them. They can also verify
any existing ones to make sure they're still valid.
 

Setup
 

After you activate the service, and complete the
simple setup described in this chapter in your
sales application, salespeople can start looking
up and enriching their data right away.
 
To get the most out of the application, however,
 you must add fields to the UI to expose the
additional information you're getting. While
most of the information maps onto fields you
can expose using Application Composer, you
must create some custom fields to map the
rest.
 

After you activate the service, and complete
the simple setup described in this chapter in
your sales application, salespeople can start
looking up street addresses and verifying
phone numbers and email addresses.
 
In the Classic Sales (Classic UI), you can also
expose the Verify Address button with a few
extra steps.
 

Where to Get More Information
 

This guide includes the information you need
to get started. You can get the full scoop in the
Using Account and Contact Enrichment by Dun
& Bradstreet guide.
 

This guide includes the information you need
to get started. You can get the full scoop in
the Using Oracle Address, Email, and Phone
Verification guide.
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Related Topics

Enrichment and Verification You Can Start Using Right
Away  
After you complete the brief setup described in this chapter, salespeople can start enriching and verifying their
customer data with two of the services: Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and Oracle
Address, Email, and Phone Verification. Additional fields and actions appear automatically in all of the appropriate
create or edit account, lead, and contact pages. Here's a brief summary of how it works.

Saving Time Entering Accounts, Contacts, and Addresses
Salespeople can start saving time and improving accuracy while creating new accounts right away. Instead of entering
data about an account themselves, they search for the account and address in new search fields, and the information is
populated automatically. Here's a screenshot of the Classic Sales Create Account page with callouts highlighting the new
UI elements.

Callout Number New UI Element Description

1
 

Account search
 

Salespeople search for accounts by name or
by address and add them. The application
suggests possible matches as soon as they
start typing. Selecting an account populates the
available company data.
 

2
 

Address search
 

Salespeople start typing an address and the
service starts suggesting matching addresses.
Selecting an address populates all of the
address data.
 

3
 

Verify Address button
 

If you enable the optional Verify Address
button, salespeople can verify an address that
they enter in the Classic Sales UI or import from
a file. You can enable this field with a few setups
for Classic Sales UIs only. If salespeople use the
address search consistently, they don't need the
button.
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Enriching Existing Accounts
To enrich an existing account, salespeople use the Enrich Account action available in all the UI pages where you edit
accounts. Here's a screenshot of the Actions menu in the Edit Account page.

When you enrich an account, you get to choose which fields to keep and which to replace.
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If you're adding contacts to an account, you can add whole sets of contacts using criteria such as job category. You can
also enrich multiple accounts and contacts at the same time on the landing page.

If you subscribe to Customer Data Management, you also have the option of enriching large batches of accounts and
contacts in the Data Enrichment work area.

Email Address and Phone Number Verification
When you enter a phone number or an email address, the application automatically checks if they're valid. The
application can't check if the phone numbers and emails you enter are valid for the specific person or account, of
course, but it does assure that a phone number will actually dial and that an email won't bounce.

If the email or phone number you enter isn't valid, you get informed right away: the application displays the status right
under the field. If nothing appears, your entry is valid. Here's a screenshot of a phone number to give you an idea of
what appears under invalid information:

Callout Number Description

1
 

Status. For phone numbers, this can be only Invalid. Email addresses can also display the status of
Partially-Valid: the domain is valid but the name can't be verified. A Partially-Valid status for an email
means that the complete email can't be verified by Loqate, but Loqate did validate the email domain.
If the person left the company, or changed their name, you'll see the Partially-Valid status for the
email, for example.
 

2
 

Date the email address or phone number was verified by the application.
 

3
 

Reverify button that you can use to verify again. You never know when area codes or email addresses
may change. What's valid today may not be in 6 months.
 

4
 

Overwrite button to manually set the status. The application, isn't perfect. If you know that the number
or email is correct, you can set the status to Verified. When you do, you see Overwritten on instead of
Verified on.
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Callout Number Description

 

The application does display a Valid status, but only much later. By default, the status appears 180 days later. When
the information is old, salespeople may want to verify it again by clicking on the Reverify button. You can specify the
number of days before the Valid status appears or even turn this option off during setup. For details, see the topic:
Enable the Verification of Addresses, Emails, and Phone Numbers.

Three Ways to Enrich Data  
There are three ways to enrich account and contact data from the Oracle Account and Contact Enrichment by Dun &
Bradstreet (D&B) service:

• Real-time enrichment

You can enrich data directly in the Account and Contact pages as described in this chapter.

The real-time enrichment uses the REST APIs and the mapping you maintain using the Manage Oracle Data as
a Service Attribute Mapping and Preferences task in the Setup and Maintenance work area.

• Manual enrichment

You can do your sales prospecting in the D&B service UI, which provides more ways to filter and search. You
then export your account or contact records into a file and import the file into your sales application.

The D&B service includes a default export mapping you can edit. You can edit the import mapping in the sales
application. The Using Account and Contact Enrichment by Dun & Bradstreet guide provides the details about
the export and import mappings.

• Batch enrichment

You can also enrich your account and contact data in bulk. Bulk enrichment uses the same REST APIs and
mapping you maintain in Manage Oracle Data as a Service Attribute Mapping and Preferences. However, the
integration doesn't support any additional custom fields you add.

Here's a diagram to illustrate the architecture:

• The D&B service includes the mapping you can use to export a file with accounts and contacts. Importing the
file using Import Management into your sales application uses an import mapping.

• The real-time enrichment feature and Oracle Customer Data Management (CDM) both use the REST APIs and
the mapping you can update in your sales application. The mapping determines which fields show up in the UI.
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Overview of Data Enrichment and Verification Setup  
This chapter outlines the process for setting up two Oracle cloud services that enrich and verify your account and
contact data: Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and Oracle Address, Email, and Phone
Verification.

When your organization subscribes to Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and Oracle
Address, Email, and Phone Verification services, the person or people designated as the service administrators for
your sales application domain or the account administrator, receive a welcome email. You must be one of the service
administrators to complete the setup. If you don't receive the email, you can ask the account administrator to create you
as a service administrator or resend the email. Here's a list of the setup tasks.

Before you start, you must complete the required setup in the Oracle Cloud Dashboard. See the Using Account and
Contact Enrichment by Dun & Bradstreet guide for details.
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Step Applies To Description Navigation or Steps Where to Get More Details

1
 

Both Classic Sales and Sales
for Redwood

Enter the service URL,
 and the user name and
password for a user with
the role: DATASERVICE
CLIENT API APPID, in two
separate pages in Setup
and Maintenance:
 

• Manage Integration
with Oracle Data as a
Service

• Manage Integration
with Oracle
Verification Services

Setup and Maintenance >
Sales > Integrations >
Manage Integration with
Oracle Data as a Service
 
Setup and Maintenance >
Sales > Integrations >
Manage Integration
with Oracle Verification
Services
 

See the topic: Integrate the
Account Enrichment and
Verification Services
 

2
 

Both Classic Sales and Sales
for Redwood

Enable the UI verification
for street addresses, email
addresses, and phone
numbers.
 

Setup and Maintenance >
Sales > Data Quality
Verification Services >
Quick Setup
 

See the topic: Enable the
Verification of Addresses,
Emails, and Phone Numbers
 

3
 

Classic Sales Optionally, you can enable
a Verify Address button
that salespeople can
use in Classic Sales to
verify addresses entered
manually.
 

Setup and Maintenance >
Sales > Sales
Foundation > Geographies
 

See the topic: Enable the
Verify Address Button
 

4
 

Both Classic Sales and Sales
for Redwood

Salespeople don't see all
of the great account and
contact information you
enrich unless you expose
additional fields in the UI.
Some of the additional
information you get from
D&B is already mapped to
existing sales account and
contact fields. All you need
to do is to use Application
Composer to add these
fields to the UI. For other
attributes, you must create
custom fields and add them
to the mapping.
 

Navigator >
Configuration >
Application Composer
 
Setup and Maintenance >
Sales > Accounts and
Contacts > Show >
Manage Oracle Data as a
Service Attribute Mapping
and Preferences
 

See the topics:
 

• Add Enriched Fields
to the Account and
Contact Pages

• Add Fields to the
Mapping

5
 

Both Classic Sales and Sales
for Redwood

Specify if you are enriching
accounts, contacts, or both
and indicate enrichment
preferences. This setup is
done in the Preferences
tab on the same Manage
Oracle Data as a Service
Attribute Mapping and
Preferences page you used
in the previous step.
 

Setup and Maintenance >
Sales > Accounts and
Contacts > Show >
Manage Oracle Data as a
Service Attribute Mapping
and Preferences
 

See the topic: Configure
Enrichment Preferences
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Related Topics

Integrate the Account Enrichment and Verification
Services  
Here's how to integrate the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) and the Oracle Address,
Email, and Phone Verification services in your sales application.

Note:  Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) is the new name for Data as a Service
(DaaS).

Prerequisites
Before you start, you must:

• Set up the DaaS service in the Oracle Cloud Dashboard.

• Copy the URL of the DaaS instance.

• Provision a user with the DATASERVICE CLIENT API APPID role.

• Add each service as a confidential application in Oracle Identity Cloud Service as described in the topic "Add a
Confidential Application" in the Administering Oracle Identity Cloud Service guide.

On the Client page of the Add Confidential Application wizard, in the Authorization section, select Resource
Owner, Client Credentials, Authorization Code, and Refresh Token as Allowed Grant Types. Leave Redirect
URL blank. If you use Basic Authentication, do not include the question mark special character (?) in the
password.

You must enter the URL and user name and password to complete the integration in the Setup and Maintenance work
area.

Integrate the D&B Enrichment with Your Sales Application

1. In the Setup and Maintenance work area, open the Manage Integration with Oracle Data as a Service task:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Show: All Tasks

◦ Task: Manage Integration with Oracle Data as a Service

2. In the Manage Integration with Oracle Data as a Service page, select the OAuth Authentication option.
3. In the URL field, enter the URL of the DaaS instance. Remove /data/ui from the end of the URL. Here's an

example: https://mydataservice-myidentitydomain.data.us2.oraclecloud.com.

If you didn't save the URL, you can find it in the welcome email and in Oracle Cloud Dashboard.
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4. In the Client ID and the Client Secret fields, enter the values you obtained when you added the service as a
confidential application in Oracle Identity Cloud Service.

5. Click Save and Close.

Integrate the Address, Email, and Phone Verification with Your Sales
Application
Enter the same information in the Manage Integration with Oracle Address Verification page:

1. In the Setup and Maintenance work area, open the task Manage Integration with Oracle Verification
Services:

◦ Offering: Sales

◦ Functional Area: Integrations

◦ Show: All Tasks

◦ Task: Manage Integration with Oracle Verification Services

2. In the Manage Integration with Oracle Verification Services page, select the OAuth Authentication option.
3. In the URL field, enter the URL of the verification service instance. Remove /data/ui from the end of the URL.

Here's an example: https://mydataservice-myidentitydomain.data.us2.oraclecloud.com.

If you didn't save the URL, you can find it in the welcome email and in Oracle Cloud Dashboard.
4. In the Client ID and the Client Secret fields, enter the values you obtained when you added the service as a

confidential application in Oracle Identity Cloud Service.
5. Click Save and Close.

Related Topics

Enable the Verification of Addresses, Emails, and Phone
Numbers  
After you enter the integration information, you enable the verification services that you want to use. Here's the easiest
way, using the Quick Setup page provided for this purpose:

1. In the Setup and Maintenance work area, open the Sales offering.
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2. In the Functional Areas section, the left pane of the page, scroll down to the Data Quality Verification
Services, and click Quick Setup (the gears icon highlighted in the screenshot).
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3. In the Configure Verification Services page, select the verification services you want to enable. Address is
enabled by default.

4. Using Show Valid Status for Email and Phone field, you can specify if and when users see the status of Valid
for verified phone numbers and emails.
Users see right away if the email address or phone number they enter are invalid, but they don't see a Valid
status until later. By default, the Valid status displays after 180 days. Displaying the status makes it possible for
users to verify the information again. In 6 months, the contact may be gone; the number may have changed.

a. To enable or disable the display of the Valid status, select Yes or No.
b. If you selected Yes, then enter the number of days before users see the Valid status.

5. Click Save and Close.

Note:  Using the Quick Setup page is the equivalent of setting the following profile options using the Manage
Administrator Profile Values task:

• Email Verification Service Enabled (ORA_ZCH_EMAIL_VERIFICATION)

• Phone Verification Service Enabled (ORA_ZCH_PHONE_VERIFICATION)

• Phone and Email Status Validity (ORA_ZCH_PHONE_EMAIL_STATUS_VALIDITY)

Related Topics
• Enrichment and Verification You Can Start Using Right Away

• Integrate the Account Enrichment and Verification Services

• How do I verify email addresses and phone numbers?

Enable the Verify Address Button  
If your salespeople are diligent in using the search field to enter addresses, you can skip this step. Addresses added
using search are already verified. The Verify Address button is only useful if you want to check that the accuracy of
addresses entered manually or if you imported unverified addresses. You can enable the button only for countries you
imported earlier.
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Repeat these steps for each of the countries where you want the button. You can only enable the button for country
geographies you imported.

1. Open the Manage Geographies task from the Setup and Maintenance work area:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Geographies

2. On the Manage Geographies page, search for each country you imported using either its name or its two letter
ISO code. For example, enter either United States or US, and click Search.

3. Select the country in the Search Results area.
4. Click Go to Task (the circular icon) in the Address Cleansing Defined column.

Here's a screenshot of the Manage Geographies page highlighting the Go to Task icon and the Address
Cleansing column.

5. In the Address Cleansing Level window, select Optional for Real-Time Address Cleansing Level.

6. Click Save and Close.
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Add Enriched Fields to the UI  

Review the List of Additional Account and Contact Attributes  
Review the list of mapped and unmapped account and contact information you can expose in the UI. You can expose
the mapped fields in the UI using Application Composer. For the unmapped fields, you must first create a custom field
for it in the sales application and add the field to the mapping.

Mapped Account Fields
You can expose any of the fields listed in the table in the account pages using the display name. Long field names
aren't always completely visible in Application Composer, but you can hover over a display name to see the underlying
technical name.

The table lists the name of the Oracle Account Enrichment attribute in the first column, and provides a brief definition
and description. The Account Field Display Name field lists the display name in the UI and in Application Composer. The
Account Field Name lists the technical name. The names don't always match.

Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

Data/DataCloudStatus
 

Data Cloud Status
 

Indicates if the record has
been matched.
 

Enrichment Status
 

DataCloudStatus
 

Data/
PrefFunctionalCurrency
 

Currency
 

A code value that describes
the type of currency in
which the sales volume
(local currency) is
expressed.
 

Preferred Functional
Currency
 

PrefFunctionalCurrency
 

Data/
CurrFyPotentialRevenue
 

Sales Volume (Local
currency)
 

The total annual sales
revenue in US dollars as
a signed, decimal field. If
the revenue is collected
in local currency, then the
local value is converted to
US dollars.
 

Current Fiscal Year's
Potential Revenue
 

CurrFyPotentialRevenue
 

Data/
DomesticUltimateDunsNumC
 

Domestic Ultimate DUNS
Number
 

A subsidiary within the
global family tree that is the
highest-ranking member
within a specific country.
May contain leading zeros,
which will be lost if the field
is treated as numeric.
 

Domestic Ultimate D-U-N-
S Number
 

DomesticUltimateDunsNumC
 

Data/DunsNumberC
 

DUNS Number
 

A randomly generated 9-
digit number assigned
by Dun & Bradstreet
Corporation to identify

D-U-N-S Number
 

DunsNumberC
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

unique business
establishments. May
contain leading zeros,
which will be lost if the field
is treated as numeric.
 

Data/
GlobalUltimateDunsNumC
 

Global Ultimate DUNS
Number
 

The top-most responsible
entity within the corporate
family tree. May contain
leading zeros, which will be
lost if the field is treated as
numeric.
 

Global Ultimate D-U-N-S
Number
 

GlobalUltimateDunsNumC
 

Data/ParentDunsNumC
 

Parent DUNS Number
 

The D-U-N-S number of
the parent organization.
May contain leading zeros,
which will be lost if the field
is treated as numeric.
 

Parent D-U-N-S Number
 

ParentDunsNumC
 

Data/
EmpAtPrimaryAdrEstInd
 

Number of Employees (This
Site)
 

The number of employees
at this location.
 

Employees at Identifying
Address
 

EmployeesAtPrimaryAddressText
 

Data/
EmpAtPrimaryAdrEstInd
 

Employees Here Reliability
Code
 

Describes the reliability of
the Employees Total value.
 

Number of Employees at
Identifying Address
 

EmployeesAtPrimaryAddress
 

Data/
EmpAtPrimaryAdrMinInd
 

Employees Primary
Minimum Indicator
 

A code value that describes
the reliability of the
Employees Total value.
 

Number of Employees at
Identifying Primary Address
Minimum
 

EmployeesAtPrimaryAddressMinimum
 

Data/EmployeesTotal
 

Employees Total
 

The total number of
employees in the business
organization; it should
include subsidiary and
branch locations.
 

Number of Employees
 

EmployeesTotal
 

Data/TotalEmpEstInd
 

Employees Total Reliability
Code
 

Describes the reliability of
the Employees Total value.
 
The possible values are:
Actual, Estimated, and
blank.
 

Number of Employees
Estimated Qualifier
 

TotalEmployeesEstimatedIndicator
 

Data/TotalEmpMinInd
 

Employees Total Minimum
Indicator
 

Displays the reliability of
the Employees Total value.
 
The possible values are:
Includes Subsidiaries,
 Subsidiaries not included,
 and blank.
 

Number of Employees
at Identifying Address
Minimum Qualifier
 

TotalEmployeesMinimumIndicator
 

Data/ImportInd
 

Import Indicator
 

A code value that identifies
whether the business
imports goods or services

Importer Indicator
 

ImportInd
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

for remanufacture or
sale, exports products
or services to a foreign
country, or is an agent for
goods.
 

Data/ExportInd
 

Export Indicator
 

A code value that identifies
whether the business
imports goods or services
for remanufacture or
sale, exports products
or services to a foreign
country, or is an agent for
goods.
 

Exporter Indicator
 

ExportInd
 

Data/LegalStatusCode
 

Legal Status Code
 

A code value that describes
the legal structure of the
business.
 

Legal Status
 

LegalStatusCode
 

Data/LineOfBusiness
 

Line of Business
 

A description of the
operations or activities of
the business. Relates to the
primary four-digit 1987 US
SIC.
 

Line of Business
 

LineOfBusiness
 

Data/MinorityOwnedInd
 

Minority Owned Indicator
 

Whether or not the
business is owned by a
member of a minority
group.
 

Minority-Owned Indicator
 

MinorityOwnedInd
 

Data/MinorityOwnedType
 

Minority Owned Type
 

Indicates the ethnicity of
the minority holding an
ownership interest.
 

Type of Minority-Owned
Organization
 

MinorityOwnedType
 

Data/RentOwnInd
 

Owns Rents Code
 

A code value that indicates
if the business owns
or rents the building it
occupies.
 

Rent or Own Indicator
 

RentOwnInd
 

Data/
PublicPrivateOwnershipFlag
 

Public Private Indicator
 

Whether or not ownership
of the business is public or
private.
 

Private Ownership
 

PublicPrivateOwnershipFlag
 

Data/SmallBusInd
 

Small Business Indicator
 

Indicates if the business
meets SBA certification
eligibility criteria effective
July 1, 1999. All firms must
be certified by one of
the Small Disadvantaged
Business Certification
Agencies.
 

Small Business Indicator
 

SmallBusInd
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

Data/ParentSubInd
 

Subsidiary Status
 

Whether or not the subject
business is more than 50-
percent owned by another
organization.
 

Subsidiary Indicator
 

ParentSubInd
 

Data/YearStarted
 

Year Started
 

The year when the current
ownership or management
assumed control of the
business or the year
established if no control
change has taken place.
This is not provided for
branch records.
 

Year Established
 

YearEstablished
 

Data/LocationType
 

Location Type
 

A code value that describes
the organizational status
of the business; for
example, Single Location,
 Headquarters, Branch.
 

HQ Branch Indicator
 

HQBranchIndicator
 

Data/FederalTaxIDNumber
 

Federal Tax ID Number
 

A number assigned by
the Internal Revenue
Services (IRS) that either
uniquely identifies or helps
to identify a subject, also
referred to as Federal
Taxpayer Identification
Number.
 

Taxpayer Identification
Number
 

JgzzFiscalCode
 

Data/PrimaryAddressLine1
 

Street Address 1
 

The first street address
line where a business
is physically located.
Generally in local language.
 

Address Line 1
 

PrimaryAddressLine1
 

Data/PrimaryAddressLine2
 

Street Address 2
 

The second street address
line where a business
is physically located.
Generally in local language.
 

Address Line 2
 

PrimaryAddressLine2
 

Data/PrimaryCity
 

City
 

City where the business is
located. Generally in local
language.
 

City
 

PrimaryAddressCity
 

Data/PrimaryCounty
 

County
 

The full name of the county
where the business is
located.
 

County
 

PrimaryAddressCounty
 

Data/PrimaryState
 

State
 

The full name of the state
where the business is
located.
 

State
 

PrimaryAddressState
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Oracle Account
Enrichment Attribute

Definition Description Account Field Display
Name

Account Field Name

Data/PrimaryPostalCode
 

OSC Postal Code
 

The 5-digit postal code
where the business is
physically located.
 

Postal Code
 

PrimaryAddressPostalCode
 

Data/PrimaryCountry
 

Country
 

The 2-byte alpha character
ISO code for the country
where the business is
located.
 

Country
 

PrimaryAddressCountry
 

Data/RawPhoneNumber
 

Phone Number
 

The primary phone number
for the business with no
formatting or punctuation.
This string contains all
telecommunication number
components (area code,
 exchange, number).
 

Primary Phone Number
 

PrimaryPhoneNumber
 

Data/
FaxRawPhoneNumber
 

Facsimile Number
 

The primary facsimile
number for the business
with no formatting
or punctuation. This
string contains all
telecommunication number
components (area code,
 exchange, number).
 

Fax
 

Fax
 

Data/Url
 

Url
 

The primary URL for the
company.
 

URL
 

PrimaryURL
 

Data/WomanOwned
 

Woman Owned
 

A business that is at least
51-percent owned by, and
whose management and
daily business operations
are controlled by, a woman.
 

Woman-Owned Indicator
 

WomanOwnedInd
 

Unmapped Account Fields
You must create a text or a number field for these attributes and add them to the mapping before you can expose the
field in the account pages.

The table lists the name of the attribute on the mapping page in the first column, and provides a brief definition and
description. The Geographical Availability column indicates if the attribute is available for all countries or just a subset.

Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

Data/State Name
 

State Name
 

The full name of the physical
state or province name where the
business is located.
 

Global
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

Data/PrimaryFullPostalCode
 

Full Postal Code
 

Full postal code as received by Dun
& Bradstreet Corporation.
 

Global
 

Data/LatitudeShort
 

Latitude Short
 

The angular distance north or
south from the earth's equator
measured through 90 degrees.
Note: This is a less granular view of
the Latitude field.
 

Canada, Germany, UK, US, Mexico,
 Vietnam, Belgium, Australia,
 Netherlands, Republic of Korea
 

Data/LongitudeShort
 

Longitude Short
 

The angular distance east or
west from the prime meridian
measured through 180 degrees.
Note: This is a less granular view of
the Longitude field.
 

Canada, Germany, UK, US, Mexico,
 Vietnam, Belgium, Australia,
 Netherlands, Republic of Korea
 

Data/MailingFullPostalCode
 

Mailing Full Postal Code
 

Full postal code as received by Dun
& Bradstreet Corporation.
 

Global
 

MetaData/MatchScore
 

Match Score
 

A score representing the likelihood
of a match between records.
 

Global
 

Data/CompanyDescription
 

Company Description
 

Narrative company description.
 

Global
 

Data/MarketableIndicator
 

Marketability Indicator
 

Indicates that the record satisfies
Dun & Bradstreet Corporation
global marketability rules.
 

Global
 

Data/GEOCodeAccuracy
 

GEO Code Accuracy
 

A code value that describes how
close the coordinates for a location
are to a rooftop level.
 

Global
 

Data/
SalesVolume(USDollars)Reliability
Code
 

Sales Volume (US Dollars)
Reliability Code
 

A code value that describes the
reliability of the annual sales/
revenue figure that is expressed in
US dollars.
 

Global
 

Data/SalesVolume(LocalCurrency)
 

Sales Volume US Dollars
 

The total annual sales revenue for
this business in local currency. Not
available on branch locations.
 

Global
 

Data/
SalesVolumeLocalCurrencyReliabilityCode
 

Sales Volume Local Currency
Reliability Code
 

A code value that describes the
reliability of the annual sales/
revenue figure that is expressed in
local currency.
 

Global
 

Data/
DomesticUltimateBusinessName
 

Domestic Ultimate Business Name
 

The primary name of the domestic
ultimate business.
 

Global
 

203



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 16
Account Data Enrichment and Verification

Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

Data/
DomesticUltimateFIPSCountryCode
 

Domestic Ultimate FIPS Country
Code
 

The Federal Information
Processing Standards code value
that identifies the country where
the domestic ultimate company is
located.
 

Global
 

Data/
DomesticUltimateD&BCountryCode
 

Domestic Ultimate D&B Code
 

Dun & Bradstreet Corporation
geographical code identifying
the country where the domestic
ultimate is located.
 

Global
 

Data/DomesticUltimateState/
ProvinceAbbreviation
 

Domestic Ultimate State Province
Abbreviation
 

The abbreviated name of the state
or province in which the domestic
ultimate is located.
 

Global
 

Data/GlobalUltimateBusinessName
 

Global Ultimate Business Name
 

The name of the ultimate
company.
 

Global
 

Data/GlobalUltimateIndicator
 

Global Ultimate Indicator
 

Indicates whether the site record is
the Global Ultimate D-U-N-S within
the corporate family tree.
 

Global
 

Data/
GlobalUltimateFIPSCountryCode
 

Domestic Ultimate FIPS Country
Code
 

The Federal Information
Processing Standards code value
that identifies the country where
the domestic ultimate company is
located.
 

Global
 

Data/
GlobalUltimateD&BCountryCode
 

Domestic Ultimate D&B Country
Code
 

Dun & Bradstreet Corporation
geographical code identifying
the country where the domestic
ultimate is located.
 

Global
 

Data/GlobalUltimateState/
ProvinceAbbreviation
 

Global Ultimate State Province
Abbreviation
 

The abbreviated name of the state
or province in which the global
ultimate is located.
 

Global
 

Data/HeadquarterDUNSNumber
 

Headquarter DUNS Number
 

The D-U-N-S number of the
headquarter organization. May
contain lead zeros, which will be
lost if field is treated as numeric.
 

Global
 

Data/Parent/
HeadquarterBusinessName
 

Parent Headquarters Business
Name
 

The primary name of the parent
headquarters company.
 

Global
 

Data/HierarchyCode
 

Hierarchy Code
 

A number used with the status and
subsidiary indicators to pinpoint
the location of an establishment
within a corporate hierarchy. The
hierarchy on the global ultimate is
'01'. A branch hierarchy is the same

Global
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

as its headquarters'. A subsidiary's
hierarchy is one more than its
parent's.
 

Data/NumberofFamilyMembers
 

Number of Family Members
 

The number of family members
including the global ultimate and
all subsidiaries and branches of the
entire family tree worldwide. All
family members within a particular
tree carry the same count.
 

Global
 

Data/OutofBusinessIndicator
 

Out of Business Indicator
 

Indicates that the business is out
of business or inactive based upon
D&B policies and procedures.
 

US only
 

Data/
OvertheCounterStockExchange
 

Over the Counter Stock Exchange
 

The symbol used to trade the
company's stock on the Over the
Counter Stock Exchange.
 

US only
 

Data/NYSEStockExchange
 

NYSE Stock Exchange
 

The symbol used to trade the
company's stock on the New York
Stock Exchange.
 

US only
 

Data/ASETicker
 

ASE Ticker
 

The symbol used to trade the
company's stock on the American
Stock Exchange.
 

US only
 

Data/NMSTicker
 

NMS Ticker
 

The symbol used to trade the
company's stock on the NASDAQ
National Market.
 

US only
 

Data/NASTicker
 

NAS Ticker
 

The symbol used to trade the
company's stock on the NASDAQ
Small Cap Exchange.
 

US only
 

Data/
OperatesFromResidenceIndicator
 

Operates From Residence Indicator
 

Operates From Residence Indicator
 

US only
 

Data/PrimaryCompetitor1
 

Primary Competitor 1
 

DUNS number of the company
deemed to be the primary
competitor for the business.
 

Global
 

Data/3YearGrowthPercentageonSalesVolume
 

3 Year Growth Percentage on Sales
Volume
 

The percentage increase or
decrease in the sales volume over
a three-year period. Includes a
plus (+) or minus (-) sign denoting
positive or negative growth in
sales.
 

US only
 

Data/3YearGrowthPercentageonEmployees
 

3 Year Growth Percentage on
Employees

The percentage increase or
decrease in the number of

US only
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

 employees over a three-year
period. Includes a plus (+) or
minus (-) sign denoting positive or
negative growth in sales.
 

Data/DeliquencyRisk
 

Delinquency Risk
 

Based on the standard Commercial
Credit Score, which predicts the
likelihood of a company becoming
severely delinquent over the next
12 months. Grouped into risk
ranges.
 

US only
 

Data/CensusFIPSTerritoryCode
 

Census FIPS Territory Code
 

The Federal Information
Processing Standards territory
code for where this subject is
located. These territory codes are
defined and developed by the
National Institute of Standards and
Technology (NIST) organization
within the US federal Department
of Commerce.
 

US only
 

Data/CensusFIPSCountyCode
 

Census FIPS Country Code
 

The Federal Information
Processing Standards county code
identifying the county where the
subject is located.
 

US only
 

Data/PrimaryCompetitor2
 

Primary Competitor 2
 

DUNS number of the company
deemed to be the second primary
competitor for the business.
 

Global
 

Data/PrimaryCompetitor3
 

Primary Competitor 3
 

DUNS number of the company
deemed to be the third primary
competitor for the business.
 

Global
 

Data/SecondaryCompetitor1
 

Secondary Competitor 1
 

DUNS number of the company
deemed to be the secondary
competitor for the business.
 

Global
 

Data/SecondaryCompetitor2
 

Secondary Competitor 2
 

DUNS number of the company
deemed to be the secondary
competitor for the business.
 

Global
 

Data/GlobalExchangeName
 

Global Exchange Name
 

The exchange where the stock
symbol is listed.
 

Global
 

Data/PrimaryIndicator
 

Primary Indicator
 

Indicates whether or not the ticker
is the primary one for the business.
 

Global
 

Data/NationalIdentificationCode
 

National Identification Code
 

A code value that describes
the type of national ID number

Global
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Oracle Account Enrichment
Attribute

Definition Description Geographical Availability

provided; for example, '12' = CRO,
 '14' = Siren.
 

Data/FIPSMSACode
 

FIPS MSA Code
 

The Federal Information
Processing Standards code value,
 which identifies the Metropolitan
Statistical Area (known as the MSA)
where this subject is located. These
MSA codes were defined and
developed by the National Institute
of Standards and Technology
(NIST) organization within the US
Federal Department of Commerce.
 

US only
 

Data/
ParentHeadquarterD&BCountryCode
 

Parent Headquarters D&B Country
Code
 

Dun & Bradstreet Corporation
geographical code identifying
the country where the parent
headquarters are located.
 

Global
 

Mapped Contact Fields
You can expose any of the fields listed in the table in the contact pages using the display name. Long field names
aren't always completely visible in Application Composer, but you can hover over a display name to see the underlying
technical name.

The table lists the name of the attribute on the mapping page in the first column, and provides a brief definition and
description. The Contact Field Display Name field lists the display name in the UI and in Application Composer. The
Contact Field Name lists the technical name. The names don't always match.

Oracle Contact
Enrichment Attribute

Definition Description Contact Field Display
Name

Contact Field Name

Data/DataCloudStatus
 

Data Cloud Status
 

The status of the record.
Example: Matched.
 

Enrichment Status
 

DataCloudStatus
 

Data/
PersonPreNameAdjunct
 

Prefix
 

The prefix (Mr., Ms.,
 Dr.) associated with the
person's name.
 

Prefix
 

PersonPreNameAdjunct
 

Data/PersonFirstName
 

First Name
 

The first name of the
person.
 

First Name
 

PersonFirstName
 

Data/PersonMiddleName
 

Middle Name
 

The middle name of the
person.
 

Middle Name
 

PersonMiddleName
 

Data/PersonLastName
 

Last Name
 

The last name of the
person.
 

Last Name
 

PersonLastName
 

Data/JobTitle
 

Title
 

The title associated with
the person's role. This is the

Job Title
 

JobTitle
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Oracle Contact
Enrichment Attribute

Definition Description Contact Field Display
Name

Contact Field Name

title as it would read on a
person's business card.
 

Data/PersonNameSuffix
 

Suffix
 

The last name suffix of the
person.
 

Suffix
 

PersonNameSuffix
 

Data/Address1
 

Street Address 1
 

The first street address
line where a business
is physically located.
Generally in local language.
 

Address Line 1
 

PrimaryAddressLine1
 

Data/City
 

City
 

City where the business is
located. Generally in local
language.
 

City
 

PrimaryAddressCity
 

Data/State
 

State
 

The abbreviation for the
physical state or province
name where the business is
located.
 

State
 

PrimaryAddressState
 

Data/PostalCode
 

OSC Postal Code
 

The 5-digit postal code
where the business is
physically located.
 

Postal Code
 

PrimaryAddressPostalCode
 

Data/Country
 

Country
 

The 2-byte alpha character
ISO code for the country
where the business is
located.
 

Country
 

PrimaryAddressCountry
 

Data/
PhoneRawPhoneNumber
 

Direct Dial Phone
 

The direct-dial phone
number associated with
this person in this role. It
includes country code, area
code and phone number.
 

Phone Number
 

PrimaryFormattedPhoneNumber
 

Data/CompanyPhone
 

Company Phone
 

The company phone
number at which the
professional can be
reached (for current role
assignments).
 

Phone Number
 

PrimaryPhoneNumber
 

Data/PhoneExtension
 

Company Phone Extension
 

This is the phone extension
associated with the
company phone number
indicated on this record.
 

Phone Extension
 

PrimaryPhoneExtension
 

Data/EmailAddress
 

Email Address
 

The main email address
associated with this
person's role or contact
record.
 

Email
 

Email
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Oracle Contact
Enrichment Attribute

Definition Description Contact Field Display
Name

Contact Field Name

Data/Department
Department
 

Department
 

A division of a large
organization such as
Executive, Administration,
 and so on.
 

Department
 

Department
 

Unmapped Contact Fields
You must create a text or a number field for these attributes and add them to the mapping before you can expose the
field in the contact pages.

The table lists the name of the attribute on the mapping page in the first column, and provides a brief definition and
description. The Geographical Availability column indicates if the attribute is available for all countries or just a subset.

Oracle Contact Enrichment Cloud
Service Attribute

Definition Description Geographical Availability

Data/FullPostalCode
 

Full Postal Code
 

Full postal code as received by Dun
& Bradstreet Corporation.
 

Global
 

DataDUNSNumber
 

DUNS Number
 

The D-U-N-S number of the
business location.
 

Global
 

Data/IndividualID
 

Individual ID
 

The unique identifier of the
professional.
 

US only
 

Data/RoleID
 

Role ID
 

Unique identifier of the
professional's job at a particular
DUNS location.
 

US only
 

Data/LastUpdateDateRole
 

Last Update Date Role
 

The date any of the role data was
last updated.
 

Global
 

Data/ManagementLevel
 

Management Level
 

Level of management; for example,
C-Level, VP-Level, and so on.
 

Global
 

Data/StandardizedTitle
 

Standardized Title
 

A business title derived from the
Management Responsibility Code,
 which identifies a title or area of
responsibility of an executive.
 

Global
 

MetaData/MatchScore
 

Match Score
 

A score representing the likelihood
of a match between records.
 

Global
 

Data/Location
 

Location
 

Address information for individual.
 

US only
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Create the Fields for Any Unmapped Information  
Here's an outline of how you can create text and number fields for any of the unmapped information that you want
to display in the UI. You can get more details about creating fields in the Oracle Applications Cloud Configuring
Applications Using Application Composer guide.

1. Ensure that you're working in a sandbox.
2. Click Navigator >  Configuration >  Application Composer.
3. Make sure CRM Cloud is selected in the Application field and expand Standard Objects.
4. Expand Account or Contact.
5. Click Fields.
6. In the Custom tab, click the Create a custom field icon.
7. Select Text or Number and click OK.

◦ Here are the guidelines for creating a text field:

Property Description

Display Label
 

Enter the text users see.
 

Display Width
 

Character width for the text field. The default is 30.
 

Display Type
 

Determines the type of text field displayed to the users. You can choose Simple Text Box
that is a single-line text field, or Multiline Text Area, a larger text area that spans multiple
lines.
 

Name
 

The unique identifier for the field that you add to the mapping. The application enters a
name for you, but it's a good idea to change the name to match the field you're mapping.
 

Description
 

Optional description of the object. This field is used for internal purposes.
 

Required
 

Leave deselected. The field isn't required.
 

Updatable
 

Leave selected.
 

Searchable
 

Indicates whether to make the field available for selection as additional search criteria in
the Add Fields list in Advanced Search mode.
 

Depends On
 

Leave blank.
 

Fixed Value Leave selected and blank.
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Property Description

  

◦ Here are the guidelines for creating a number field:

Property Description

Display Label
 

Enter the text users see.
 

Display Width
 

Leave blank.
 

Name
 

The unique identifier for the field that you add to the mapping. The application enters a
name for you, but it's a good idea to change the name to match the field you're mapping.
 

Description
 

Optional description of the object. This field is used for internal purposes.
 

Required
 

Leave deselected. The field isn't required.
 

Updatable
 

Leave selected.
 

Searchable
 

Indicates whether to make the field available for selection as additional search criteria in
the Add Fields list in Advanced Search mode.
 

Indexed
 

Indexing a field for search improves search performance.
 

Maximum Length
 

Leave the default value.
 

Minimum Value
 

Leave blank.
 

Decimal Places
 

Leave at 0.
 

Depends On
 

Leave blank.
 

Fixed Value
 

Leave selected and blank.
 

8. Click Save and Close.
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Add Enriched Fields to the Account and Contact Pages  
Here's how to add enriched fields to the Profile tab in the Edit Account and Edit Contact pages in Classic Sales. You can
use the same process to add the fields to other Classic Sales pages as well.

If you're adding the fields to the Sales for Redwood UIs, then you must use VB Studio instead of Application Composer
and follow the example topic, "Add a Custom Field to the Edit Contact Page", in the Oracle Fusion Cloud Sales
Automation Extending Sales for Redwood.

1. Create and activate a sandbox.
2. Navigate to Configuration > Application Composer.
3. With the Account or Contact object selected in Application Composer, click Pages.
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4. Expose the field on the Profile tab on the Edit Account or Edit Account page.

Note:  The "Edit" pages are called "Details" pages in Application Composer.

a. Scroll to locate the Details Page Layouts and open a custom layout or create one by duplicating the
default layout.

b. Click the Profile subtab (callout 1 in the screenshot).
c. In the Summary Subtab section, click Edit (callout 2).

d. Scroll down in the Available Fields column to locate the field and move it to the Selected Fields column.
e. Use the arrow buttons to move the field where you want it
f. Click Save and Close.

You are returned to the Layout page, which reflects your changes.
g. Click Done.

You are returned to the Application Composer page.
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5. Review the pages where you added the fields:

a. With the sandbox still open, click Home.
b. Open the Account or Contact work area.
c. Review each of the pages to make sure the fields are where you want them.

6. Publish the sandbox.

Add Fields to the Mapping  
Here's how to add fields to the mapping:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Sales

◦ Functional Area: Accounts and Contacts

◦ Show: All Tasks

◦ Task: Manage Oracle Data as a Service Attribute Mapping and Preferences

2. Click the Attribute Mappings tab.

On the Attribute Mappings tab, there are two sections: Account Attributes and Contact Attributes.
3. In the appropriate section, find the field you want to map in the Social Data Cloud and Insight Attribute

column.

4. In the Sales Cloud Object column, select Account from the list.
5. In the Sales Cloud Attribute column, select the sales field you want to map.
6. When you complete mapping all of the fields, click Save and Close.
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Configure Enrichment Preferences  
Specify if you want to enable enrichment of accounts, contacts, or both, and configure enrichment preferences to define
what data is updated in an enriched account or contact.

CAUTION:  Ensure that you configure attribute mappings before you start configuring enrichment preferences.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Oracle Data as a Service Attribute Mapping and

Preferences and open it.

This page includes two tabs, one for accounts and another one for contacts. You can use these to enable
enrichment for accounts and contacts, and configure the data that should be included in the enriched account.

3. Select Account or Contact to enable enrichment for accounts or contacts, respectively.
4. Enter a match threshold for accounts and contacts in the Match Threshold field.
5. Enter the maximum number of records that should be enriched in the Maximum Number of Accounts for

Real-Time Enrichment and Maximum Number of Contacts for Real-Time Enrichment fields.
6. In case of contact enrichment, enter the maximum number of new contacts to create during enrichment in the

Maximum Number of New Contacts field.
7. Map the source attributes with the required sales attribute. You can also select preferences for each attribute.

For example, you can set an attribute to be displayed during real-time enrichment. Note that the preferences
aren't available for child fields.

Note:  Click Reset to revert back to the default mapping and preferences.

8. Click Save and Close
If you have a preproduction or staging environment, then test the service association between your sales preproduction
environment and your Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) subscription. You must limit
testing to 500 records. When you go to production, do the service association between your production environments
and your Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) production environment. The service
association steps are the same, but the test and production service URLs are different. The service URLs are listed in
your welcome email and in the Unified Console application.
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17  Computer Telephony Integration (CTI)

Overview of Computer Telephony Integration (CTI) in
Sales for Redwood  
Computer telephony integration (CTI) enables integration of third party media toolbars. You can display a media toolbar
by enabling the Partner CTI Service, and by giving your signed-in users the Access Partner Media Toolbar privilege
which allows access to the toolbar.

Note:  If your users have the standard Sales job roles, you don't need to add the Access Partner Media Toolbar
privilege.

Use CTI to:

• Receive phone calls on the Sales for Redwood app and automatically view the caller's contact record or lead
record.

• Make an outbound call using Click to Dial and skip manual dialing.

Integrating with CTI gives you the following features:

• Notifications of incoming calls and ability to accept or reject the call

• Automatic caller identification

• Ability to search for a contact

• Optional caller verification

• Display of predefined screen pop with caller or service details

• Automatic interaction recording

• Call wrap up

Prerequisite Setup  
First ensure that the Service offering is enabled, and then that the Redwood user interface is enabled. You enable the
Redwood user interface through the Service application whether you're using Sales or Service Center.

1. Sign in to Sales or Service as an administrator or setup user.
2. Navigate to My Enterprise > Offerings.
3. Click the Opt In Features button.
4. From the Opt In: Service screen, locate the Redwood User Interface for Service option and make sure that it's

enabled.
5. Verify all the child items are also enabled.
6. Click Done on the Opt In page, then click Done again.
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How do I configure profile options to enable the Partner
Media toolbar  
The profile option SVC_PARTNER_MEDIA_TOOLBAR_ENABLED controls the visibility of the partner media toolbar. If
you don't enable the profile option, the partner media toolbar is hidden. You can set this profile option either at a site
level or at a user level.

To configure the profile options for enabling the partner media toolbar:

1. Navigate to the Setup and Maintenance work area and open the Tasks panel tab.
2. Click Search from the list of displayed tasks.
3. In the Search field, type Manage Admin.
4. From the displayed list of tasks, click Manage Administrator Profile Values.
5. In the Manage Administrator Profile Values page, navigate to the Search: Profile Option region.
6. In the Profile Option Code field, type SVC_PARTNER_MEDIA_TOOLBAR_ENABLED.
7. Click Search.

The Search Results: Profile Options region displays the list of profile options.
8. In the Profile Values region, specify the values in the Profile Value column for the Site Profile Level to 'Yes' if

you want the partner media toolbar to be visible to all users.
9. Alternatively, set the Site level value to 'No' and add a new row for a user for whom the partner media toolbar

must be visible.
10. Click Save and Close.

Note:  Ensure that the user is assigned the privilege Access Partner Media Toolbar
(SVC_ACCESS_PARTNER_MEDIA_TOOLBAR_PRIV) before trying to access the toolbar.

How do I configure Multichannel Architecture (MCA)
profile options?  
Profile options let you configure and control application data centrally. Use the Multichannel Architecture (MCA) profile
options to manage the MCA runtime profile option values. Administrators and setup users manage MCA profile options
in the Setup and Maintenance work area.

To configure the MCA Profile Options:

1. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Communication Channels

◦ Task: Manage MCA Profile Options

2. Click the name of the profile option you want to set.
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This displays the Manage MCA Profile Options page for the selected profile option code.
3. In the Profile Values section for the profile option code, set the Profile Value for the Site Profile Level.
4. In the selected profile value, click the New icon to add a profile value.
5. Click Save or Save and Close to save the configuration.

MCA Profile Options
The following table lists the various MCA profile options that you can configure:

Profile Option Description

SVC_MCA_DISABLE_JWT
 

Enables or disables the JSON Web Token generation.
 

SVC_MCA_DISABLE_OUTBOUND_
CONTACT_VERIFY
 

Enables or Disables automatic display of contact verification screen for outbound calls. If enabled, it will
override the call flow parameter configurations.
 

SVC_MCA_DISABLE_OUTBOUND_WRAP_
UP
 

Enables or disables automatic display of the wrap-up screen for outbound calls. If enabled, it will
override the call flow parameter configurations for wrap up.
 

Note:
For Sales for Redwood implementations, this setting must be enabled.
 

SVC_MCA_ENABLE_ENGAGEMENT_SYNC Controls the in-focus chat interactions to be automatically associated with their screen popped tabs.

SVC_MCA_RECORD_ACTIVITIES_YN
 

Indicates whether activities must be logged for real time interactions.

Note:  For Sales for Redwood implementations, this setting must always be disabled (set to No).

 

SVC_MCA_RT_CHECK_EVENT_DISPATCH_
INTERNAL_MS
 

Sets the number of milliseconds the user must wait for the start communication event. We recommend
that you don't change this value unless instructed by Oracle Support.
 

SVC_MCA_RT_EVENT_DISPATCH_MAX_
RETRIES
 

Sets the number of times the user must wait for reverse lookup to return before running the start
communication event. We recommend that you don't change this value unless instructed by Oracle
Support.
 

SVC_MCA_SHOW_CONTACT_ON_WRAP_
UP

Indicates whether to show the contact information during the wrap up process.

SVC_OVERRIDE_PARTNER_TOOLBAR_
SELECTION

This option allows user to override system default setting of the partner media toolbar. User can select
other toolbars from the list of active toolbars.

SVC_OVERRIDE_PARTNER_TOOLBAR_
SELECTION
 

Enables the administrator to override the default setting of the partner media toolbar. The
administrator can select other toolbars from the list of active toolbars.
 

SVC_PARTNER_MEDIA_TOOLBAR_
ENABLED
 

Controls the visibility of the partner media toolbar. If it's not enabled, the partner media toolbar is
hidden.
 

SVC_TOOLBAR_DEBUG_MODE_ENABLED
 

Turns on the JavaScript logging messages for debugging toolbar-related issues.
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CTI Media Toolbar APIs  
Media toolbar APIs are a set of JavaScript functions delivered by Oracle to enable Computer Telephony Integration (CTI)
partners to integrate their media toolbars with your application.

For information on the media toolbar APIs including details on each available API, see the Related Topics for the CTI
Media Toolbar APIs topic in the Implementing Fusion Service guide.

Related Topics
• Overview of the Media Toolbar API

Create a CTI Toolbar for Redwood  
Use this task to add a new Redwood toolbar.

1. Sign in as an administrator or setup user.
2. In the Setup and Maintenance work area, choose the following:

◦ Offering: Service.

◦ Functional Area: Communication Channels.

◦ Task: Manage Media Toolbar Configuration.

3. In the Manage Media Toolbar Configuration screen, click the Add (+) icon.
4. In the Toolbar work area, do the following:

◦ Name: Redwood Toolbar.

◦ Layout: Redwood

◦ Communication Panel URL: Paste the appropriate URL.

5. In the Manage Media Toolbar Configuration list, make sure the Default column entry is checked.
6. Click Save and Close.

Assign the CTI Toolbar
You can enable the toolbar at site level, meaning it's available to all your users, or you can assign the toolbar to just
specific users.

1. In the Setup and Maintenance work area, click the Tasks icon, and then click the Search link.
2. Enter Manage Administrator Profile Values in the Search box and click Search.
3. Click the task link, and then in the Manage Administrator Profile Values work area, enter the following search

string in the Profile Display name field: %Partner%.
4. In the Search results field you have two choices depending on how you want to assign the toolbar.
5. To enable the toolbar at the site level, do the following:

a. Locate and select SVC_PARTNER_MEDIA_TOOLBAR_ENABLED profile option.
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b. If there's a Site Profile Level entry, make sure the Profile Value is set to Yes. To disable the toolbar at the
site level, set that value to No.

c. If there's no Site entry, click the Add (+) icon, and from the Profile Level drop down list, select Site, and
then from the Profile Value drop down list, select Yes.

6. To enable the toolbar only for specific users, do the following:
a. First, make sure the Site Profile Level value is set to No.
b. Then, click the Add (+) icon, and from Profile Level drop down list, and select User.
c. And finally, in the User Name field, enter the user's name.

7. When finished, click Save and Close.

Call Flow Parameter Settings  
The call flow parameters determine the default and administrator-defined actions to be performed for a customer
interaction. Customer interactions are calls with the customer in Sales for Redwood and calls or chats in Service Center.
Administrator-defined settings override the default settings.

You can specify the settings listed in the following table:

Setting Options Description

Contact Required
 

Yes/No
 

Specifies whether the contact details of a
customer must be displayed.

Note:  For Sales for Redwood
implementations, you must select No.

Select No if you're using Sales for Redwood.
 

Contact Verification
 

Yes/No
 

Specifies whether the customer details must be
verified at the beginning of the call.
 

Note:  For Sales for Redwood
implementations, you must select No.

 

Screen Pop
 

Yes/No
 

Specifies whether a screen pop page must be
displayed. Select Yes.
 

Wrap Up
 

Yes/No/Server Driven
 

Specifies whether a customer interaction
requires wrap up. Select the Server Driven
option to get notified by the toolbar if an
interaction must be wrapped up.
 

Note:
For Sales for Redwood implementations, this
setting must always be enabled.
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Deactivate Contact Verification
Contact verification allows a user to verify a caller against records already set up in the database prior to the exchange
of sensitive information. In Sales for Redwood however, most inbound calls are related to sales opportunities where, for
instance, a new lead may be calling about an inquiry. Given that the majority of calls are of this type, call verification isn't
required.

1. Sign in to the application as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:

◦ Offering: Service

◦ Functional Area: Communication Channels

◦ Task: Configure Call Flow Parameters

3. In the Default Settings work area, click the following drop-down lists, and change the value of both to No.

◦ Contact Required

◦ Contact Verification

4. Click Save and Close.

Configure Seeded Interaction Outcome Values  
By default, Interaction outcome values, such as Call answered, Positive outcome, include values that pertain both to
Service users and to Sales users. To configure the list to show only outcomes valid to a Sales user, perform the following
task.

1. Sign in to CX Sales as an administrator or setup user.
2. In the Setup and Maintenance work area, and choose Sales from the Setup drop-down list.
3. Click the Tasks icon, then select Search.
4. In the Search field, enter Manage Standard Lookups, and click the task link in the results.
5. In the Manage Standard Lookups work area, enter ORA_SVC_MCA_RESOLUTION_CD in the Lookup Type field,

then click Search.
6. Uncheck all values you don't want your users to see.
7. When you’re finished, click Save and Close.
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18  Oracle Digital Assistant

Language Processing Using Oracle Digital Assistant  
Sales features that require natural language processing, including sales recommendations, Ask Oracle bar filtering,
and the Sales Assistant chatbot, rely on the Oracle Digital Assistant (ODA) platform. Here's a brief overview of concepts
that will help you complete the required basic ODA setup and integrate the different sales features. Refer to the ODA
documentation to understand the full capabilities of the platform. At present, natural language processing is available
for English only.

Here's an architecture overview:

1. Oracle Digital Assistant (ODA) is a platform that's used to create chatbots and to provide natural language
processing for other applications and features.

2. Different domains, such as sales, service, and financials, require different sets of language skills. Oracle
provides some skills as stand-alone components. It builds others into digital assistants. You can install both in
your ODA application instance from the ODA "store".

3. For all Oracle cloud application chatbots, including the Sales Assistant, and for filtering activities, you install
(the term used is "pull") the FADigitalAssistant digital assistant.

4. FADigitalAssistant includes multiple chatbot skills, including CX Sales, Help Desk and HCM Knowledge. For
sales, you're using only the CX Sales skill.

5. For the Recommendations feature in both the Sales for Redwood UI and in CX Sales Mobile,, you install ("pull")
the CX Text Analyzer skill.

6. For each sales feature that uses natural language processing, you create a separate channel. There are different
types of channels for different uses.

◦ For sales recommendations (handled by the CX Text Analyzer skill) in both the Sales for Redwood UI and
in CX Sales Mobile, you create the Webhook channel. The Sales Recommendations feature analyzes the
text of call logs and notes salespeople enter to recommend what action to take.

◦ For the CX Sales skill in FADigital Assistant, different channels handle different applications:
- To enable natural language filtering of activities, you create an Oracle Web channel.
- To enable the Sales Assistant chatbot in CX Sales Mobile, you create Oracle Web channel. You can

use the same Oracle Web channel for both activities filtering and Sales Assistant.
- To enable the Sales Assistant chatbot for Microsoft Teams in CX Sales Mobile, you create a

Microsoft Teams channel.
7. After you create and activate a channel, you copy over identifying information from the channel to the sales

application to complete the link. You can learn how to create the channel for each feature and how to create the
link by reviewing the documentation for the feature.

Here's a visual overview of the integration between Sales and the Oracle Digital Assistant platform:

Oracle Digital Assistant Integration Elements

Callout Description

1 Oracle Digital Assistant (ODA) is a platform that's used to create chatbots and to provide natural
language processing for other applications and features. It bundles others into digital assistants You
can install both in your ODA application instance from the ODA "store".
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Callout Description

2 Different domains, such as sales, service, and financials, require different sets of language skills. Oracle
provides some skills as stand-alone components. Others are bundled into digital assistants.

3 For Sales, you use the CX Text Analyzer skill set for the Sales Recommendation feature.

4 For activities filtering and for the Sales Assistant chatbot in CX Sales Mobile and Microsoft Teams, you
use the FADigitalAssistant.

5 You connect the skills in ODA to the sales application, by creating different types of channels.

6 You copy the identifying information in a channel.

7 And enter it in the Sales Application. How you enter the information varies depending on the channel.
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Related Topics
• Getting Started with Oracle Digital Assistant for Cloud Applications.

Overview of Common ODA Setup for Sales  
Here's an overview of the basic Oracle Digital Assistant setup that you must complete for sales features that use natural
language processing, including sales recommendations and the Sales Assistant chatbot used with Oracle CX Sales
Mobile and Microsoft Teams.

Step Setup Task Application Description Where to Get More Details

1
 

Enable a user to administer
the Oracle Digital Assistant
application.
 

Oracle Identity Cloud
Service (IDCS)

In IDCS, you must provide
the user setting up the
sales feature with the ability
to administer the Oracle
Digital Assistant (ODA)
platform.
 
This one-time setup
involves importing sales
users into IDCS, and
assigning the Service
Administrator role to the
user doing the setup in
ODA.
 
You must have the Identity
Domain Administrator role
to complete this step.

See the topic: Enable Users
to Administer Oracle Digital
Assistant.
 
For additional information,
 see the Oracle Digital
Assistant documentation:
Getting Started with Oracle
Digital Assistant for Cloud
Applications.
 

2
 

Copy the URL for the Oracle
Digital Assistant (ODA) for
your use in setup.
 

Oracle Identity Cloud
Service (IDCS)

You can obtain the URL to
access the ODA platform UI
during your IDCS setup.
 
Just copy the URL from
the idcs-oda application
Configuration tab,
Resources section, Primary
Audience field.
 
This step is optional. After
you opt in to the Digital
Assistant feature in your
sales application (step 3),
 you can also access the
ODA platform UI directly
from the sales application
through the Manage Digital
Assistant setup task.
 

See the topic: Obtain the
Oracle Digital Assistant URL
 

3 Opt in to the Digital
Assistant feature.

Sales application Opt in to the Digital
Assistant feature. This is a
one-time setup.
 

See the topic: Opt in to
Oracle Digital Assistant
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Step Setup Task Application Description Where to Get More Details

After you do so, you can
access the ODA platform
UI directly from Setup
and Maintenance in the
Sales application using the
Manage Digital Assistant
setup task.
 

4 Install the Digital Assistant
for Fusion Applications
(FADigitalAssistant)
provided by Oracle.

Oracle Digital Assistant In the ODA platform, you
must pull (install) the
FADigitalAssistant and the
CX Text Analyzer from the
application's skill store.
 
The FADigitalAssistant
includes the CX Sales skill
that's required for activities
filtering and the Sales
Assistant chatbot in the CX
Sales Mobile and Microsoft
Teams applications.
 
The CX Text Analyzer
digital assistant is
required for the Sales
Recommendations feature.
 

See the topic: Install the
Digital Assistants
 

5 Create channels for the
features that use natural
language processing and
hook them up to Sales.

Use Oracle Digital Assistant
for the channel creation.

How you create the
channels and how you hook
them up depends on the
feature.
 
Follow the setup
instructions in the chapters
covering different features.
 

See the topics:
 

• Overview of Sales
Recommendations
Setup

• Overview of Natural-
Language Filtering
Setup for Activities

• Set Up Oracle Sales
Assistant for CX Sales
Mobile

• Set Up Oracle Sales
Assistant for Microsoft
Teams

6 Periodically update the
FADigitalAssistant and
CX Text Analyzer digital
assistants.

Oracle Digital Assistant FADigitalAssistant and the
CX Text Analyzer digital
assistants are updated
every release and three
times within each release.
You should periodically
update both to the latest
version.

See the topic: Refresh the
Digital Assistants
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Enable Users to Administer Oracle Digital Assistant  
Before you can set up the integration with the Oracle Digital Assistant (ODA) platform, you must grant one or more
users the appropriate permission in the Oracle Identity Cloud Service.

Here's how:

• Import the users from your sales application into the Oracle Identity Cloud Service (IDCS).

Although you only need one user to perform the integration and administer the service, you must import all of
them.

• Assign the Service Administrator Role to the user who will be doing the ODA integration.

Import Sales Users into IDCS
1. Sign in to Oracle Identity Cloud Service.
2. To import the users, enable user synchronization:

a. Click Navigator > Oracle Cloud Services
b. Search for and select the Oracle Applications Cloud instance.
c. Click the Provisioning tab.
d. Turn on Enable Provisioning.
e. In the Select Provisioning Operations section of the page, select the Authoritative Sync check box.
f. Turn on Enable Synchronization.

g. Click Save.
3. Verify that the users are available and synchronized in the application:

a. Click the Users tab.
b. Check whether the users are available in the application. If they're not, import the users:

i. Click the Import tab.
ii. Click Import.

Assign the Service Administrator Role to the User Performing the
Integration

1. While signed in to the Oracle Identity Cloud Service, click Navigator > Oracle Cloud Services.
2. Search for the application name that starts with idcs-oda.
3. Open the application.
4. Click the Applications Roles tab.
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5. Select the Service Administrator role (callout 1 in the screenshot) and click the corresponding menu item
(callout 2).

6. From the menu, select Assign Users.
7. Search for the user you want to assign.
8. Select the user and click OK.

Obtain the Oracle Digital Assistant URL  
Here's how to obtain the URL that you can use to access to the Oracle Digital Assistant platform for setup.

1. While signed in to the Oracle Identity Cloud Service (IDCS), click Navigator > Oracle Cloud Services (callout 1 in
the screenshot).

2. Search for the application name that starts with idcs-oda (callout 2).
3. Click to open the application (callout 3). 

4. Click the Configuration  tab (callout 1 in the following screenshot).
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5. Expand the Resources section (callout 2). 

6. Copy the URL from the Primary Audience field (highlighted in the following screenshot) 

Install the Digital Assistants  
To enable the integration, you must pull the FADigital Assistant and the CX Text Analyzer digital assistants from the
Oracle Digital Assistant platform store. The FADigitalAssistant includes the CX Sales skill that's required for activities
filtering and the Sales Assistant chatbot in the CX Sales Mobile and Microsoft Teams applications. The CX Text Analyzer
digital assistant is required for the Sales Recommendations feature.

.
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1. Sign in to Oracle Digital Assistant as the user granted the administrative privilege.
2. Click the Navigator.
3. Expand the Development menu item.
4. Click Store (callout 1 in the screenshot).
5. In the Skill Store, search for either FADigitalAssistant or CX Text Analyzer.
6. Locate the version that corresponds to your application release, the first four digits of the version number.

For example, Version 22.04.30 corresponds to applications version 22A. The last two digits show the
FADigitalAssistant version. To see all available versions, click Display all versions of this skill (the square icons)
next to the Actions menu.

7. Click Actions (three vertical dots highlighted by callout 3) and select Pull (callout 4). 

Opt in to Oracle Digital Assistant  
You must opt in to the Digital Assistant feature. Opting in enables the Digital Assistant functional area in the Sales
offering. You can then open Oracle Digital Assistant directly from the sales application using the Manage Digital
Assistant setup task.

1. Navigate to the Setup and Maintenance work area and select the Sales offering.
2. In the Functional Areas pane, click Change Feature Opt In.
3. Enable the Digital Assistant functional area by selecting the check box.
4. Click Done.
5. From now on, you can open the Oracle Digital Assistant from the Sales offering:

a. In the Functional Areas pane, click Digital Assistant.
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b. In the Task  pane, click the Manage Digital Assistant  task.

Refresh the Digital Assistants  
Oracle updates both digital assistants used in Sales (FADigitalAssistant and the CX Text Analyzer) once very release and
multiple times between releases. To get the full benefit of the feature, you must ensure that you have the latest version
that corresponds to your sales application version.

Here's how to get the latest updates:

1. Sign in to Oracle Digital Assistant as the user granted the administrative privilege.
2. Click the Navigator.
3. Expand the Development menu item.
4. Click Store (callout 1 in the screenshot).
5. In the Skill Store, search for FADigitalAssistant or CX Text Analyzer.
6. Locate the version that corresponds to your application version. The first four digits of the version number

correspond to the release. For example, Version 22.04.33 (callout 1 in the following screenshot) corresponds to
applications version 22A. The last two digits show the FADigitalAssistant version.

7. Click Display all versions of this skill (callout 2 in the screenshot).

8. Find the latest version for your release (the highest number) (callout 1 in the following screenshot).
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9. Click Actions (three vertical dots highlighted by callout 2) and select Pull (callout 3).

10. Now select the refreshed skill in the channel:
a. Click Channels.
b. Select the channel to refresh the skill in the list of channels.

Note:
- For Oracle Sales Assistant for Microsoft Teams, configure the Microsoft

Teams channel. See Set Up Oracle Sales Assistant for Microsoft Teams in the
Implementation Reference guide for more information.

- For CX Sales Mobile, configure the Oracle Web Channel. See the topic Enable Sales
Assistant for CX Sales Mobile.

c. In the Route to field, select the new skill version.
d. In the Change Channel Routing dialog, click Change.
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19  Sales Recommendations

Recommended Actions from Text Analysis  
When you enable sales recommendations, the application analyzes the English-language text in notes and call logs
and recommends appropriate follow-up actions. An action can be to create a task, an appointment, or a contact,
depending on the text that was entered. The recommendations appear at the top of the Activities panel and page where
salespeople can either accept or dismiss them. You can enable the same sales recommendations you set up here for CX
Sales Mobile with minimal additional setup. At present, the sales recommendations feature and other natural-language
processing features are available in English only.

Suppose, for example, that a salesperson enters "asked for a meeting next Tuesday at 11" in a call wrap-up and saves.
Based on the text, the application suggests the creation of an appointment.

This screenshot shows the recommended appointment viewed in the Activities page in Sales for Redwood. The CX
Sales Mobile app works very much the same way.

• The recommendation (callout 2)

• The text on which it was based (callout 1)

Salespeople can either create the appointment or click Dismiss to reject the recommendation and remove it from view.
The application schedules the appointment at the time specified in the text and in the salesperson's time zone. The
appointment includes the relevant text from the call wrap-up.
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When enabled, this feature replaces the automatic creation of a task after call wrap ups.

Multiple Recommendations
If salespeople receive multiple recommendations either, they can review and act on them one by one either on the
Activities pane or page by clicking the View Details link.

Here's a screenshot of the Activities panel on a lead listing two sample recommendations. The View Details link is
highlighted.

Oracle Digital Assistant and Sales Recommendations  
Sales recommendations use the text analysis features of Oracle Digital Assistant (ODA). Here's a brief overview of the
different features and concepts that will help you in your integration.

Overview of the Oracle Digital Assistant Integration for Sales Recommendations

Callout Description

1 Oracle Digital Assistant (ODA) is a platform that's used to create chatbots and to provide language
analysis for other applications and features. ODA is used not only by the sales recommendations
feature, but also by CX Sales Mobile, and the integration with Microsoft Teams, for example.
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Callout Description

2 Different domains, such as sales, service, and financials, require different sets of language skills. Oracle
bundles some of these predefined skills into digital assistants, such as FADigital Assistant. Others are
available as stand-alone skills. You install both types in your ODA application instance from the ODA
"store". For sales recommendations, you install (the term used is "pull") the CX Text Analyzer skill.

3 Applications integrate with the different skills through channels of different types. To integrate the CX
Text Analyzer skill with the sales recommendations feature, you create a channel of type Webhook and
associate the CX Text Analyzer skill to it.

4 After you create and activate the channel, you copy its Webhook URL and secret key.

5 To link the channel to the sales application, you enter the Webhook URL and secret key into Application
Composer (Oracle Sales Assistant Setup, Configure Text Analysis tab).
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Overview of Sales Recommendations Setup  
Sales for Redwood uses the natural language processing capabilities of the Oracle Digital Assistant (ODA) to analyze
the text of notes and tasks. This guide covers only the steps to enable the Sales Recommendations feature using the
Sales skill in ODA provided by Oracle. For information on creating skills and other ODA features, you must follow the
instructions in the Getting Started with Oracle Digital Assistant for Cloud Applications.

Note:  Sales recommendations from Sales Insights and Opportunity next best action are also available as part of
central recommendations.

Here's an overview of the setup tasks.

Step Setup Task Application Description Where to Get More Details

1
 

Complete the prerequisite
Oracle Digital Assistant
application setup.
 

Oracle Identity Cloud
Service (IDCS)

Before you set up any
of the features that
use natural-language
processing, you must
perform some prerequisite
setup of Oracle Digital
Assistant:

• Set up administrator
users

• Obtain the ODA URL

• Install (pull) the CX
Text Analyzer skill

• Enable the Digital
Assistant used for
Oracle Fusion Cloud
Applications

 
If you already completed
the setup for another
feature, you can skip this
step.

See the topic: Overview of
Common ODA Setup for
Sales.
 
For additional information,
 see the Oracle Digital
Assistant documentation:
Getting Started with Oracle
Digital Assistant for Cloud
Applications.
 

2
 

Create the Webhook
channel to sales
 

Oracle Digital Assistant Create the Webhook
channel that enables the
analysis of sales text.
 
After you create the
channel, you copy the
Webhook URL and secret
key for use in the next step.
 

See the topic: Create a
Webhook Channel
 

3 Associate the Webhook
channel that you created to
the sales application.

Sales application Enter the Webhook
URL and secret key in
Application Composer (
Application Composer > 
Common Setup >  Oracle
Sales Assistant Setup >
Configure Text Analysis).

See the topic: Associate
the Webhook Channel
to Sales and Specify
Recommendation Options
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Step Setup Task Application Description Where to Get More Details

You then enable text
analysis, and disable any
fields you don't want
analyzed.
 

4 Enable Recommendations Sales application Opt in to the Sales
Recommendations feature.

See the topic: Enable Sales
Recommendations
 

Create a Webhook Channel  
Create a Webhook channel so that the meeting notes can be sent to Oracle Digital Assistant for text analysis.

1. Navigate to the Setup and Maintenance work area and select the Sales offering.
2. In the Functional Areas pane, click Digital Assistant.
3. In the Task  pane, click the Manage Digital Assistant  task.
4. On the Oracle Digital Assistant home page, click the Navigator (the hamburger menu highlighted by callout 1).

5. Expand the Development menu item (callout 2).
6. Click Channels (callout 3).
7. Make sure that the Users tab is selected (callout 4).
8. Click Add Channel  to open the Create Channel window.
9. Make these entries in the Create Channel window:

a. Give your channel a name.
b. Select Webhook as the channel type.
c. In the Payload Version field, select the Conversation Model option.
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d. Enter an arbitrary value in the Outgoing Webhook URL field. It doesn’t matter what you enter. Just don't
enter a real URL.

e. Don't change the value in the Session Expiration  field.
f. Click Create.

10. In the Route To field, select the TextAnalyzer skill that you pulled from the store earlier (callout 2 in the
screenshot).

11. Scroll to the Secret Key (callout 3) and Webhook URL  fields (callout 4) and copy both of the values.
12. Now enable the channel by clicking the Channel Enabled toggle (callout 1 in the screenshot).
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Associate the Webhook Channel to Sales and Specify
Recommendation Options  
Here's how to associate the Webhook channel you created for recommendations to the sales application and how to
specify which recommendations you want displayed to which audience. You can specify which fields you want analyzed
and which job roles and regions will see the recommendations. By default, the application analyzes the text entered in
all of the available fields to all job roles and regions.

1. Enter an active sandbox with the Application Composer as one of the available tools (callout 1 in the screenshot)
2. Open Application Composer.
3. Click Oracle Sales Assistant Setup under the Common Setup heading in the left-hand pane (callout 2 in the

screenshot).

4. Click the Configure Text Analysis tab (callout 3).
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5. On the Configure Text Analysis tab, activate the Enable text analysis option as highlighted in the sample
screenshot. 

6. Enter the Webhook URL and the secret key that you obtained when you set up the Webhook channel.
7. Click Configure Fields.
8. On the Configure Fields tab, specify which fields get analyzed and generate recommended actions. By default,

all the available fields are enabled.
9. Next, click Configure Recommendations to select which recommended actions you want displayed and

for whom. If your organization doesn't use appointments, you can turn off any recommendations to create
appointments, for example. By default, all available recommended actions display for all salespeople.
You can disable the action completely, or restrict availability by job role and geography. For example, you can
specify that you want only sales managers in Germany to receive suggestions to create appointments. To do so,
expand Create Appointment and enter Sales Manager in the roles box and Germany in the regions box.

Note:  Any restrictions by job role and geography you specify here also affects the availability of
recommendations in CX Sales Mobile. During CX Sales Mobile setup you can restrict availability further but
the settings you make here take precedence.

10. Click Save Configuration.
11. You must publish the sandbox to make your changes active.

Related Topics
• Create and Activate Sandboxes

Enable Sales Recommendations  
Here's how to enable sales recommendations. The sales recommendation feature analyzes text of notes and call logs
and recommends follow-up tasks and appointments. When enabled, this feature replaces the automatic creation of a
task after call wrap ups.

1. Open the Setup and Maintenance work area and select the Sales offering.
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2. In Setup: Sales, click the Change Feature Opt In link.
3. In the Opt In: Sales page, click Features for Sales (the pencil icon in the topmost row highlighted in the screenshot).
4.

5. Select Enable for Sales Recommendations.
6. Click Done.

Turn Off Unwanted Recommendations  
You can turn off sales recommendations for features that you don't use in your implementation in Application
Composer Sales Assistant Setup. For example, if you don't use appointments, you can disable recommendations to
create appointments.

For navigation details, see the topic: Associate the Webhook Channel to Sales and Specify Recommendation Options
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20  Quoting

Overview of the Oracle Sales and Oracle CPQ Integration 

The integration between Oracle Sales and Oracle CPQ supports standard B2B selling processes, which feature highly
configurable products, variable or dynamic pricing models, discount negotiations requiring executive approval, and
large, branded sales documents.

Oracle CPQ ensures that sales forecasts are reliable and based on real-world quotes. It ensures that sales orders are
valid and contain the correct billing and shipping details to eliminate costly change orders. Additionally, quote data
feeds back into Sales, so that businesses can analyze and improve the overall efficiency of their sales teams.

The integration steps help you configure a solution that combines the power of these applications, while reducing the
cost of ownership and the time needed to deploy the application. However, the integration remains configurable and
extensible, so it can support a wide range of use cases serving any industry. For more information, see Overview of
Planning Your Implementation.
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21  Web Conference Integration

Overview of Web Conference Integration Setup  
You can setup and enable web conferences using either Microsoft Teams or Zoom.

• To implement the integration with Microsoft Teams, follow the instructions in the How do I integrate Microsoft
Teams with Redwood User Experience? playbook.

• To set up Zoom, follow the instructions in the topic Configure Zoom Web Conference for Your Sales Application

In both cases, you must enable web conferencing for appointments so that web conferencing can be used in
orchestrations. For steps, see the topic Enable Web Conferencing for Appointments.

Configure Zoom Web Conference for Your Sales Application  
Here's how to integrate the Zoom conferencing application.

Before You Begin
To activate the web conference feature, you must first raise a service request from My Oracle Support who will then
issue you with a promotion code. You must also have an active Zoom account and remain in agreement with the terms
and conditions of your contract to successfully configure the web conference and your sales application integration.
Also, note that your zoom license must include REST API support, as well as the necessary permissions to manage
meetings and recordings.

Note:  You need the Configure Oracle Fusion Applications Offering privilege (ASM_CONFIGURE_OFFERING_PRIV) in
your user role to enter the promotion code in the application.

When you receive a promotion code to activate Web Conferencing, follow these steps to enter it in your sales
application.

1. Click Navigator > My Enterprise > Enterprise work area.
2. On the Enterprise Information page, click Manage Promotion Code.
3. On the Manage Promotion Codes page, click Enter Promotion Code.
4. On the Enter Promotion Code dialog box, enter the promotion code, and click Save and Close.

The promotion code you entered appears in the Part Number column on the Manage Promotion Codes page.

Once you’ve entered your promotion code, follow the steps to enable, integrate, and verify a web conference app for
your sales application.

When you complete the integration of your Sales for Redwood application with Zoom for Web Conferencing, users can:

• Start Zoom meetings

• Verify and update meeting participants as contacts while the meeting is ongoing

• Take notes and record the meeting outcome
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Summary of Setup Steps
Here's a summary of the steps to enable and integrate a web conference app for your sales organization.

1. Create your own OAuth Application in Zoom.

An OAuth app defines a set of Zoom APIs to allow Oracle access those APIs on your behalf. The OAuth app can
be private and doesn't need to be published. For more details, see the Create an OAuth Application in Zoom
section of the Configure Web Conference for Your Sales Application topic.

2. Instead of making repeated calls to pull data frequently from an API, such as a Zoom account, Webhooks
retrieve the required information about events that happen. The Zoom account must install your Webhook-
enabled app to authorize data flow via Webhooks. For more details, see the Enable Webhooks for Web
Conference section of the Configure Web Conference for Your Sales Application topic.

3. From your Classic Sales application, navigate to the Manage Web Conference Integration task in Setup
and Maintenance to complete and activate the integration. For more details, see the Complete Your Web
Conference Integration section of the Configure Web Conference for Your Sales Application topic.

Create an OAuth Application in Zoom
Here's how to create an OAuth application in Zoom.

1. Sign in to Zoom as a setup user with access to the Zoom Marketplace and with the necessary privileges to build
apps.

2. Navigate to your profile page and select the Advanced drop-down option.
3. From the Advanced drop-down menu, select App Marketplace. You're redirected to the App Marketplace

website.
4. Select the Develop drop-down menu (callout 1 in the screenshot), and then click Build App.

5. From the OAuth panel, click Create (callout 2 in the screenshot).
6. From the Create an OAuth app page, type your application name in the App Name field.
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7. Select the Account-level app option (callout 1) and deactivate the Would you like to publish this app on
Zoom App Marketplace? toggle (callout 2 in the screenshot).
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8. Click Create.
You're redirected to the App Credentials tab from where you can copy the Client ID and Client Secret.

Note:  The Client ID and the Client Secret are necessary to complete and activate the Zoom integration with
your sales application.

9. In the OAuth Redirect URL field, enter your platform destination URL where Zoom will send the access token
after you complete the OAuth authentication.

10. In the Whitelist URL section, insert your platform full domain in the following format: https://
[podhost:podport]/crmUI/faces/OAuthService?service=zoom.

Note:  You can also get this URL from the OAuth Redirect URL field in the Manage Web Conference
Integration task in Setup and Maintenance. See the Complete Your Web Conference Integration section
below.

11. Click Continue.
12. In the Information section, complete the Basic Information for your app by entering these details:

◦ App Long Name and Description

◦ Your Company Name

◦ Name and the Email Address of the developer in charge of the integration (as a point of contact)

13. Click Continue to move to the Features section where you can subscribe to the interested events to receive
Webhook notifications for your app. For more information, see the section Enable Webhooks for Web
Conference.

14. Click Continue again to move to the Scopes tab.
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15. Click Add Scopes and select these two scope types and associated options:

◦ Meeting - Select View and manage all user meetings

◦ Dashboard - Select View all users' meeting information on Dashboard

These two scope types are the extent of APIs that Oracles are allowed to use. Scopes provide a way to limit the
amount of access that's granted to an app.

16. Click Done to complete the creation of your OAuth application in Zoom.

Note:  This OAuth application won't be published in the Zoom marketplace.

Enable Webhooks for Web Conference
Webhooks act as a medium to notify consumer applications about events that occur in your web conference provider.
For example, Zoom implements Webhooks or callbacks to notify clients about events such as when a:

• Meeting started or completed

• Participant joined or left the meeting

• Participant joined a meeting before the host

• Participant is waiting for host to start a meeting

Instead of making repeated calls to pull data frequently from an API, such as a Zoom account, Webhooks retrieve
the required information about events that happen. The Zoom account must install your Webhook-enabled app to
authorize data flow via Webhooks.
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Here's how to enable Webhooks for an OAuth application in Zoom.

1. From the OAuth panel, click the Feature tab to display the My Feature page as follows:

2. Copy the Verification Token to validate an event notification request from Zoom.

Note:   This validation token is necessary to complete and activate the Zoom integration with your sales
application. See the Complete Your Web Conference Integration section for more information.
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3. Click Event Subscriptions and subscribe to the interested events to receive Webhook notifications for your app
by entering these details:

◦ Click  Add new event subscription  and select Meeting. Click the field again if you want to add
additional Event Subscriptions.

◦ Enter the Subscription Name.

◦ Select the events from available Event types that you would like to subscribe as follows.

Note:  Although you can subscribe to as many events as required for each event subscription, you can
only have a maximum of 10 event subscriptions per app.

◦ Enter a valid Event Notification Endpoint URL as shown in the following example: https://
<podhost>:<podport>/crmRestApi/webConferenceEvent/zoom.

This is the designated URL of your app where you receive Webhook POST requests, also known as event
notifications. Event notifications are sent as HTTP POST requests in JSON to the endpoint you specify in
your Marketplace app. This URL must be secured over HTTPS.

4. Click Done to complete the Webhook configuration of your OAuth application in Zoom.
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Complete Your Web Conference Integration
You're now ready to complete and activate the Zoom web conference integration for your sales application. Follow these
steps:

1. Navigate to My Enterprise >  Setup and Maintenance  > Manage Web Conference Integration. The following
screen is displayed.

2. Enter the following:

Field Value

Provider
 

Select Zoom from the drop-down list.
 

Client ID
 

Copy the value generated in the App Credentials section from the application created on Zoom
marketplace. (See step 8 in the Create an OAuth Application in Zoom section).
 

Client Secret
 

Copy the value generated in the App Credentials section from the application created on Zoom
marketplace. (See step 8 in the Create an OAuth Application in Zoom section).
 

OAuth Redirect URL
 

This pre-populated field defaults to the value you entered for the Whitelist URL in step 9 of the
Create an OAuth Application in Zoom section. It contains your pod information in the following
format:
 
https://[podhost:podport]/crmUI/faces/OAuthService?service=zoom

Service URL
 

This pre-populated field defaults to the value you entered in step 9 of the Create an OAuth
Application in Zoom section.
 
To support GDPR requirements of EU customers, you can use this URL as the base URL for all
API requests associated with EU accounts.
 
https://eu01api-www4local.zoom.us

 
For information about the Service URL, go to this URL https://marketplace.zoom.us/
docs/api-reference/introduction
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Field Value

Verification Token
 

Copy the verification token value generated in the Add Feature section from the application
created on Zoom marketplace. (See the section Enable Webhooks for Web Conference).
 

3. Click Register to initiate the OAuth process.

A new window is displayed which requests your Zoom credentials.
4. Sign in with your Zoom account details and once you're successfully authenticated, you receive this message:

Congratulations. You have successfully registered your web conference provider.

Note:  Calls to Zoom will be made with these credentials. The email address for Sales resources will be used
as the Zoom user ID.

5. Next, you're prompted to authorize the usages of the scopes you selected in step 15 in the Create an OAuth
Application in Zoom section.

6. Return to the Manage Web Conference Integration page and click Save and Close to complete the registration.

Verify Your Setup
Here's how to verify your setup.

1. Sign in to your sales application.
2. Create an appointment of type Web Conference.
3. Check your Zoom web profile to verify the successful creation of your meeting in Zoom (https://zoom.us/

meeting#/upcoming)

Remove a Web Conference
These steps describe how to remove a web conference integration from your sales application.

1. Sign in to Sales as a sales administrator.
2. Navigate to My Enterprise >  Setup and Maintenance.
3. In the Setup and Maintenance work area, click the Tasks side panel icon and then click the Search link.
4. Search for and select the Manage Web Conference Integration task.
5. In the Provider field, remove the current value and leave blank.
6. Click Save and Close.

Enable Web Conferencing for Appointments  
Enable web conferencing for appointments. This setup is required for Orchestration steps that allow salespeople to
open web conferencing with the click of the Start Web Conference button.

1. In Setup and Maintenance, open the task Manage Activity Type and Subtype:

◦ Offering: Sales

◦ Functional Area: Sales Foundation
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◦ Show: All Tasks

◦ Task: Manage Activity Type and Subtype

2. For the Web conference (WEB_CONFERENCE) entry, select the Appointments check box.
3. Enter a start date.
4. Click Save and Close.
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22  Sales Assistant

Overview of Sales Assistant  
Sales Assistant is a chatbot that you can use to access sales information and perform sales activities. You enter
questions or commands, and the Sales Assistant retrieves the information or acts on your requests. The Sales Assistant
reduces manual data entry, and makes it easier to view and update sales records through text in Microsoft Teams and
through either text or voice in CX Sales Mobile.

Things to note:

• Supported Channels: Microsoft Teams, CX Sales Mobile

• Supported Language: English

• Supported Objects: Accounts, Appointment, Contacts, Opportunities, Service Requests, Tasks, Sales Leads,
and Custom objects

Administrators can enable or disable different objects for each channel.

• Security:  When using Oracle Sales Assistant in Microsoft Teams, you're prompted to sign in to Sales via a sign-
in button the assistant sends to you when you first converse with it. After you sign in, the assistant continues
the conversation with you.

To use Oracle Sales Assistant in CX Sales Mobile, you can use the chatbot right away after you sign in to Oracle
CX Sales Mobile.

For any channels, the same functional privilege you have in Sales applies when entering into conversations with
the Sales Assistant.

Where to Get Help with Sales Assistant Setup
If you need help with enabling Oracle Sales Assistant, send a message to the Sales Assistant forum on Oracle Cloud
Customer Connect. Here's the URL:

https://cloudcustomerconnect.oracle.com/resources/dee2ff3bf7/summary

Related Topics
• Overview of Sales Assistant Setup

• Set Up Oracle Sales Assistant for Microsoft Teams

• Set Up Oracle Sales Assistant for CX Sales Mobile

Overview of Sales Assistant Setup  
Because Oracle Sales Assistant setup is different for each of the channels it's running in, this chapter is divided into
different sections for each channel.
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Step Setup Task Application Description Where to get more details

1
 

You must have completed
the prerequisite Oracle
Digital Assistant application
setup.
 

Oracle Identity Cloud
Service (IDCS)

Before you set up any
of the features that
use natural-language
processing, you must
perform some prerequisite
setup of Oracle Digital
Assistant:

• Set up administrator
users

• Obtain the ODA URL

• Install (pull) the
FADigitalAssistant.

• Enable the Digital
Assistant used for
Oracle Fusion Cloud
Applications

 
If you already completed
the setup for another
feature, you can skip this
step.

See the topic: Overview of
Common ODA Setup for
Sales.
 
For additional information,
 see the Oracle Digital
Assistant documentation:
Getting Started with Oracle
Digital Assistant for Cloud
Applications.
 

2 Check Adaptive Search
setup.

Classic Sales You must check that
Adaptive Search is set up
and the correct fields are
enabled for Opportunity
and Activity objects.

• Opportunity: Status,
 Sales Method

• Activity: Type, Activity,
 Start Date, End Date,
 Status, Due Date

Prerequisite Adaptive
Search Setup in Sales

3
 

Configure the integration
with Microsoft Teams
 

Microsoft Teams Developer
Portal and Oracle Digital
Assistant

For Oracle Sales Assistant
for Microsoft Teams,
 involves creating an app
in the Microsoft Teams
Development Portal and a
Microsoft Teams channel in
Oracle Digital Assistant.
 

See Set Up Oracle
Sales Assistant for
Microsoft Teams for more
information.
 

4
 

Configure the integration
with Classic Sales Mobile
 

Oracle Digital Assistant and
Application Composer

For Oracle Sales Assistant
for CX Sales Mobile, you
configure an Oracle Web
Channel and hook it up
to CX Sales Mobile using
Application Composer.
 

See Enable Sales Assistant
for CX Sales Mobile for
more information.
 

5
 

Use the Common
Configuration Tool to
Update Synonyms
 

Application Composer The Oracle Sales Assistant
Common Configurations
administrator tool provides
an easy way for you to
manage synonyms for
all supported channels
without having to manually
manage them in Oracle
Digital Assistant.

See the topic Use the
Common Configuration
Tool to Update Synonyms
of the Common
Configurations section for
more information about
adding synonyms to fields
and objects (if required).
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6 Periodically update the
FADigitalAssistant skill

Oracle Digital Assistant The CX Sales skill is
updated every release
and three times within
each release. You should
periodically update to the
latest version.

See the topic: Refresh the
Digital Assistants
 

Prerequisite Adaptive Search Setup in Sales  
Oracle Sales Assistant uses enabled saved searches and the high-performance search capabilities powered by Adaptive
Search. Before using the Oracle Sales Assistant, you must ensure that:

1. Adaptive Search is enabled in the Sales application, and that search indexing processes are run and regularly
scheduled.

2. Fields are enabled in Adaptive search for these objects:

◦ Opportunity - Status, Sales Method

◦ Activity - Type, Activity, Start Date, End Date, Status, Due Date

See Make Additional Fields Searchable and the Implementation Reference guide.

Validate Oracle Sales Assistant Configurations Using the
System Status Tool  
Use the system status tool to check if you are missing information or if you have entered incorrect data for your CX
Sales Mobile and Oracle Sales Assistant configurations.

The system status tool is available from both within and outside a sandbox environment. For example, if you access
the tool inside a sandbox, it checks the objects configured in the sandbox. Alternatively, if you are using the tool from
outside the sandbox, it checks the objects against published configurations.

Previously, you needed to be inside a sandbox to configure the channels, but now you can configure channels for Oracle
Sales Assistant outside a sandbox. This topic explains how to use the system status tool to determine if the setup for
Oracle Sales Assistant is complete and ready to use from outside a sandbox.

The system status tool helps determine whether Oracle Sales Assistant is setup correctly. It also checks whether all
aspects, such as REST APIs, are working as required for the sales assistant to function.

Navigate to the System Status Tool from Outside a Sandbox
Here's how to access the system status tool from outside a sandbox environment.

1. Open Application Composer by selecting Application Composer under the Configuration category in the
Navigator menu.
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2. Under the Common Setup Menu, click Productivity Applications Configuration.
3. Click the Oracle Sales Assistant tab to enter your channels configuration.

Note:  Click the CX Sales Mobile tab to open the System Status tool and view the current status of the CX
Sales Mobile configuration.

4. Click Save Configuration and the system status page is displayed showing the current status of your channel
configurations.

Navigate to the System Status Tool within a Sandbox
Here's how to access the system status tool from inside a sandbox environment.

1. Sign in to the Sales application as a user with a Sales Administrator role.
2. Select or create a sandbox that you want to use for your configurations. Make sure that your sandbox includes

Application Composer as an active tool.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the System Status tab to open the system status tool.

Check the System Status of Your Configuration
The system status page contains a summary of the setup information such as host, user name, and the time and date
of the last system check. The results section displays the status of the requests that were checked and you can filter by
all requests or view only request that failed.

To check the status of your Oracle Sales Assistant:

1. From the Channels Configuration page, click System Status. 

2. View the Setup Information section as follows:

◦ Host

◦ Username

◦ Last Check

3. Check the General  section which displays the summary status of the following general items for the sales
assistant setup. Note that general checks aren't related to specific objects.

◦ CX Sales Skill Provisioning
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Checks if the provisioning is correct for the environment by invoking the list skill API. An error indicates
that there’s an issue with the Oracle Digital Assistant provisioning and you must raise a service request
(SR) with the support team.

◦ CX Sales Skill Version Check

Checks the Sales skill version. The Oracle Digital Assistant list skill API only returns skills whose skill
versions match FA version, which can be used for this validation. If the list returned is empty, then this
checks to see if there is any available valid skill.

◦ Bootstrap Resources

Checks if REST APIs are working successfully in your environment.

◦ User Preferences

Checks if user preference values such as user display name, region, date format and so on can be
successfully retrieved.

◦ Adaptive Configuration

Checks if the Adaptive Search REST API is working successfully and is able to retrieve the available list of
objects which are indexed for Adaptive Search.

4. Click Channel Selection to filter objects based on the channel selected.
5. View the status results from the Results section to view checks for the configured objects.

Note:  If you are using the system status tool from inside a sandbox, it checks the objects configured in the
sandbox. If you accessed the tool from outside a sandbox, then checks are performed on those published
configurations.
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6. Click View Details to display a drawer with additional information for a request that has an error status.

Note:  If an object has any issue, then the View Details is displayed. If the object has no issues, then No
Issues is displayed.

Here are a few examples of some checks that the system status tool performs. If there's an object that is
enabled but does not have synonyms added to it, then an error will be displayed for the object. Also, if there are
fields that have synonyms but not enabled for Adaptive Search, then an error is displayed for the object. Here's
a sample of the error details screen.

Any requests that aren’t correctly configured are marked accordingly so you can easily tell what areas needs to be
configured based on the status as follows:

Status Description

Success The Success icon means this item passes all validations and no issues are found.

Error The Error icon means this item doesn't pass all validations. This can be caused by either the request to
the server itself fails or some fields are configured incorrectly.

Hidden The Hidden icon indicates that the request is hidden in the Navigator.

Recommended The Recommended icon means this item is not configured as recommended. Although this doesn't
affect the application's functionality, you should configure the item as suggested.
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FAQs for Sales Assistant  

Can I configure channels for Oracle Sales Assistant outside a
sandbox?  
Yes. You no longer need to create and publish a sandbox to configure channels for your sales assistant.

In addition, you can use the system status tool to help validate if the configurations for Oracle Sales Assistant are all
completed and the assistant is ready to use.

Related Topics
• Validate Oracle Sales Assistant Configurations Using the System Status Tool

Microsoft Teams  

Set Up Oracle Sales Assistant for Microsoft Teams  
Enabling Oracle Sales Assistant in Microsoft Teams involves creating an app in the Microsoft Teams Development Portal
and a channel in Oracle Digital Assistant.

1. Create an app using the Developer portal in Microsoft Teams, and add a bot to the app.

Ensure that you set the following 2 options:

◦ Under the Messaging bot section, select My bot supports uploading and downloading files

◦ Under the Scope section, select Personal

◦ Note:  You can create an app using many different ways as outlined in the Microsoft Teams chapter in
the Using Oracle Digital Assistant guide.

2. Create a channel in Oracle Digital Assistant using the bot ID and password from the bot registration as follows:

a. In a separate browser window or tab, open Oracle Digital Assistant, click Channels in the left menu, and
choose Users.

b. Click + Channel to open the Create Channel dialog.
c. Enter a name for your channel.
d. Select Microsoft Teams as the channel type.
e. Enter the Microsoft Application Id with the Microsoft Bot ID that you obtained when you created your

bot registration in the Developer portal in Microsoft Teams.
f. Enter the Microsoft Application Password  with the client secret that you obtained from your bot

registration.
g. Click Create.
h. From the Channels page, copy the WebHook URL and paste it somewhere convenient on your system.
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i. Click the Route To  icon and from the drop down, select the Oracle Digital Assistant or skill that you want
to associate with the channel.

j. Select Channel Enabled.
3. Copy the WebHook URL that was generated when you created the channel and add it to the bot registration in

Microsoft Teams.
4. Test your Oracle Digital Assistant through the Chat window in Microsoft Teams.

Overview of Extending Sales Assistant for Microsoft Teams  
Microsoft Teams Composer is an easy-to-use interface designer tool in Application Composer that lets you configure
the Oracle Sales Assistant chatbot for Microsoft Teams channel users. It helps you manage which objects and fields are
visible in the chatbot.

You can create conditions to define when a page layout displays, without having to carry out specific configurations. You
can add your own custom objects to the chatbot using Microsoft Teams Composer and add page layouts in the same
way that you can with standard sales objects.

You can add a role to a chatbot feature's List, Summary, and Edit layout. For example, a user with the Sales Manager role
might want to see certain fields on an opportunity record that other sales team members won't need. You can assign
geographical regions to a page layout, which will restrict a page layout's availability to users from your selected set of
geographical regions. For example, you might want to configure a summary layout based on the Sales Representative
and Sales Manager roles, for Canada, based on an expression where the amount is less than $200,000 and the win
probability is greater than 50%.

To use this feature, you must have Oracle Sales Assistant implemented for Microsoft Teams. You can enable or disable
the objects available on the channel, which means that Microsoft Teams channel users of Sales Assistant can also view
information about custom objects.

CAUTION:  You can only configure the latest skill from the skill store that matches your current release. For example,
if the skill you want to modify is from a previous release and you're making your changes in a later release, then you
must re-base the skill your users are using to the latest skill that was modified. In addition, you must re-route the
channel to the new re-based skill so that users can start using it and perform Reset sessions in the channel UI.

Note:  If you need help with enabling Oracle Sales Assistant, send a message to the Sales Assistant forum on Oracle
Cloud Customer Connect. Here's the URL:  https://cloudcustomerconnect.oracle.com/resources/dee2ff3bf7/summary

Access the Microsoft Team Composer tool from the Oracle Sales Assistant Setup node under the Common Setup
section of Application Composer.
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Note:  Oracle Sales Assistant for Microsoft Teams utilizes the saved searches enabled in Workspace and the high-
performance search capabilities powered by Adaptive Search. See the Implementation Reference guide for more
information about Adaptive Search and setting up Workspace saved searches.

Navigate to Microsoft Teams Composer  
You can configure custom sales assistant layouts to display data by role, region, or other criteria for Microsoft Teams
channel users. Using the Microsoft Teams Composer configuration tool, you can add, remove, and rearrange standard
or custom fields to suit your business requirements.

Navigate to the Microsoft Teams Composer Tool
Here's how to navigate to Oracle Sales Assistant for Microsoft Teams.

1. Select or create a sandbox that you want to use for your configurations. Make sure that your sandbox includes
Application Composer as an active tool.

2. Open Application Composer by selecting Application Composer under the Configuration category in the
Navigator menu.

3. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
4. Click the Microsoft Teams Composer tab to open the Oracle Sales Assistant for Microsoft Teams configuration

tool.

On the left-hand side of the configuration tool, you can see the Application Features pane which lists the standard and
custom objects that are enabled for Oracle Sales Assistant for Microsoft Teams in the current sandbox. The standard
objects include:

• Accounts

• Appointment
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• Call Report

• Contacts

• Opportunities

• Tasks

• Sales Leads

• Service Requests

When you click Home you have the option to enable or disable an object, or choose a different icon for an object.

The center pane lists the predefined objects or other objects that were added for Oracle Sales Assistant for Microsoft
Teams. You can see at a glance those objects that are enabled and those objects that are deactivated are denoted by
an icon. Scroll to the bottom of the page and you see the + Add Feature button, which let's you add custom objects to
Oracle Sales Assistant for Microsoft Teams.

Note:  If you're adding a custom object, ensure that the Include in Service Payload option is enabled for an object
in Application Composer. For details about how to do this, see the Add Objects and Fields chapter in the Configuring
Applications Using Application Composer guide.

Assign Roles and Regions to Access Oracle Sales Assistant via
Microsoft Teams  
You can assign roles and regions to have access to CX Sales using Oracle Sales Assistant in Microsoft Teams. This gives
you the flexibility to allow users with specific roles and in specific regions to have a conversation with the sales assistant.
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If there are no roles and regions selected for the Assigned Roles and Assigned Regions fields, then Oracle Sales
Assistant will be available to all Oracle Sales users.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.

2. In the Application Feature pane, click Settings.
3. From the General Settings pane, select the regions you want from the Assigned Regions drop-down list.

If you add two regions (region A and region B), the sales assistant will be available for users in region A or in
region B.

4. Next, select the roles you want from the Assigned Roles drop-down list.

If you add one role and one region, the sales assistant will be available for users with that role and in that
region. However, if you add two roles and two regions, users with either one of the roles (role A or role B) in
either one of the regions (region A or region B) can use the assistant.

5. Click Save.

Enable Attachments and Notes for Microsoft Teams  
The Enable Attachments is selected by default and allows you to ask to view or upload attachments to your record. The
Enable Notes is also selected by default and allows you ask to view or add notes.
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For example, you can ask the assistant to attach a file to the object's records for those objects that have an attachment
as a child object. When enabled, it will launch the attachment form for you to share notes, photos, videos, documents,
or files from Oracle Sales Assistant for Microsoft Teams to CX Sales records.

You can also ask the assistant to add a note for any object that has notes as a child object. The assistant prompts you
for the note details to add to the record you want.

Here's how to enable attachments and notes from the Microsoft Team tool in Application Composer.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Create a new sandbox to use for your configurations.
3. Select Application Composer under the Configuration category in the Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Oracle Sales Assistant Setup.
5. Click the Microsoft Teams tab.
6. In the Application Features pane, click Settings.
7. The Enable Attachments toggle is selected by default and allows you to ask to view or upload attachments to

your record. The Enable Notes toggle is also selected by default and allows you ask to view or add notes.

Note:  If you don't have access to attachments or notes in Oracle Sales, you won't be able add attachments or
notes and won't be able to get any notes via Oracle Sales Assistant.

8. Click Save.

Here is a sample screenshot of the general settings highlighting the Enable Attachments and Enable Notes options.

About Page Layouts for Standard and Custom Objects  
If you want to change the standard layout for an object for Oracle Sales Assistant for Microsoft Teams, you can create a
new page layout and configure it to suit your company's requirements.

There are three different types of page layouts that you can create:

• List layout

• Summary layout

• Edit layout

266



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 22
Sales Assistant

Here are the basic configuration steps to make simple changes to Oracle Sales Assistant for Microsoft Teams layout
pages:

1. In the Application Features pane, click the standard or custom object that you want to create a layout for.
2. Select the relevant type of page layout, such as the List, Summary or Edit.
3. In the Layouts pane, click the Click to Clone icon for the standard layout and enter a layout name.
4. Click Ok.
5. Change the fields that appear by clicking the relevant field and selecting a new field from the list.
6. You can remove fields by clicking the field and then clicking the cross icon.
7. To move a field, just drag it to the location where you want it to appear.
8. Click Save in the top right-hand corner of the Microsoft Teams Composer page.

Tip:  Before saving, you can click the Preview tab to preview how the changes will display on Microsoft Teams.

9. Test and publish your new page layouts. See the Test Your Oracle Sales Assistant for Microsoft Teams topic for
details about how to check your page layout configuration changes.

If you want to make more extensive changes to a page layout, familiarize yourself with the additional capabilities of the
different types of page layout.

The List Page Layout
The List page layout displays a list of an object's records, with each record showing a set of fields that can be
configured. Here are the points to note about configuring the List page layout:

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature Using Microsoft Teams Composer topic.

• The list layout contains 3 sections, Title, Contextual and Detail. In the Contextual and Detail sections, you can
add up to five fields. Click on add field to select a field for the object. Once a field is added, click add field again
to select another field and the pane shows two fields and a separator. You can rearrange the fields on each row
by clicking and holding the field to move it to a new position.

• Roles and geographical regions can be assigned to List page layouts. These enable you to restrict who can view
the page layout by their role and their geographical region. You can find more details about how to do this in
the Define Criteria for a Feature's Page Layout topic.

Make sure that you click Save in the Microsoft Teams Composer tool page before creating another page layout.

Test and publish your new page layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic
for details about how to check your configuration.

The Summary Page Layout
The Summary page layout displays an object's details. There are six sections to the Summary layout consisting of a top
section that provides the object's contact information and top-level information of your choice, information sections,
and child and actions related object sections.

The sections of the summary layout are as follows:

• The top section is the Header section (fields are standard and you can't add additional fields to this section).

• The Information Section consists of one or many Info1 sections, owner and primary contact (you can rearrange
the sections as required).

• Child object section (you can add child objects and rearrange child objects within the child objects section)
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• Actions section (this is always placed at the end and depends on the selected object). Some objects have
actions and some don't. All action show up as buttons on the card.

Here are the points to note about configuring the top section:

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature topic.

• You can't move the top section, because this section is designed to contain the top-level information for the
object.

Here are some points to note about the information section:

• Displays Info 1 section, Owner, and Primary contact sections. Note that not all objects has Owner and Primary
Contact sections. For example, both Opportunity and Account objects have Primary Contact and Owner, the
Contact object has Owner, and Service Request has Primary Contact.

• You can add as many Info 1 sections as required and each Info 1 section shows up as its own section. The
section is named Info1 section because you can add 1 field per row.

• You can reorder any of the sections by using the blue up and down arrows.

• You can add fields by clicking the + Add Field button at the bottom of each section. There's no limit as to the
number of fields you can add.

• You can add Info 1, Owner, and Primary contact sections by clicking the + Add Section button.

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature topic.

The section for adding child and related objects is at the bottom of the Summary page layout. Child objects such as
notes, attachments, or in the case of the Opportunity object, products, and competitors are supported only for the
Summary layout. If the object has other related objects, those can't be added to the summary card.

• This section can't be moved, however you can add as many child and related objects as you require by clicking
+ Add Child.

• When you add a child or related object, the child object section displays on the left pane of the summary card.
Click the child object and the screen to modify the list view is displayed. Note that only the first two sections of
the list card will be displayed on the summary card. The full list layout on the top level object's summary card
isn't displayed. See the Child Object Page Layouts section of this topic for more information.

Other configuration options for the Summary page include:

• Assign roles and geographical regions to Summary page layouts. These enable you to restrict who can view
the page layout by their role and their geographical region. You can also define a set of conditions that have
to be met before the page layout is displayed. For example, if you create criteria as follows: Win probability is
Greater than 50%, then any opportunities with a win probability greater than 50% will use your layout. You can
find more details about how to set these up in the Define Criteria for a Feature's Page Layout topic.

Make sure that you click Save in the configuration tool page before creating another page layout.

Test and publish your new page layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic
for details about how to check your mobile configurations.
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The Edit Page Layout
When you create an object using Oracle Sales Assistant (OSA), the default action is that the assistant only prompts for
values of required fields that have no default values. Here are the points to note about configuring the Edit page layout:

• Edit page layouts is available for Task, Appointment, and Call Report objects only.

• You can change the fields, remove fields, and move fields using the steps in the Create Your Own Page Layout
for a Feature Using Microsoft Teams Composer topic of this chapter.

• The order of the questions asked during the create is based on the order of the fields in the edit layout. To
move a field, just drag it to the location where you want it to appear.

• By default, when you create an object, the assistant only prompts for values of fields on the edit page layout
that are required and have no defaults values. However, if you would like the assistant to prompt for additional
fields that aren't mandatory, or mandatory and have a default, then you can select the fields in the "Prompted
Fields on Assistant Create" section on the left hand side of the tool. Any fields selected in this section will
always be prompted during conversational create if the field is part of the edit layout. The fields selected in this
section applies to the predefined standard or custom layouts.

• You can also assign roles and geographical regions. These enable you to restrict who can view the page layout
by their role and their geographical region. You can also define a set of conditions that have to be met before
the page layout is displayed. For example, if you create criteria as follows: Win probability is Greater than 50%,
then any opportunities with a win probability greater than 50% will use your layout. You can find more details
about how to set these up in the Define Criteria for a Feature's Page Layout topic.

Make sure that you click Save in the configuration tool page before creating another page layout.

Test and publish your new page layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic
for details about how to check your mobile configurations.

Child Object Page Layouts
You can only add child objects to the Summary page layouts, but you can also create page layouts for the child objects
themselves.

Here are points to note when configuring page layouts for child objects:

• Note and Attachments are special child objects that can't be extended or modified.

• Only predefined child objects layouts are displayed under the Child object section.

• When you add a child object to a parent object's page layout, the child object is added to the Children pane. To
create a page layout for the child object, click the child object and clone the standard page layout, as you would
for the parent object.

• Configuring a child object page layout is the same as configuring a parent object's page layout, so you can
follow the same steps you're already familiar with in this topic.

• The template that's used for the list view for top level objects page layout is selected when you add the child
object to a parent page. You can then further configure the List page when you select the child object and clone
the standard page layout.

• You can assign roles and geographical regions to child object page layouts. You can also assign criteria for
displaying the list page layout. Child object layouts only supports list layouts for now and advanced criteria isn't
supported for list layouts.

Ensure that you test and publish your new page layouts. See the Test Your Oracle Sales Assistant for Microsoft Teams
Configuration topic for details about how to check your configuration.
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About Page Layouts for Global Actions  
You can create Sales Briefing layouts for specific roles, including custom roles, by either hiding or displaying the
information related to pipeline, tasks or appointments for the particular role.

This can be particularly useful for sales managers who don't have a pipeline and so don't want to see blank pipeline
information on their home page. You can also define the definition of pipeline based on Workspace saved searches.

Here's how you configure the Sales Briefing response:

1. In the Application Features pane, click Global Actions.
2. In the Layouts pane, click the Click to Clone icon to create a new Sales Briefing layout.
3. Enter a layout name and click Ok.

All the Sales Briefing information is displayed by default. You can hide specific information from the Edit
Layouts pane by clicking the Show icon to enable or disable the information on the card.

You can also add a saved search to the pipeline card by clicking the Actions menu (3 horizontal dots icon)
beside the pipeline row.

Tip:  If you want to assign a role to your Sales Briefing layout, add the role in the Assigned Roles pane.

4. Click Save.
5. Test and publish your new page layouts.

See the "Test Your Oracle Sales Assistant for Microsoft Teams" topic for details about how to check your page layout
configuration changes.

Create Your Own Page Layout for a Feature Using Microsoft Teams
Composer  
This procedure shows you how to create a Summary page layout for an Oracle Sales Assistant for Microsoft Teams
feature but you can also use this procedure to help create List and Edit page layouts as well.

Creating your own layout enables you to select the fields your users will see for a feature's view using Microsoft Teams.

Tip:  You can also specify which user roles can view a particular layout, create criteria that have to be met to display
the layout, and specify which geographical regions can view the layout.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Microsoft Teams Composer tab to open the Oracle Sales Assistant for Microsoft Teams configuration

tool.
6. In the Application Feature pane, click the feature that you want to create a layout for.
7. Select the relevant type of page view, such as the summary, list, or edit view.
8. In the Layout pane, click the Click to Clone icon for the Standard layout and enter a layout name.
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9. Click Ok.
10. Select the Active tick icon if it's not already selected.
11. In the Edit Layout pane add fields to the Summary layout page, for example, by clicking + Add Field in the Info

1 Section.
12. Select the field that you want to add to the Summary layout and then select a label, if one exists.

Note:  You can remove fields by clicking the field you want to delete and then click the cross icon.

13. You can move fields by clicking the field and moving it to your preferred location.
14. For the Summary layout, click the + Add Action and select which user actions you want to display or hide using

the toggle buttons.
15. Click Save in the Microsoft Teams Composer page.
16. Test and publish your new page layouts. See the Test Your Oracle Sales Assistant for Microsoft Teams

Configuration topic for details about how to check your configurations.

Assign Roles to Page Layouts  
You can add a role to an Oracle Sales Assistant for Microsoft Teams page layout. You can also add a role to an
application feature's relevant type of page view, such as the summary, list or edit view.

For example, a user with the Sales Manager role might want to see certain fields on an opportunity record that other
sales team members won't need.

Note:  You can assign a role when you create a custom object layout. For example, you can also assign advanced
criteria for custom object summary layouts. Custom features are created when you create a custom object in
Application Composer, and they're selected from the Available Features pane.

Here are the steps to assign a role to an Opportunity Summary layout using Microsoft Teams Composer and display the
new layout in the Oracle Sales Assistant for Microsoft Teams application.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.
2. In the Application Feature pane, click the feature that contains the page layout that you want to add roles to. In

this example, expand the Opportunities subheader.
3. Select the relevant type of page view, such as the summary, list or edit view. In this example, select the

Summary view.
4. In the Layouts pane, select the relevant page layout, or create a new page layout (see the Create Your Own Page

Layout for a Feature Using Microsoft Teams Composer topic for details about how to create a page layout).
5. Expand the Assigned Roles pane, and select the roles you want to add.

Note:  You can remove a role by clicking the Remove (X) icon.

6. Click Save.
7. Check that your changes appear in your CX sales application. Sign in as a Oracle Sales Assistant for Microsoft

Teams user and view your changes by sending "refresh metadata". Then send the utterance to get the record
for the layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic for details about
how to check your changes.

8. When you're happy with your changes, publish your sandbox to distribute your configurations to all Oracle
Sales Assistant for Microsoft Teams users.
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Related Topics
• Create Your Own Page Layout for a Feature Using Microsoft Teams Composer

• Test Your Oracle Sales Assistant for Microsoft Teams Configuration

Assign Regions to Page Layouts  
Adding geographical regions to a feature's layout enables you to restrict its availability to users from a selected set of
geographical regions.

For example, if you add the United States and United Kingdom regions to a page layout, then only users from these
countries can view the page layout. You can assign a region when you create a custom object layout.

Here are the steps to assign a geographical region to an Opportunity Summary layout using Microsoft Teams Composer
and display the new layout in the Oracle Sales Assistant for Microsoft Teams application.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.
2. In the Application Feature pane, click the feature that contains the page layout that you want to add regions to.

In this example, expand the Opportunities subheader.
3. Select the relevant type of page view, such as the summary, list, or edit view. In this example, select the

Summary view.
4. In the Layouts pane, select the relevant page layout, or create a new page layout (see the Create Your Own Page

Layout for a Feature Using Microsoft Teams Composer topic for details about how to create a page layout).
5. Expand the Assigned Regions pane, and select the regions you want to add.

Note:   Select as many regions as you require. You can remove a region by clicking the Remove (X) icon.

6. Click Save.
7. Check that your changes appear in your CX sales application. Sign in as a Oracle Sales Assistant for Microsoft

Teams user and view your changes by sending "refresh metadata". Then send the utterance to get the record
for the layout. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration topic for details about
how to check your changes.

8. When you're happy with your changes, publish your sandbox to distribute your configurations to all Oracle
Sales Assistant for Microsoft Teams users.

Related Topics
• Create Your Own Page Layout for a Feature Using Microsoft Teams Composer

• Test Your Oracle Sales Assistant for Microsoft Teams Configuration

Define Criteria for a Feature's Page Layout  
Creating criteria enables you to define a set of conditions that have to be met before the page layout is displayed for a
feature's Summary views.

For example, if you create criteria for an Opportunity Summary layout as follows: Win probability is Greater than 50%,
then any opportunities with a win probability greater than 50% will use your layout in the Summary view.

Note:  You can't create criteria for a feature's List view.
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This procedure shows you how to create criteria for an Oracle Sales Assistant for Microsoft Teams feature's page layout.

1. Navigate to the Oracle Sales Assistant for Microsoft Teams configuration tool.
2. In the Application Feature pane, click the feature that contains the page layout that you want to add roles to. In

this example, expand Opportunities.
3. Select the relevant type of page view, such as the summary or edit view. In this example, select the Summary

view.
4. In the Layouts pane, select the relevant page layout, or create a new page layout (see the Create Your Own Page

Layout for a Feature Using Microsoft Teams Composer topic for details about how to create a page layout).
5. In the Advance Criteria pane, click Add.
6. Create your criterion by selecting a field, operator, and then entering the relevant field value.

Note:  You can't select a field value from a list of values, so enter the field value.

7. To add a conditional statement click Add and select AND or OR. Enter the field, operator, and relevant field
value.

8. Click Save.
9. Check that your changes appear in the CX Sales application. See the Test Your Oracle Sales Assistant for

Microsoft Teams Configuration topic for details about how to check your changes.
10. When you're happy with your changes, publish your sandbox to distribute your configurations to all Oracle

Sales Assistant for Microsoft Teams users.

Related Topics
• Create Your Own Page Layout for a Feature Using Microsoft Teams Composer

• Test Your Oracle Sales Assistant for Microsoft Teams Configuration

Add Custom Objects to Page Layouts  
You can add a custom object to your Oracle Sales Assistant for Microsoft Teams chatbot.

Sales objects are also known as features in Sales Assistant for Microsoft Teams. When you create a custom Sales
object in Application Composer a corresponding feature is also created in Sales Assistant for Microsoft Teams. Custom
features can be found in the Application Features pane in the Microsoft Teams Composer page.

Here's how you add a custom object, or feature to your Oracle Sales Assistant for Microsoft Teams using Microsoft
Teams Composer.

1. Sign in to the Oracle CX Sales application as user with a Sales Administrator role.
2. Select the sandbox you want use for your configuration.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Select the Sales application and find the custom object you want to add to Oracle Sales Assistant for Microsoft

Teams.
5. Expand the object's menu and click Fields.
6. Select the field you want to add to Oracle Sales Assistant for Microsoft Teams.
7. In the Constraints section, enable the Include in Service Payload option.
8. Click Save and Close.
9. Repeat steps 6 to 8 for each field that you want to add to the application.

10. Next, under the Common Setup Menu, click Oracle Sales Assistant Setup.
11. Click the Microsoft Teams Composer tab to open the Oracle Sales Assistant for Microsoft Teams configuration

tool.

273



Oracle Fusion Cloud Sales Automation
Implementing Sales

Chapter 22
Sales Assistant

12. In the Features pane, click the + Add Feature and search for the custom object you previously created in
Application Composer.

13. Click the custom object (otherwise known as a feature) that you want to add.
14. Choose an icon from the list to display for the selected custom feature.
15. Click Next and a preview of the List and Summary views that will be created are displayed for the selected

custom feature.
16. Click Ok and add the custom object to the Features pane.
17. If you want to add custom layouts to the List or Summary views, see the Create Your Own Page Layout for a

Feature Using Microsoft Teams Composer topic for more details.
18. When you have finished adding the custom feature, click Save in the top right-hand side of the Microsoft

Teams Composer page.
19. Next, use the Common Configuration tool to define the synonyms for the newly enabled custom object. See the

Common Configurations section for more details.
20. Test and publish your new features. See the Test Your Oracle Sales Assistant for Microsoft Teams Configuration

topic for details about how to check your changes.

Test Your Oracle Sales Assistant for Microsoft Teams
Configuration  
After you have configured Oracle Sales Assistant for Microsoft Teams using Microsoft Teams Composer, you should test
your configuration before distributing the changes to your users.

Task Summary
To test your configurations, complete these tasks:

1. Download the configuration changes from the sandbox and verify them.
2. Publish the sandbox.

Download Configuration Changes From the Sandbox
Here's how:

1. After making changes to your configuration, keep the Oracle CX Sales application open (signed in with a Sales
Administrator or Sales Implementor role). Make sure that the sandbox where you made the changes is active in
the application.

2. Sign in as a Oracle Sales Assistant for Microsoft Teams user that will be able to view your configuration
changes. For example, if the changes have been made to a layout with an assigned role, then you'll need to sign
in as a user with the required role permissions to view the changes.

3. Check your configurations by sending "refresh metadata". Then send the utterance to get the record for the
layout.

Publish the Sandbox
Once you're ok with your configurations, publish the sandbox. Here's how:

1. Sign in to Oracle CX Sales as the same user you used to make the configuration changes.
2. Publish your sandbox to distribute your changes to all Oracle Sales Assistant for Microsoft Teams users.
3. Send "refresh metadata" one more time so all users receive the changes you made to your configurations.
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Note:  You can configure only the latest skill from the skill store that matches your current release. For example, if the
skill you want to modify is from a previous release and you're making your changes in a later release, then you must
re-base the skill your users are using to the latest skill that was modified. In addition, you must re-route the channel to
the new re-based skill so that users can start using it and perform Reset sessions in the channel UI.

Configure Microsoft Teams with Custom Scripts  
You can configure Microsoft Teams to match your business requirements by writing custom scripts using JavaScript
that enforce validations and rules.

You can create scripts for Microsoft Teams using the CX Sales Mobile script tools. You can also assign scripts for CX
Sales Mobile to Microsoft Teams if the requirements for both channels are the same. You can add custom scripts for
Microsoft Teams to Appointments, Call Reports, and Tasks for On Create, Before Save, and After Save events.

Note:  To enable the custom scripts for Microsoft Teams feature, you must first create an Enable Custom Scripts
for Microsoft Teams (CDA_ENABLE_CSS_TEAMS) profile option, and then set the option value to Yes. For more
information, see Enable Custom Scripts for Microsoft Teams Profile Option.

Create a Script and Assign to Microsoft Teams
Here's how you create a script and assign to Microsoft Teams:

1. Select the sandbox you want use for your configuration.
2. Select Navigator > Application Composer > Mobile Application Setup.
3. Click the CX Sales Mobile Scripts tab at the top of the Mobile Application Setup page.
4. To create a script for a top-level parent object, select the object you want to write a script for, and then select

the event that will trigger your script. You can choose one of these events:

◦ On Create (triggered when a new record is created in the mobile app).

◦ Before Save (triggered before a record is saved).

◦ After Save (triggered after the app has saved the record).

5. Click the plus icon in the <Event Name> Scripts section.
6. Enter the script name and description.
7. (Optional) If you want the script to work for particular regions, select geographical regions for the script. The

script will work for users who have your selected regions as their country preference setting in the CX Sales app.

Note:  A script can have multiple regions associated to it, but the same region can't be assigned to more than
one active script for the same object and event.

If you want to restrict your script to trigger for certain user roles, you will need to specify these by writing a
JavaScript script
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8. Select Microsoft Teams as your assigned channel and click Create to create your script.

9. Click Validate to check whether your script has any errors. The validation checks include checks for nested
functional calls and anything else in the script that will cause it to run forever in an infinite loop.

10. When you're finished, click Save.

Assign Existing Scripts to Microsoft Teams
You can also assign existing scripts for CX Sales Mobile to Microsoft Teams if the requirements for both channels are the
same.

Here's how you add an existing script and assign to Microsoft Teams.

1. Select the sandbox you want use for your configuration.
2. Select Navigator > Application Composer > Mobile Application Setup.
3. Click the CX Sales Mobile Scripts tab at the top of the Mobile Application Setup page.
4. Choose the event and locate the existing script that you want to assign to Microsoft Teams.
5. Select Microsoft Teams as your assigned channel. 

6. Click Validate to check whether your script has any errors. The validation checks include checks for nested
functional calls and anything else in the script that will cause it to run forever in an infinite loop.

7. When you're finished, click Save.
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Enable Custom Scripts for Microsoft Teams Profile Option  
You can add custom scripts for Microsoft Teams to Appointments, Call Reports, and Tasks for On Create, Before Save,
and After Save events. For example, you can trigger a script to validate or enforce some rules before or after a call report
is saved.

To enable the custom scripts for Microsoft Teams feature, you must first create an Enable Custom Scripts for Microsoft
Teams (CDA_ENABLE_CSS_TEAMS) profile option, and then set the option value to Yes.

Here's how to edit the CDA_ENABLE_CSS_TEAMS profile option:

1. Sign in as a user with access to the setup areas.
2. Navigate to  Setup and Maintenance work area.
3. Open the Tasks side panel and click Search.
4. Search and select the Manage Profile Options task.
5. From the Manage Profile Options page, click Actions > New .
6. Enter all the fields with relevant details with specific attention to the following:

◦ Profile Option Code = CDA_ENABLE_CSS_TEAMS

◦ Profile Option Name = Enable Custom Scripts for Microsoft Teams

◦ Application = Sales Assistant

◦ Module = Sales Assistant (Module Type = LBA)

◦ Start Date = Date that the option should start to be enabled

7. Click Save and Close.
8. For the Site Profile Option Levels, select the Enabled and Updatable check boxes to enable.
9. Click Save and Close.

10. In the Setup and Maintenance work area, open the Manage Administrator Profile Values task:

◦ Offering: Sales

◦ Functional Area: Sales Foundation

◦ Task: Manage Administrator Profile Values

11. In the Manage Administrator Profile Values page, search by the profile option code, CDA_ENABLE_CSS_TEAMS.
12. Click the profile option name link.
13. On the Profile Values section, click Actions > New .
14. Select Profile Level to Site and set Profile Value = Y.
15. Click Save and Close.

FAQs for Microsoft Teams  

How can I hide or display a feature?  
Navigate to the Microsoft Teams Composer in Application Composer. In the Application Feature pane, select the feature
you want to hide or display, and click the Enable icon to enable or disable the feature in the Feature Details pane. Click
Save.
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Can I configure additional fields to prompt during a conversational
create?  
Yes, you can specify what fields you want the assistant to prompt in both the edit page layout sections for CX Sales
Mobile and Microsoft Teams.

By default, when you create an object, the assistant only prompts for values of fields on the edit page layout that are
required and have no defaults values.

However, if you would like the assistant to prompt for additional fields that aren't mandatory, or mandatory and have a
default, then you can select the fields in the Prompted Fields on Assistant Create section on the left hand side of the
Microsoft Teams and CX Sales Mobile configuration tools. Any fields selected in this section will always be prompted
during conversational create if the field is part of the edit layout. The fields selected in this section also applies to the
predefined standard or custom layouts.

For CX Sales Mobile, see Configure the Edit Page Layout for more information. For Microsoft Team, click the related link
About Page Layouts for Standard and Custom Objects.

Related Topics
• About Page Layouts for Standard and Custom Objects

• Configure the Edit Page Layout

CX Sales Mobile  

Set Up Oracle Sales Assistant for CX Sales Mobile  
Oracle CX Sales Mobile is a specialized mobile application for CX Sales. Only the CX Sales skill (Oracle Sales Assistant)
for CX Sales can be set up with CX Sales Mobile.

You create a channel in Oracle Digital Assistant and expose your Sales Assistant in Oracle CX Sales Mobile.

Set Up CX Sales Mobile
Once you have performed the steps to configure ODA and have access to start using Sales Assistant, you can configure
the Oracle Web Channel to associate to the Sales assistant skill. Here's a table summarizing what you must do to set up
CX Sales Mobile with the Oracle Sales Assistant. See the topic referenced in the last column for details about each setup
step.

Step Task Description Where to get more details

1
 

Complete the prerequisite Oracle
Digital Assistant application setup.
 

Before you set up any of the
features that use natural-language
processing, you must perform
some prerequisite setup of Oracle
Digital Assistant:

See the topic: Overview of
Common ODA Setup for Sales.
 
For additional information, see
the Oracle Digital Assistant
documentation: Getting Started
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Step Task Description Where to get more details

• Set up administrator users

• Obtain the ODA URL

• Enable the Digital Assistant
used for Oracle Fusion Cloud
Applications

 
If you already completed the setup
for another feature, you can skip
this step.

with Oracle Digital Assistant for
Cloud Applications.
 

2
 

Create a Channel in Digital
Assistant.
 

Create an Oracle Web Channel in
Oracle Digital Assistant.
 

See the section "Create a Channel
in Digital Assistant" in the topic
Enable Sales Assistant for CX Sales
Mobile for more information.
 

3 Set up in CX Sales Mobile
Composer tab in CX Sales
Application Composer.

To enable Oracle Sales Assistant
in CX Sales Mobile, enter the
Oracle Digital Assistant Host
and Channel ID of the Oracle Web
channel registered in Oracle Digital
Assistant.

See the section "Set the Digital
Assistant Host and Channel ID" in
the topic Enable Sales Assistant
for CX Sales Mobile for more
information.
 

4
 

Enable or Disable Sales Assistant
for Standard or Custom Objects.
 

In the CX Sales Mobile
configuration tool, select the
standard or custom objects you
would like to enable for sales
assistant.
 

See the section "Enable or Disable
Sales Assistant for Standard or
Custom Objects" in the topic
Enable Sales Assistant for CX Sales
Mobile for more information.
 

5
 

Test Your Configurations.
 

After you have configured Oracle
CX Sales Mobile using Application
Composer, you should test your
configurations before distributing
them to your user's mobile devices.
 

See the topic Test Your
Configurations of the Mobile
Applications chapter of this guide.
 

Note:  The CX Sales Mobile app uses saved searches and other work areas that are powered by the high-performance
search capabilities of Adaptive Search. Prior to using the CX Sales Mobile application, check that Adaptive Search is
deployed in the CX Sales application, and that search indexing processes are run and regularly scheduled. You must
also ensure that these fields are enabled for use as search filters for the following objects:

• Opportunity: - Status, Sales Method

• Activity: - Type, Activity, Start Date, End Date, Status, and Due Date

Enable Sales Assistant for CX Sales Mobile  
Sales assistant is an individual chatbot that you can use to help you perform your daily sales-related tasks. Using your
phone, you can ask questions or commands to the sales assistant and it retrieves the information, or acts on your
requests. It reduces manual data entry, and makes it easier to view and update sales records through text or voice
commands.
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Follow the steps outlined in the following sections to enable sales assistant for your sales representatives.

Create a Channel in Oracle Digital Assistant
1. In a browser window, open ODA, click Channels in the left menu, and choose Users.
2. Click + Channel to open the Create Channel dialog.
3. Give your channel a name.
4. Choose Oracle Web as the channel type.
5. Disable the Client Authentication Enable option using the toggle.
6. Enter an asterisk (*) for Allowed Domains.
7. Set the Session expiration time.
8. Click Create.
9. In the Channels page, copy the Channel ID and make a note of it.

10. Click Route To and select the Sales skill that you want to associate with the channel.
11. Switch on the Channel Enabled control.

Set the Digital Assistant Host and Channel ID
After you create the Oracle Web channel in Oracle Digital Assistant, configure Oracle Fusion Cloud Applications with
the values from the web channel. You don't need to create and publish a sandbox to configure channels for your sales
assistant.

Here's how to set the Digital Assistant host and channel ID to enable Oracle Sales Assistant in CX Sales Mobile.

1. Select Application Composer under the Configuration category in the Navigator menu.
2. Under the Common Setup Menu, click Productivity Applications Configuration.
3. Click the Oracle Sales Assistant tab to open the Channels Configurations page.
4. Navigate to the Register the Oracle Digital Assistant Channels section of the Channels Configurations page.
5. Enter the following host and channel ID details:

◦ In Oracle Digital Assistant Host, enter the Oracle Digital Assistant Instance URL without https://
See the topic: Obtain the Oracle Digital Assistant URL

◦ In Channel ID, enter the ID of the Oracle Web channel that you created in Oracle Digital Assistant.

Note:  You can now begin to enable, configure, and test the sales assistant for CX Sales Mobile by using the Mobile
Application Setup tool as outlined in the following sections. You must perform these tasks only from a new sandbox.

Enable Sales Assistant in the Mobile Application
Here's how to enable sales assistant for CX Sales Mobile in the Mobile Application Setup tool.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Create a new sandbox to use for your configurations.
3. Select Application Composer under the Configuration category in the Navigator menu.
4. Under the Common Setup Menu, or on the Overview page, click Mobile Application Setup.
5. Click the CX Sales Mobile Composer tab.
6. In the Application Features pane, click Settings.
7. In the mobile interface designer, click Oracle Sales Assistant Settings.
8. Enable sales assistant by using the Enable toggle.
9. Oracle Sales assistant is available for all roles and regions by default. If you would like to restrict access, you can

specify the roles and regions that can use sales assistant in the Assigned Roles and Assigned Regions fields.
Just click the relevant field and select the roles and regions to assign access.
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10. The Enable Attachments is selected by default and allows you to ask to view or upload attachments to your
record.

The Enable Notes is also selected by default and allows you ask to view or add notes.

Note:  If you don't have access to attachments or notes in Oracle Sales, you won't be able add attachments or
notes and won't be able to get any notes via Oracle Sales Assistant.

11. Click Save.

Enable or Disable Sales Assistant for Standard or Custom Objects
Finally, you need to specify which objects can be used with sales assistant.

1. In the Applications Features pane, click Home.
2. In the mobile interface designer, click the standard or custom object you would like to enable for sales assistant

and in the Feature Details pane, click the Enable for Sales Assistant toggle.

Note:  Sales assistant isn't available for the following objects: Calls to Log, Products, and Partners. Creating
call reports is supported, but searching for them isn't.

3. Click Save.

Test Your Configurations
Test and then publish your sales assistant configurations. See the Test Your Configurations topic for details about how to
check your mobile configurations.

FAQs for CX Sales Mobile  

Can I modify the Sales Assistant welcome message for CX Sales
Mobile?  
Yes, your administrator can now create a new or modify an existing welcome message with some suggestions of what
sales representatives can do and say to the sales assistant which are relevant to your business.

Your administrator can modify the message in the Oracle Sales Assistant Common Configuration Tool within
Application Composer.

For example, here’s a sample sales assistant screenshot of a CX sales mobile welcome screen.
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Related Topics
• Edit Strings in Oracle Sales Assistant Common Configuration Tool

Common Configurations  

Overview of Managing Synonyms for Sales Assistant  
A synonym is a word or phrase with a similar meaning for the CX objects and fields used in utterances sent to Oracle
Sales Assistant.

Synonyms for CX objects and fields allow Oracle Sales Assistant to understand the objects and fields your user is asking
about, based on your company's jargon. These can include abbreviations, slang terms, and common misspellings.

For example, your salespeople may call or refer to "opportunities" as "deals". The Oracle Sales Assistant Common
Configurations administrator tool provides an easy way for you to manage synonyms for all supported channels without
having to manually manage them in Oracle Digital Assistant.

Navigate to the Common Configuration Tool  
Here's how to navigate to the Oracle Sales Assistant Common Configurations tool.
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1. Sign in to the Sales application as a user with a Sales Administrator role.
2. Select or create a sandbox that you want to use for your configurations. Make sure that your sandbox includes

Application Composer as an active tool.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.

When the Common Configurations tool opens, it first checks if there are skills compatible with current version of your
sales application. Currently, Oracle only supports the same skill version as the latest sales application version. For
example, if your sales application version is 21.04, then the skill version must also be 21.04. A message is displayed if
there are no skills found with the same version.

If a skill version matches your sales application, then the Common Configurations tool displays both a left panel and a
right panel. The right will be empty. The left panel consists of 1 main Synonyms section.

Use the Common Configuration Tool to Update Synonyms  
To ensure that Sales Assistant is aware of any objects enabled from the CX Sales Mobile composer tool or Microsoft
Teams composer, you can use the Oracle Sales Assistant Common Configurations administrator tool to update
synonyms for the objects enabled.

Update Synonyms for Objects Enabled for Oracle Sales Assistant
Here's how to update synonyms for objects enabled for your Sales Assistant.

1. Sign in to the Sales application as a user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.
6. Expand the Synonyms section and under the CX Objects section, select the object for which you want to

update synonyms.

◦ The objects displayed are objects are that enabled for Oracle Sales Assistant for any supported channels.

◦ If you're looking for a child object, first select the parent object, such as "Opportunities", from CX Objects
section. Then select the child object from the Child Objects section, such as "Opportunities Child
Objects".

◦ If the child object is also a top-level object, select the top-level object to define the synonyms required.

7. From the Object Name Synonym(s) field in the right pane, enter the synonym that you want for the selected
object in the Enter Synonym(s) text box and press Return.

◦ Once the synonym is added, it displays in the list of synonyms for the object.

Note:  Predefined synonyms can't be removed. To remove a custom synonym, select it from the list and
click the X icon.

8. Click Save. The Select Sales Assistant Skill dialog is displayed.
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9. From the Select Sales Assistant Skill dialog, select the Sales Assistant skill that you want the updated
synonyms for objects transferred to.

10. Click Save.

An in progress notification is displayed during the transfer and a success message is displayed when the
transfer successfully completes. The next time you update and save synonyms for an object, the Select Sales
Assistant Skill dialog displays the last updated Sales Assistant skill that you have saved to.

CAUTION:  An error message displays if there is an problem during the transfer to the skill. Any updates you
made won't be saved if you exit the Common Configurations administrator tool at this stage.

Update Synonyms for Fields Enabled for Oracle Sales Assistant
Use the Oracle Sales Assistant Common Configurations administrator tool to update synonyms for the fields to use in a
conversation. You want to ensure that Sales Assistant is aware of the fields you want your users to use in a conversation
with the assistant from any of supported channels, such as updating a synonym for a field used to search for a record.

Here's how to update synonyms for your Sales Assistant fields.

1. Sign in to the Oracle CX Sales application as a user with a Sales Administrator role.
2. Select the sandbox you want use for your configurations.
3. Open Application Composer by selecting Application Composer under the Configuration category in the

Navigator menu.
4. Under the Common Setup Menu, click Oracle Sales Assistant Setup.
5. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.
6. Expand the Synonyms section and under the CX Objects section, select the object for the field which you want

to update synonyms.

◦ If you're looking for a field of a child object, first select the parent object, such as "Opportunities", from
CX Objects section. Then select the child object from the Child Objects section, such as "Opportunities
Child Objects".

7. Once the object is selected, select a field from the Fields section in the right pane, enter the synonym that you
want for the selected field in the Enter Synonym(s) text box and press Return.

◦ Once the synonym is added, it displays in the list of synonyms for the field.

Note:  Predefined synonyms for fields can't be removed. To remove a custom synonym for a field,
select it from the list and click the X icon.

8. Click Save. The Select Sales Assistant Skill dialog is displayed.
9. From the Select Sales Assistant Skill dialog, select the Sales Assistant skill that you want the updated

synonyms for fields transferred to.
10. Click Save.

An in progress notification is displayed during the transfer and a success message is displayed when the
transfer successfully completes. The next time you update and save synonyms for a field, the Select Sales
Assistant Skill dialog displays the last updated Sales Assistant skill that you have saved to.

CAUTION:  An error message displays if there is an problem during the transfer to the skill. Any updates you
made won't be saved if you exit the Common Configurations administrator tool at this stage.
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Tips for Adding or Updating Synonyms for Objects and Fields
Here are some tips for adding or updating synonyms for objects or fields

• If there are no skills of the same version as your sales application, then you must navigate to your Oracle Digital
Assistant environment to get the latest version of the Sales skill from the Skill Store (via FADigitialAssistant).

• Synonyms can't contain characters such as, : (colon) or , (apostrophe) and can't end with ? (question mark), " or
' (double or single quote mark), or . (period).

• Synonym values aren't case-sensitive. For example, USA and usa are considered as the same value.

• You can't add synonym(s) that are already present in an object or a field. An error message displays if you try to
add a duplicate synonym to the list.

• You can't add synonym(s) if the synonym is part of a set of reserved words for the Oracle Sales Assistant. An
error message displays if you try to add a synonym that contains a reserved word to the list.

• If you add a synonym to a formula field, then Oracle Sales Assistant won't be able to search on the field because
formula fields aren't searchable.

Edit Strings in Oracle Sales Assistant Common Configuration Tool  
Use the Oracle Sales Assistant Common Configuration tool to update phrases or strings from the sales assistant.
Responses from the sales assistant are based on such phrases or strings and applies to either CX Sales Mobile,
Microsoft Teams, or users of both channels.

For example, you can modify the sales assistant help text to make the answer more relevant in response to a user's
request for help on a contact list.

Follow these steps to update strings using the common configuration tool:

1. Create and enter a publishable sandbox where Application Composer is enabled.
2. Navigate to Application Composer.
3. Click Oracle Sales Assistant Setup.
4. Click the Common Configurations tab to open the Oracle Sales Assistant Common Configurations tool.
5. Click on the Response Text section.
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6. In the Select String drop down list, search for the string you want to update. For example, search for "I am your
Oracle sales Assistant" as shown in this sample screenshot to locate the CX Sales Mobile's sample welcome message.

7. Select the string you want and make your changes in the Edit String field.

Strings are in ICU format. Some strings contain tokens and some strings are pluralized. You can preview how the
string will be rendered under the Preview section. For example, if your string contains tokens, for each token, double
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click on the token row and enter the value in the Sample Value section. You can then preview the rendered string
based on the sample value you enter.

Here's a sample screenshot that highlights where to enter and preview a sample token value from the Sales Assistant
Common Configurations tool.

8.

Click Save. The Select Sales Assistant Skill dialog is displayed. 
9. From the Select Sales Assistant Skill dialog, select the Sales Assistant skill that you want the updated string to

transfer to.
10.Click Save.
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Related Topics
• Can I modify the Sales Assistant welcome message for CX Sales Mobile?
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23  Web Activity Rules

About Web Activity Rules  
You can perform an activity sync from Oracle Eloqua to Oracle Sales contacts, leads and opportunities that exist in
Sales. Use the Web Activity Rule expression builder to define rules to include or exclude web activity records for the
objects that are of interest.

For example, you might want to create a web activity rule that imports only those emails that were sent from a
campaign after a specific date and exclude any emails that have the term " Oracle" in the email subject.

Here's how to access web activity rules.

1. Open Application Composer by selecting Configuration > Application Composer in the Navigator menu.
2. Under the Common Setup Menu, click Web Activity Rules to open the Web Activity Rules UI.

You can create rules to import records for the following web activity types:

• Email Open

• Email Click-Through

• Email Send

• Form Submit

• Page View

• Web Visit

Any rules that you have already created are displayed in the Web Activity Rules list page. It shows the name of the rule
as well as the type, status, creation and last updated dates and the name of the user who performed the last updates to
the web activity rule.

Manage Web Activity Rules  
From the Web Activity Rules page, you can view previously created rules, create, edit, and delete a rule to either include
or exclude all or any attributes for the Campaign and Web Activity objects.
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Here's how to create, edit, and delete a web activity rule.

1. Sign in as a sales administrators or user with the appropriate access privileges.
2. From Application Composer > Web Activity Rules, navigate to the Web Activity Rules page and click Create.

3. In the Basic Details section, enter the name and a brief description of the rule and the type of web activity to want to
define the rule.

4. In the Rule Definition section, click Add Group to include or exclude groups of attributes for your selected object
that you want to define for your web activity.
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5. Click Add Object to select either the Campaign and Web Activity objects. Select the
attributes, operators, and values that you want to define for the conditions of your rules.

You can define multiple rules for each of your objects. Click the plus (+) sign at the end of each row to add another
rule associated with your web activity type.

Note:  For date values, you can select the specific date that you want or you can specify a run date plus or minus
a specific number of days in integer format. For example, for date-related attributes you specify a run date plus 7
days. This means that if all or any of the rules are met, the rule will continue to process and update records 7 days
past the specified run date.

6. When you're done with including and excluding group for the objects you want and have defined all the rule
conditions, you can activate the rule by changing the Status  field in the Basic Details section from Inactive to Active.
You can only set 1 rule to Active for each web activity type.

7. Click Save.
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Change Web Activity Rules  
1. From Application Composer > Web Activity Rules, navigate to the Web Activity Rules page.
2. In the Name field, double-click the rule you want to edit. Note that you can change the basic details expect for the

name of the rule and you can change all or any of the rule conditions.
3. Click Save to update the web activity rule name with your changes.
4. To delete rules that no longer apply, select them from the list page and click Delete. 
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